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General

Foreword

This user's manual introduces the functions and operations of DSS Professional (hereinafter referred
to as "the system" or "the platform").

Safety Instructions

The following signal words might appear in the manual.

Signal Words

Meaning

A DANGER

Indicates a high potential hazard which, if not avoided, will result in
death or serious injury.

A WARNING

Indicates a medium or low potential hazard which, if not avoided,
could result in slight or moderate injury.

A CAUTION

Indicates a potential risk which, if not avoided, could result in
property damage, data loss, reductions in performance, or
unpredictable results.

Provides methods to help you solve a problem or save time.

Provides additional information as a supplement to the text.

Frequently Used Functions

Icon/Parameter

Description

View the details of an item.

5

Clear all selected options.

- Search for items by keywords or specified content.
E or Delete Delete items one by one or in batches.
, 1) or Edit Edit the parameters of an item.
_’ =3 Enable, or Enable or disable items one by one or in batches.
Disable
E or Export Exported the selected content to your local computer.
Refresh the content

or Refresh efresh the content.

*

A parameter that must be configured.
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Privacy Protection Notice

As the device user or data controller, you might collect the personal data of others such as their
face, audio, fingerprints, and license plate number. You need to be in compliance with your local
privacy protection laws and regulations to protect the legitimate rights and interests of other
people by implementing measures which include but are not limited: Providing clear and visible
identification to inform people of the existence of the surveillance area and provide required
contact information.

About the Manual

® The manual is for reference only. Slight differences might be found between the manual and the
product.

® \We are not liable for losses incurred due to operating the product in ways that are not in
compliance with the manual.

® The manual will be updated according to the latest laws and regulations of related jurisdictions.
For detailed information, see the paper user's manual, use our CD-ROM, scan the QR code or
visit our official website. The manual is for reference only. Slight differences might be found
between the electronic version and the paper version.

® All designs and software are subject to change without prior written notice. Product updates
might result in some differences appearing between the actual product and the manual. Please
contact customer service for the latest program and supplementary documentation.

® There might be errors in the print or deviations in the description of the functions, operations
and technical data. If there is any doubt or dispute, we reserve the right of final explanation.

® Upgrade the reader software or try other mainstream reader software if the manual (in PDF
format) cannot be opened.

® All trademarks, registered trademarks and company names in the manual are properties of their
respective owners.

® Please visit our website, contact the supplier or customer service if any problems occur while
using the device.

® |f there is any uncertainty or controversy, we reserve the right of final explanation.
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1 Overview

1.1 Introduction

Dahua Security System (DSS) Professional is designed for centralized security management. It
enhances hardware performance and provides centralized video monitoring, access control, video
intercom, alarm controller, POS, radar and Al features, such as face recognition, automatic number
plate recognition, and video metadata.

Whether you are a small business with a few cameras, or a global business spread across the globe
with over 20,000 cameras, DSS Professional is the right solution for you. Even if your needs change
in the future, you can easily scale, upgrade or add functionalities to DSS Professional so that your
needs are met. Build your security management system on a solid foundation with DSS
Professional.

1.2 Highlights

® Scalable design, easy to grow

With distributed deployment, you can easily expand the supported channels to 20,000 and
central storage capacity to 4 PB. The multi-site function allows you to incorporate multiple DSS
platforms into one, and conveniently show their information on one PC client. You can access
live and recorded videos, real-time and historical events, and more.

® Al-powered applications, proactive security

DSS Professional integrates various Al capabilities that devices have, such as face recognition,
automatic number plate recognition, and video metadata. You will be notified immediately
when the target you are interested in appears, allowing you or security personnel to take
necessary security measures.

® Highly available technology, more stable

With hot standby and N+M redundancy, DSS Professional ensures that your business will not be
interrupted by failed servers.

® Customized services, enhanced competitiveness

We offer services for you to build DSS Professional into your own platform, allowing it to fully
suit your needs and give you a competitive edge in the market.
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2 Installation and Deployment

DSS platform supports standalone deployment, multiple sites deployment, distributed
deployment, hot standby, and N+M deployment, and LAN to WAN mapping.

Standalone Deployment

For projects with a small number of devices, only one DSS server is required.

Figure 2-1 Standalone deployment

Network
Cable

DSS

Access Controller

W e e

IPC  PTZ Camera PTZ Camera NVR

Multiple Sites Deployment

If you have multiple platforms, you can connect one or more platforms to your current one, so that
you can view the resources from them directly on your main platform, including viewing real-time
videos from video channels, searching for viewing real-time and historical events, and downloading

recorded videos.
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Figure 2-2 Multiple sites deployment
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Distributed Deployment

Suitable for medium to larger projects. Sub servers are used to share system load, so that more
devices can be accessed. The sub servers register to the main server, and the main server centrally
manages the sub servers.

Figure 2-3 Distributed deployment
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Hot Standby

Used with systems that require high stability. The standby server takes over the system when the
active server malfunctions (such as with power-off and network disconnection). You can switch

back to the original active server after it recovers.
Figure 2-4 Hot standby
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N+M

Each sub server has a standby server to maintain stability. When a sub server malfunctions, the
system replaces it with an idle standby server. When the malfunctioning server normalizes, you can
manually switch back to it. If you do not manually switch them, the system will automatically make
the switch if the standby server malfunctions.
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DSS Sub Server

IPC PTZ Camera PTZ Camera NVR

LAN to WAN Mapping

Perform port mapping when:

Access Controller

Figure 2-5 N+M

Network

'\7 Cable

DSS Main Server

r\‘?

DSS Sub Server

3

IPC  PTZ Camera PTZ Camera NVR VTO

Access Controller

® The server of the platform and devices are on a local area network, and the DSS client in on the
internet. To make sure that the DSS client can access the platform server, you need to map the
platform IP to the Internet.

® The platform is on a local area network, and the devices are on the Internet. If you want to add
devices to the platform through automatic registration, you need to map the IP address and
ports of the platform to the Internet. For devices on the Internet, the platform can add them by
their IP addresses and ports.

A\

The management tool does not differentiate service LAN ports and WAN ports. Make sure that the

WAN ports and LAN ports are the same.
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2.1 Standalone Deployment

2.1.1 Server Requirements

Table 2-1 DSS Professional hardware requirements

Parameter Hardware Requirement Operating System

® (CPU: Intel Xeon Silver 4214 2.2 GHz
® RAM: 16 GB
® Network card: 4 x Ethernet port @
Recommended 1000 Mbps
requirements ® Hard drive type: 7200 RPM
Enterprise Class HDD 1 TB ® Microsoft® Windows Server
® DSS installation directory space: 500 2019 Standard (64-bit)
GB ® Microsoft® Windows Server
2022 Standard (64-bit)
® (CPU:Intel Xeon E-2224 3.4 GHz/4 ® Microsoft® Windows 10

cores 20H2 Pro (64-bit)
® RAM:8GB ® Microsoft® Windows 11
Minimum ® Network card: 2 x Ethernet port @ 21H2 Pro (64-bit)
1000 Mbps

requirements .
® Hard drive type: 7200 RPM

Enterprise Class HDD 1 TB

® DSS installation directory space: 500
GB

® Face recognition images, videos, and files cannot be stored on the system disk and DSS
installation disk. We recommend you store these files on a separate local disk or a network disk.

® For best performance, we recommend adding additional hard drives to store pictures.

2.1.2 Installing Management Tool

Prerequisites

® You have downloaded the installation package from the official website or received it from our
sales or technical support.

® You have prepared a server that meets the hardware requirements described in "2.1.1 Server
Requirements".

Procedure

Step 1 Double-click the DSS installer .
(1]

el

The name of the installer includes version number and date, confirm before installation.

Step2  Click the software license agreement, and then read the agreement.
Step3  Select the check box to accept the agreement, and then click Next.
Step4  Select the type of platform you want to install, and then click Next . Main is selected by

default.
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Step 5

Step 6

Step7

Select AcuPick as needed, and then click Next.
1

AcuPick can be deployed on the same server as the platform, or on a separate one. For
how to configure parameters for AcuPick, see "5.1.2.1.2 AcuPick".

Figure 2-6 Select a platform type

Professional

Installation Option

lect the platform or component that you need to install

B4 platform

Sub Platform

Click Browse, and then select an installation path.

If the Install button is gray, check whether the installation path and space required meet
the requirements. The total space required is displayed on the page.

el

We do not recommend installing the management tool on disk C, because features such
as face recognition require higher disk performance.

Click Install.

A\

The installation process takes about 4 to 8 minutes. Do not cut off the power or close the
program.

Click Run after the installation completes.

Configure the network parameters.

1. Configure the IP address of the network card.
@

Dual NIC will be available if the server has two network cards. This is useful when you
need to access devices on two different network segments.

2. (Optional) Enable WAN Mode, enter a WAN IP address or a domain name, and then
click Next.

o=t

If the platform is in a local network, use this function to connect it to the Internet so
that you can access it from outside the local network.
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Figure 2-7 Configure the network parameters

Configuration Wizard

Configure network and security to quickly start services

Network

NIC Mode
® Single NIC Mode

NIC IP Address

WAN Mode

3. Configure the TLS version, and then click Finish.

TLS1.2 is selected by default and cannot be changed. We do not recommend using
TLS1.0 and TLS1.1 because they have serious security vulnerabilities.

If the available RAM of the server is less than 4 GB, you can only use basic functions
related to video. If it is less than 2.5 GB, you cannot use any function.

Related Operations
® To uninstall the platform, log in to the server, go to ".\DSS\DSS Server\Uninstall", double-click
uninst.exe, and then follow the on-screen instructions to uninstall the program.

® To update the system, directly install the new program. The system supports in-place update.
Follow the steps above to install the program.

2.1.3 Configuring Server IP Address

Change the server IP address as you planned. Make sure that the server IP can access the devices in
your system. For details, see the manual of the server.

After changing the IP address of the server, you need to update it in the management tool. See the
following section.
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2.1.4 Management Tool

The management tool allows you to view status of services, start or stop services, change service
ports, and more.

On the server, double-click !

S Professional
12 DSS Jiociment tool

Main Platform

|1 Stop All

Service Description
General Standard Service

NGINX NGINX Proxy Service

REDIS Redis Data Cache Service 6379 Running...

MysQL MySQL Database Service

\%[e] MQ Push Notifications Service

¥ Platform Management Service

SMC System Management Service

DAMS DA Management Service

ACDG Access Control Management Service 8888 Running...

Figure 2-8 Management tool

Status

HTTP:80; HTTPS:443(Login Port) Running...

3306 Running...

RESTOUT:6556; RESTINNER:6555; ... Running...

Table 2-2 Interface description

OPENWIRE:61616; MQTT:18 s Running...

HTTP:8000; HTTPS:18443; CMS:9... Running...

Running...

Operation

No.

Function

Description

Server information

Displays the IP address and type of the platform.

Information for port
mapping

Displays the ports that you need to map for various functions.
Select one or more functions, the ports you must map will be

displayed on the right. CIick to export them to your computer

so that you can check on them easily.

Download clients and
logs

® (lient: Displays how to download the PC client and App.
® | ogs: Download the operation logs of the management tool.
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No.

Function

Description

Configurations and
view information of
the platform

Network: Configure the network card mode, IP address, and
the WAN mode. If the server has two network cards, you can
select Dual NIC mode, configure two IP addresses, and then
the platform will be able to connect to two networks and
access the devices on each one. If the platform is in a local
network and the devices are on the internet, or you need to
access the platform that is in a local network from the
Internet, you can enable WAN Mode and map the IP address
of the platform to a WAN IP address or a domain name.
Security: Select a TLS protocol version when you access the
webpage of the platform through a browser. TLS1.2 is
selected by default and cannot be disabled. There are security
vulnerabilities to TLS1.0 and 1.1. We strongly recommend you
disable it to avoid security risks. After configuration, follow the
on-screen instructions to configure the TLS protocol version in
the IE browser so that you can access the webpage of the
platform normally.

Language: Select the language of the management tool.
Multiple languages are supported.

Port Self-adaption: If a port is occupied, the platform will
change the it automatically. After turning on or off this
function, you must restart the server for it to be effective.
User manual: View the user manual of the platform.

About: View the software version information, software
license agreement, and more.

Service management

Click Restart All to restart all services.

Ll

When starting the platform, if the available memory of the
server does not reach 4 GB, only the basic video services can
be enabled. If the server has less than 2.5 GB of available
memory, no services are available.

Click Stop All to stop all services.

Click Refresh to refresh services.

Status of services

There are 5 status of services, including starting, unavailable,
stopping, running, and stopped.

The unavailable status only depends on the status of the SMC
service. If the SMC service is not properly running, the overall
status will be unavailable.

Running means that all services are running normally.

Services

Displays all services, and their status and port numbers. click 2]
to change the port number of a service, and then the services will
restart automatically after modification.

10




@/hua

User's Manual

No. Function

Description

Database repair

If you cannot log in to the client because the database is

abnormal, you can try to repair it manually. CIick of the
MySQL service, and follow the instructions. Based on the items
checked, the platform will determine whether repair or
restoration is needed. If repair fails, you can try restoring the
database using one of the backup files. During restoration, the
platform will also back up the database. Please make sure that

there is enough space. Otherwise, restoration will fail. Click @ to
view all backup files.
@

The platform will automatically backup the database according
the backup and restore configurations. To configure automatic
backup and restore, see "7.5 Backup and Restore".

[

® This operation cannot be performed in hot standby.
® To restore the database, the platform needs to use port 3306.
If a process is using the port, you need to terminate it first.

2.1.5 Installing and Logging into DSS Client

Install the DSS client before licensing it.

2.1.5.1 Installing DSS Client

You can visit the system through the DSS Client for remote monitoring.

2.1.5.1.1 DSS Client Requirements

%)

dxdiag

Press the Windows key, and type dxdiag , and then click ..-.... On the System page, the
information of your computer is displayed.

To install DSS Client, prepare a computer in accordance with the following requirements.

Table 2-3 Hardware requirements

Parameters Description
® CPU:Intel® Core i7-11700 @ 2.50 GHz
R ded svst ® Memory: 16 GB and above
ccommended system ® Graphics: NVIDIA® GeForce® RTX 3060
requirements
® Network Card: 1000 Mbps
® HDD: Make sure that at least 200 GB is reserved for the client.

11




a/hua

TECHNOLOGY

User's Manual

2.1.5.1.2 Downloading and Installing DSS Client

Procedure

Step 1
Step 2

wnv n
—+ |+
N olw

[¥4]

—
F

(9]

Go to https://IP address of the platform in the browser.
Click PC, and then Download.

[

The platform also supports installation by MSI package. Visit https://
software.dahuasecurity.com/en/download/ and download the MSI package of the
platform version you need. Please be advised that you cannot overwrite the PC client
installed with an exe package, and vice versa. Also, the PC client installed with an MSI
package does not support automatic update. You must download the package of the
new version an install it manually.

If you save the program, go to Step 3.
If you run the program, go to Step 4.
Figure 2-9 Download DSS Client

Y Dss

DSS PC Clientvsao

Application-based | Scalable | Secure | Open

Double-click the DSS Client program.

Select the checkbox of | have read and agree to the DSS agreement and then click
Next.

Select a path for installation, and then click Install.

The installation progress is displayed. It takes about 5 minutes to complete.

2.1.5.2 Logging in to DSS Client

Procedure

Step 1
Step 2

5)
Double-click L2

Select a language and user type.

on the desktop.

Normal users are added on the platform manually. Domain users are imported from a
domain.

If you want to log in using a domain user account, you must import the domain user first.
For details, see "3.2.3 Importing Domain User".

12
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Step 3

Step 4

Enter the IP address and port number of the platform.

On the drop-down list, platforms that are in the same network as your computer will be
shown.

L1

® [f you want to log in to the platform using its domain name, you must link its IP
address to a domain name first. For details, see "2.7.2 Mapping IP or Domain Name".

® |f you log in by localhost, the platform will automatically change it to 127.0.0.1.

Figure 2-10 Automatically discovered platform

Normal User

&

. Remember Password

Auto Login

Click anywhere else on the page to start initializing the platform.
For first-time login, you will be automatically directed to the initialization process.

If you are not logging in for the first time, enter the IP address, port number of the
platform, username, and password, and then click Login.

1. The default user is system. Enter and confirm the password, and then click Next.

The password must consist of 8 to 32 non-blank characters and contain at least two
types of characters: Uppercase, lowercase, number, and special character (excluding'
" &).

2. Select your security questions and enter their answers, and then click OK.

The client will automatically log in to the platform by using the password you just set.

A\

Please keep the security questions and answers properly. Otherwise, your password
cannot be recovered if you forget it.

13
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2.1.5.3 Homepage of DSS Client

Figure 2-11 Homepage

Overview

Ree

Event Center DeepXplore Maintenance Cen...

& S

Access Managem...  Parking Lot Intelligent Analysis

Table 2-4 Parameter description

No. Name Function

1 Tab Displays the names of all tabs that are opened.

14
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No.

Name

Function

System settings

e [B: Enable or disable alarm audio.

o N Displays number of alarms. Click the icon to go to Event

Center.

Click E to view system messages, such as the information of
a device was edited or deleted. The permissions of a user will
determine what messages can be seen. For example, if user A
does not have the permission of device A, then user A will not
get the message when device A is deleted.

]
Click [IT] to connect to other platforms as sites to your current
platform. You can view certain resources from the sites. For
details, see "2.2 Multiple Sites Deployment".
EX: User information: Click the icon, and then you can login to
the web page by clicking system IP address, change password,
lock client and log out.

¢ Click platform IP address to go to the Web page.

¢ Click Change Password to change user password.
¢ Click About to view version information.

¢ Click Sign Out to exit client.

Click Eto lock client.

Overview

The number of devices in total, offline and online.
The number of total, processed and pending events.
The client network, CPU and RAM usage.

Management

® View and manage logs.

Download videos.
Check local pictures and videos.

Settings for video, snapshot, video wall, alarm, security and
shortcut keys.

View user manual.

Customize quick HTTP commands. For details, see "8.5 Quick
Commands".

Applications

L Application options including monitoring center, access
management, intelligent analysis and vehicle entrance control.

ES. Configuration options.

2.1.6 Licensing

Activate the platform with a trial or paid license the first time you log in to it. Otherwise you cannot
use it. You can upgrade your license for more features and increased capacity.

This section introduces license capacity, how to apply for a license, how to use the license to
activate the platform, and how to renew your license.
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2.1.6.1 Applying for a License

A license is used to confirm the features and number of channels you purchased. To get a formal
license, contact our sales personnel. To apply for a trial license, visit our website and find DSS
Professional, scroll to the bottom, click Apply, and then follow the instructions. You can only use a
trial license on a server once.

2.1.6.2 Activating License

L1

The following images of the page might slightly differ from the actual pages.
2.1.6.2.1 Online Activation

Prerequisites
® You have received your license. If not, see "2.1.6.1 Applying for a License".

A license is used to confirm the features and number of channels you purchased. To get a formal
license, contact our sales personnel. To apply for a trial license, visit our website and find DSS
Pro, and then follow the application instructions.

® The platform server can access the Internet.
Procedure

Step1  Onthe Home page, click EY and then in System Config, select License.
Click Online Activate License.

[¥4]

—
F

N

Step3  Select an activation method. Select Normal Active to complete the process. If you
upgraded the system from Express to DSS Pro, and DSS Express has a paid license, then
select Upgrade from Express instead.

Figure 2-12 Select a method

BDSS o

9 Online Activate License

@ Normal Activate

Activation Code:

Step4  Enter your new Activation Code.

1. Enter the DSS Pro activation code that you received.
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2. Ifyou select Upgrade from Express, enter the original Express activation code or
import the deactivation file.

® Enter the original activation code: Select Enter Activation Code, and then enter
the original activation code.

® |mport the deactivation file: Select Import DSS Express Deactivation Code, click
B and then select the deactivation file.
Step5 Click Activate Now.
Step6  Onthe License page, view your license details.

2.1.6.2.2 Offline Activation

Prerequisites
You have received your license. If not, see "2.1.6.1 Applying for a License".

A license is used to confirm the features and number of channels you purchased. To get a formal
license, contact our sales personnel. To apply for a trial license, visit our website and find DSS Pro,
and then follow the application instructions.

Procedure

Step1  Onthe Home page, click EY and then in System Config, select License.
Step2 Click Offline Activate License.

wn
—
1]

w

Select an activation method. Select Normal Active to complete the process. If you
upgraded the system from Express to DSS Pro, and Express has a paid license, then select
Upgrade from Express instead.
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Step 4

Figure 2-13 Select a method

9 Offline Activate License

@ Mormal Activate

Failed to get activation code. Please select DS s deactivation method.

Enter Activation Code

Export offline license request file:

» page on an Internet-connect PC. Upload the license request file from Step 1.

Enter your new Activation Code.

1. Enter the DSS Pro activation code that you received.
2. If you select Upgrade from Express, enter the original Express activation code or
import the deactivation file.

® Enter the original activation code: Select Enter Activation Code, and then enter
the original activation code.
® |mport the deactivation file: Select Import DSS Express Deactivation Code, click

E, and then select the deactivation file.
Click Export to export the license request file.
Generate license file.

1. Move the request file to a computer with Internet access.

2. On that computer, open the system email that contains your license, and then click the
attached web page address or Click to go to DSS License Management to go to the
license management page.

3. Click Activate License.

4. Click Upload, select the license request file, and then when you are prompted
uploaded successfully, click Activate.
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The success page is displayed, where a download prompt is displayed asking you to
save the license activation file.

Figure 2-14 Upload license request file

Activate DSS License

1 DSS License Management

Request File:

& Upload

The license request file can be exported in DSS software.

License Key:

JOOC-000(-2000- 30000

5. On the success page, click Save to save the file, and then move the file back to the
computer where you exported the license request file.

6. On the Offline Activate License page, click Import, and then follow the on-screen
instructions to import the license activation file.

Step7 Onthe License page, view your license details.

2.2 Multiple Sites Deployment

If you have multiple platforms, you can connect one or more platforms to your current one, so that
you can view the resources from them directly on your main platform, including viewing real-time
videos from video channels, searching for real-time and historical events, and downloading
recorded videos. The information of the platforms is linked to the user logged in to the main
platform. When the user log in to the main platform again, the main platform will automatically
connect to the other platforms. This function is only available to users assigned with the
administrator role.

Prerequisites

The versions of different platforms must be the same.
Procedure
Step1 Login to the DSS Client.

L]
Click (Tl on the upper-right corner, and then click Add Site.
Enter a name for the site, and the login information, and then click OK.

wn |\
~ |~
w N

You can now view real-time videos of the devices, and real-time and historical events
from the site.

19



@Z@ya User's Manual

Figure 2-15 Resources from the site shown in the monitoring center

e +  SiteName Alarm Catego... Alarm Type e riori emarl Alarm Status

2.3 Distributed Deployment

2.3.1 Installing Main Server

For details about how to install the main server, see the previous chapter or section.

After sub server are deployed, log in to the main server, and then you can view the status of the sub
servers.

2.3.2 Installing Sub Server

This section introduces how to install sub servers and register them to the main server.
Prerequisites

® You have received the DSS installer from our sales or technical support.

® You have prepared a server that meets the requirements mentioned in "2.1.1 Server
Requirements", and the server IP address is set.

Procedure

Step 1 Double-click the DSS installer .

(L1
The name of the installer includes version number and date. Please confirm before
installation.

Step2 Click agreement, read through the agreement, and then accept it.

Step3  Select the agreement check box, and then click Next.

Step4  Select Sub for server type, and then click Next.

Step5 Click Browse, and then select the installation path.
If the Install button is gray, check whether your installation path and space meet the
requirements. The total space required is displayed on the page.
L]
We recommend you do not install the platform into drive C because features such as face
recognition require higher disk performance.

Step6 Click Install.
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Step7

A\

The installation process takes about 5 to 10 minutes. Do not cut off the power or close the
program.

Click Run when the installation finishes.

Figure 2-17 Select network mode and network card

Config Wizard

Step 1: Network Config

® Single NIC Dual NIC
Local IP

Ethernet

ot

Select a network mode and the network card, and then click Next Step.
w

Dual NIC will be available if the server has two network cards. This is useful when you
need to access devices on two different network segments.

Figure 2-18 Configure the information of the main server

Config Wizard

Step 1: Select Network Adapter Step 2: Central Server Config

Center IP

ng Port

Configure the IP address and port of the main server.
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Step 10 Click Finish.

L1

After successfully installing a sub server, you need log in to the platform of main server to
enable it so that it can work properly. For details, see "7.1.1 Distributed Deployment".

Related Operations

® To edit service ports, start or stop services, refresh services, view service status or more, see
"2.1.4 Management Tool".

® To uninstall the platform, go to Control Panel > Programs and Features, and then locate DSS
Server. Double-click it, and then uninstall it according to the on-screen instructions.

2.4 Hot Standby

For detailed steps, see DSSReplicatorPlus2.0 Configuration Guide V8.1.1. If you have any problems,
contact technical support.

2.5 Cascade

Attach a DSS platform to another DSS platform, and then you can view videos of the child platform
from the parent platform. You can create up to 3 cascade levels.

Prerequisites
Make sure that all the platforms on the system were already installed.

Background Information

® You only need to configure the child DSS information on the parent DSS information.
® Express can only be a child platform.

Procedure

Step1 Loginto the parent DSS client. On the Home page, cIick > System Deployment.

Step CIick
Step Click Add, and then configure parameters.

w N

® Organization: Select an organization for the added platform, so that the resources of
the platform will be attached to the organization of the current platform.

® |P Address, Port, Username and Password: Enter corresponding information of the
added platform.

Step4  Click OK.

2.6 N+M

On the main server, enable the sub server, and then create the sub-standby relationship.
Prerequisites

See "2.1 Standalone Deployment" and "2.3 Distributed Deployment" to deploy the servers you
need.

Procedure

Step1 Login to the parent DSS client. On the Home page, click EY > System Deployment.
Step2  Click &,
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Step3  Click B 6 enable the sub servers.
Step4  Configure a standby server.

1. Click & of a sub server.
2. Select Standby Server for Server Type, and then click OK.

Step5  Configure the sub-standby relationship in either of the following ways.

® Go to the Server Configuration page of the sub server to select a standby server.

1. Click & of a sub server.
2. On the Select Standby Server(s) section, select one or more standby servers.

Figure 2-19 Select a standby server

9 Server Configuration

Server Name: IP Address:

Server Type:

3. Click OK.
® Go to the Server Configuration page of the standby server to select a sub server.

1. Click B ofa standby server.
2. Onthe Select Sub Server(s) section, select one or more sub servers.

You can click KA to adjust the priority.
3. Click OK.

2.7 Configuring LAN or WAN

2.7.1

2.7.2

Configuring Router

For the list of the ports that need to be mapped, see "Appendix 1 Service Module Introduction".
[1]

Make sure that the WAN ports is consistent with LAN ports.

Mapping IP or Domain Name

If the platform is deployed in a local network, you can map the IP address of the server to a fixed
WAN IP or a domain name, and then log in to the server using the WAN IP or domain name.

The page might vary between the main server and the sub server. This section uses the main server
page as an example.

Procedure

Step1 Loginto DSS server, and then double-click 2.
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Step2 Clickthe E] on the upper-right corner, and then select Network.

Step3  Enable WAN mode, enter a WAN IP address or a domain name, and then click OK.
1

If you want to use a domain name, you need to make corresponding configurations on
the domain name server.

Step4 Click OK, and then the services will restart.

2.8 Virtualization Deployment

We usually apply virtualization deployment to better utilize hardware resources. In virtualization
deployment, physical servers usually do not load virtual servers with all their allocated resources,
and do not load virtual servers and the resources they need at the same time. However, the DSS
platform frequently acquires the video streams from cameras for live view and storage, which puts
high pressure on the CPU, memory, network, and storage. The benefits of virtualization deployment
disappears when the DSS platform is running on a virtual server. Therefore, we do not recommend
that you deploy the DSS platform on a virtual server. We recommend that you install an operating
system on a physical server and directly deploy the DSS platform on the server to achieve optimal
and reliable performance.

If you have to deploy the DSS server on a virtual server, pay attention to the following content
during deployment.

Operating System for Virtual Server

® VMware®ESXi™ 7.x
® Microsoft® Hyper-V with Windows Server 2019

PC Client

When the PC client is running on a virtual server, the biggest issue is that the PC client cannot use
the GPU to decode videos. Therefore, we do no recommend installing and running the PC client on
a virtual server.

DSS Server

® [f the resources, such as CPU and memory, allocated to the virtual server are more than a
physical server required to run the DSS server, there should not be a problem for the DSS server
to run on the virtual server.

® |f the resources, such as CPU and memory, allocated to the virtual server are just the same as a
physical server required to run the DSS server, you must consider that certain resources will be
used to run the virtualized environment.

® When multiple virtual servers and other applications are running on the same physical server,
there might be performance issues. For a virtual server, it cannot make sure that certain
resources will always be used by a process. If this can be addressed, performance issues can be
minimized or avoided.

® The DSS server will continuously store videos and other data to disks. We recommend that the
DSS server should exclusively use the disks allocated to it by the virtual server, so that the DSS
server can use all of the disks' read and write capability.
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® The DSS server will continuously occupy certain bandwidth to acquire video and audio streams.
We recommend that the DSS server should exclusively use the network cards allocated to it by
the virtual server, so that the DSS server can use all of the network cards' performance.

® We do not recommend using virtual servers to configure hot standby and N+M deployment.

® |n virtualization deployment, the license might become invalid due to change of hardware
information.

2.9 Installing Plugin

You can add more functions to the platform by installing plugins.
Prerequisites

® Download the installation package from the official website.
® Purchase a license that allows you to use the functions of the plugin.

Background Information

For environments other than standalone deployment, you must make sure that the plugin versions
installed on all servers are the same. Otherwise, the main server will not be able to balance the
workload to other servers. For example, if the main server installs plugin version A, and the sub
server the plugin version B, only the plugin on the main server will work properly, and all data can
only be processed on the main server. The main server cannot use the resources of the sub server.

Procedure
Step1 Complete standalone deployment. For details, see "2.1 Standalone Deployment".
Step2 Double-click the installation package of the plugin.
Step3  Click the software license agreement, and then read the agreement.
Step4  Select the check box to accept the agreement, and then click Next.
Step5 Click Install.

1]

The plugin is installed to the same directory as the management tool by default. It cannot
be changed.

Related Operations

® To uninstall the plugin, log in to the server, go to ".\DSS\DSS Server\Uninstall", double-click
uninst_energy.exe, and then follow the on-screen instructions to uninstall the plugin. For the
main server, you can choose to keep related data. But for sub servers, related data will be kept
by default. You cannot choose to delete it.

® To update the plugin, directly install the new program.
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3 Basic Configurations

Configure basic settings of the system functions before using them, including system activation,
organization and device management, user creation, storage and recording planning, and event
rules configuration.

3.1 Managing Resources

Manage system resources such as devices, users, and storage space. You can add organizations and
devices, configure recording plans and retrieval plans, bind resources, and more.

3.1.1 Adding Organization

Classify devices by logical organization for the ease of management. The default organization is
Root . If the parent organization is not specified, newly added devices are attached to Root.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Clickk2
Step3  Add an organization.

1. Select a parent organization.
2. Click .
Figure 3-1 Add an organization

Organization

¥ im Current Site
02 test-dms

=2 Build3

= VTO

VTH

VTS

£z pyf-1

3. Enter the name of the organization, and then click OK.
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Figure 3-2 Add an organization

9 Create Organization
Parent Organization:
Root

ization Name:

Remark:

You can also right-click the root organization, and then click Create Organization to
add an organization.

Related Operations
® (Change organization name

Right-click the organization, and then click Rename.
® Delete an organization

Organization with devices cannot be deleted.

Select the organization, click B or right-click an organization and select Delete.
® (Change the organization of devices

Select one or more devices, and then click Move To to move them to another organization.

3.1.2 Managing Device

Add devices before you can use them for video monitoring. This section introduces how to add,
initialize, and edit devices and how to change device IP address.

3.1.2.1 Searching for Online Devices

Search for devices on the same network with the platform before you can add them to the
platform.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Click E

.
Step3  Click .

w

—
F

N
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W
The icon changes to k=l when devices are searched.

[

® When using the platform for the first time, the platform automatically searches for
devices on the same network segment.

® |f not the first time, the platform automatically searches for the devices in the network
segment you configured last time.

Figure 3-3 Search for devices

Organization

A+ s @

MAC Address

Step4  Specify IP Segment, and then click Search.

Figure 3-4 IP segment search

Modify IP

Initialization Status v IP Address %  Device Model MAC Address Operation

The devices have been added to the platform will not be displayed in the search results.
3.1.2.2 Initializing Devices

You need to initialize the uninitialized devices before you can add them to the platform.
Procedure

Step1  Search for devices. For details, see "3.1.2.1 Searching for Online Devices".
Step2  Select an uninitialized device, and then click Initialize.
@
® You can select multiple devices to initialize them in batches. Make sure that the
selected devices have the same username, password and email information. The
information of these devices will be the same after initialization, such as password and
email address.
® (Click = next to Initialization Status to quickly sort out devices in certain status.
Step3  Enter the password, and then click Password Security.
Step4  Enter the email address, and then click Change IP.
L]

The email is used to receive security code for resetting password.
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Step5 Enter the IP address, and then click OK.

When setting IP addresses in batches, the IP addresses increase in an ascending order.

3.1.2.3 Changing Device IP Address

You can change IP addresses of the devices that have not been added to the platform.
Procedure

Step 1  Search for devices. For details, see "3.1.2.1 Searching for Online Devices".
Step2 Select a device, and then click Change IP.
[L]

For devices that have the same username and password, you can select and modify their
IP addresses in batches.

Figure 3-5 Change IP address

st O Refresh

Initialization Status * IP Address 8 MAC Address
® Initialized

Change Device IP

Step3  Enter New IP, Subnet Mask and Gateway, and then click Save.

When setting IP addresses in batches, the IP addresses increase in sequence.
Step4  Enter the username and password used to log in to the devices, and then click OK.

3.1.2.4 Adding Devices

You can add different types of devices, such as encoder, decoder, ANPR device, access control,
emergency assistance device, alarm box, radar device, and video intercom. This section takes
adding an encoder as an example. The configuration pages shown here might be different from the
ones you see for other types of devices.

When you add devices by using automatic registration, IP segment, or importing, some devices will
fail to be added if they exceed the number of devices or channels allowed to be added to the
platform. These devices will be displayed in Devices without License.

3.1.2.4.1 Adding Devices One by One

There are multiple ways you can add devices to the platform, including using domain names, serial
numbers, IP addresses, IP segments, and automatic registration.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Click k2.
Step3  Click Add.
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Step 4

Enter device login information, and then click Add.
Select a mode to add the device.

® |P Address: We recommend selecting this option when you know the IP address of
the device.

Only Encoder devices support IPv6. If you want to add devices to the platform
through IPv6 addresses, you must first configure an IPv6 address for the platform.
Contact technical support for help.

® [P segment : Add multiple devices in the same segment. We recommend selecting
this option when the login username and password of the multiple devices in the
same segment are the same.

® Domain Name : We recommend selecting this option when the IP address of the
device changes frequently and a domain name is configured for the device.

® Auto Registration : We recommend this method when the IP address of a device
might change. The ID of auto register has to be in accordance with the registered ID
configured on the device you want to add. The port number must be the same on the
platform and on the device. The auto register port is 9500 on the platform by default.
To change the auto register port number, open the configuration tool to change the

port number of DSS_ARS service.
=t

¢ After a device is added through auto registration, hover the mouse over its IP
address on the device list, and then you can see its local IP address and the IP
address it uses to connect to the platform.

¢ Sleep function is supported for IPCs that use 4G mobile network to communicate
and are solar-powered only when they are added to the platform through
automatic registration.

® P2P: Add devices under a P2P account to the platform. The platform must be able to
access the P2P server. There is no need to apply for the dynamic domain name of the
device, perform port mapping or deploy a transit server when using it.

L]
The parameters vary with the selected protocols.

Figure 3-6 Add an encoder

1.Login Infor

IP Type:

® IPvd

IP Address: Device Port:
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Step5 Enter the information.
Step6  Click OK.

® To add more devices, click Continue to add.

® To go to the web manager of a device, click E
3.1.2.4.2 Adding Devices through Searching

Devices on the same network with the platform server can be added using the automatic search
function.

Procedure

Step1  Search for devices. For details, see "3.1.2.1 Searching for Online Devices".

Step2  Select a device, and then click Add to Device List or =
©=an

If devices have the same username and password, you can select and add them in
batches.

Figure 3-7 Add in batches

MAC Address

Step3  Select the server and organization, enter username and password, and then click OK.
3.1.2.4.3 Importing Devices

Enter the device information in the template, and then you can add devices in batches.

Prerequisites

You have downloaded the template, and then enter device information in the template.
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Figure 3-8 Download template

Organization
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Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Click 2.
Step3  Click Import.

Figure 3-9 Import devices

Import

Support File E

Step4  Click Import File, and then select the completed template.
Step5 Click OK.
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3.1.2.5 Editing Devices

Edit the information of devices.

3.1.2.5.1 Changing IP Address

For the devices that have been added to the platform, and their IP addresses have been changed,
you can edit their IP addresses directly on the platform so that they can connect to the platform

normally.

Procedure

tep 1

:

[94]

—
F

N

wnv n
—+ |+
Nolw

Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Click Device Config.

Click Edl of a device.
Edit the IP address, and then click OK.

3.1.2.5.2 Modifying Device Information

Procedure

tep 1

d

te

:

te

:

Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Click 2.
Click Bl of a device, and then edit device information.

Click Get Info and the system will synchronize device information.

Figure 3-10 Basic information

Click Video Channel, and then configure the channel information, such as the channel
name and channel features.

[

® The features that you can set for channels vary with the types of devices.
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® |f the device is added through the ONVIF protocol, you can configure the stream type
of it video channels.

Step5 Click the Alarm Input Channel tab, and then configure number, names, and alarm types
of the alarm input channels.

L1

Skip the step when the device does not support alarm input.

® Alarm type includes external alarm, Infrared detect, zone disarm, PIR, gas sensor,
smoke sensor, glass sensor, emergency button, stolen alarm, perimeter and preventer
move.
® Alarm type supports custom. Select Customize Alarm Type in the Alarm Type drop-
down list. Click Add to add new alarm type. It supports up to 30 custom alarm types.
Step6  Click the Alarm Output Channel tab and then edit the number and names of alarm
output channels.

Step7 Click the POS Channel, and then edit the number and names of the POS channels.
(1]

el

This tab will only appear if the device has POS channels.

Step8 Click the Audio and Light Channel tab, and then edit the number and names of the
audio and light channels.

1]

This tab will only appear if the device has audio and light channels.
Step9  Click OK.

3.1.2.5.3 Getting Device Information in Batches

This function allows you to get information from device in batches to reduce repeated operations.
For example, if the platform fails to get information from certain devices after you add them in
batches, you can use this function to get the information from them at the same time.

Procedure

tep1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device > Add Device.

:

Step2 Select an organization, and then the devices in this organization and its sub organizations
will be displayed on the right.

Step3  Select multiple devices.

Step4  Select More > Get Info, and then click OK.

Wait for the platform to finish the process.
Related Operations

If the platform still cannot get information from certain devices, click k%4 to see the reasons.
3.1.2.5.4 Configuring Channel Features in Batches
Configure the channel features in batches so that devices can work normally.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  On the top of the page, select More > Capability Set Management.
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Step In the Capability Set Type drop-down list, select a type, and then the platform will only
display devices and channels that are configured with that type of capability set.

tep 3
Step4  Select the channels you want to configure.
Step5 Click the area below the Features column, and then select one or more features.

Figure 3-11 Select capability sets

Channel Name Device Name Organization Features

IPC IPC

Electric Focus

Step6  Complete configuration.

® |f configuration is complete, click Complete to save the settings and exit the page.

® |f you want to configure more channels, click Save to save your current settings, and
then continue your configuration. When it is complete, click Complete to save the
settings and exit the page.

3.1.2.5.5 Modifying Device Organization

You can move a device from an organization node to another one.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Click 2
Step3  Select a device to be moved, click Move To, select the target organization, and then click
OK.

Figure 3-12 Move a device

. MoeTo

3.1.2.5.6 Changing Device Password

You can change device usernames and passwords in batches.

Procedure
Step1 Login tothe DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.
Step2  Clickk2
Step3  Select a device, and then click Change Password.
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You can select multiple devices and change their passwords at the same time.

Figure 3-13 Change device password

+ Add W Delete % Import % Bport [ MoveTo € Time Zone: gs @ More

swords in Batches . izati Online Status ¥  Offline Reason Operation

ord:
2990990008

- Szl

Step4  Enter the old and new passwords, and then click OK.

3.1.2.6 Logging in to Device Webpage

After a device is added to the platform, you can click E to go to the webpage of the device.

The platform supports accessing the webpage of a device through the HTTPS protocol. If you want
to use this function, you must complete the following steps. For details procedures on the device
webpage, see the user's manual of the device.

1. Log in to the webpage of the device, and then download the trusted CA root certificate.
2. Double-click the certificate, and then click Install Certificate.
3. Select Current User, and then click Next.

&# Certificate Import Wizard

Welcome to the Certificate Import Wizard

This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.

A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure networlk
connections. A certificate store is the system area where certificates are kept.

Store Location
(@) Current User
() Local Machine

To continue, dick Next.

MNext Cancel

4, Store the certificate to Trusted Root Certification Authorities, and then click Next.
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& L4 Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

(O Automatically select the certificate store based on the type of certificate
(®) Place all certificates in the following store

Certificate store:
|Trusted Root Certification Authorities Browse...

Next Cancel

5. Click Finish.
6. On the webpage of the device, create a device certificate, and then apply it.

|

For the IP address in the certificate, you must enter the IP address of the computer that visits the
webpage.

3.1.2.7 Exporting Devices

You can export the information of devices to your computer. This is useful when you need to switch
or configure a new platform, you can quickly add them all by importing them. You can export up to
100,000 devices at a time. Only administrators are allowed to export the login passwords of devices.

Procedure

wn
—
[}
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Step 6

Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Click .

(Optional) Select only the devices that you need.

Click Export.

Enter the login password, encryption password, select whether to export the passwords
of devices and the export range, and then click OK.

[

You can configure whether to verify the login password. For details, see "7.4.1 Configuring
Security Parameters".

® The encryption password is used to protect the export file. It consists of 6 uppercase or
lower case letters, numbers, or their combination. You need to enter it when using the
export file.

® You can select All to export all the devices, or Selected to export the devices you
selected.

Select a path on your PC, and then click Save.

3.1.2.8 Modifying Device Time Zone

Configure device time zone correctly. Otherwise you might fail to search for recorded video.
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If a device is accessed through ONVIF and the ONVIF version is earlier than 18.12, the device DST
cannot be edited on the platform. You can only edit it manually on the device.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2 Clickk2
Step3  Select a device, and then click Time Zone Settings.

Figure 3-14 Modify device time zone

[ JEES & Import % Export

IP Address + Device Name Device Type ~ Organization Online Status

192 Time Zone Settings

2aja California

- s

Step4  Select a time zone.
Step5 Click OK.

3.1.3 Binding Resources

You can bind different types of channels, such as an ANPR channel or door channel, to a video
channel. You can view real-time videos of the bound channels in different functions, or linked them
for certain actions in an event, such as recording a video.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Click =l
Step3  Select a channel, and then click Modify.

Figure 3-15 Bind one or more channel

Config VTH

— Ty

Eventinfo F

Time Template Holiday Template Action

Bind Video Channel odif

Channel Name

Step4  Select one or more channels, and then click OK.
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Figure 3-16 Select the channels you want to bind

9 Channel Bind

elect Channel Selected(1)
Q Channel Name Device Name Operation

IPC -]

IO D

-

e I N

o e

@l 0 0 0

Step5 Click OK.

3.1.4 Adding Recording Plan

Configure recording plans for video channels so that they can record videos accordingly.

You can configure 2 types of recording plans for a channel. One is general recording plan, and a
device will continuously record videos during the defined period. The other is motion detection
recording plan, and a device will only continuously record videos when motion is detected.
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3.1.4.1 Adding Recording Plan One by One

Add a center recording plan or device recording plan for a channel, so that it can make general or
motion detection videos within the defined period.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Click ]
Step3  Select a channel, and then configure a recording plan.

:

wn
~
D

N

® (Configure a center recording plan.
1. Click Add Recording Plan next to Center Recording Plan.
Figure 3-17 Add a center recording plan (1)

Config

Al Rule Config Sync People Counting...

2. Configure the parameters, and then click OK.

Table 3-1 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the server by default. It cannot be changed.

® General recording: The device will continuously record videos within
the defined periods.

® Motion detection recording: The device will continuously record videos
within the defined periods on motion detections.

Recording Type

Select Main Stream , Sub Stream 1 or Sub Stream 2.

Stream Type Videos recorded on the main stream will have the best quality, but they
require more storage.

Remarks Customizable description for the recording plan.

Select a default time template or click Create Time Template to add a

Recording Time new time template. See "3.1.6 Adding Time Template".

3. Click OK.
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® (Configure a device recording plan.

The platform can obtain and display the recording plan that has been configured on
EVS of the latest versions. You can check if recording plan are obtained and displayed
on the page to know if your EVS is of the latest version.

1. Click Add Recording Plan next to Device Recording Plan.
Figure 3-18 Add a device recording plan (1)

Config

Al Rule Config Sync People Counting...

2. Configure the parameters, and then click OK.

Table 3-2 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the device by default. It cannot be changed.
The device will make recordings using the main stream by default. It cannot
Stream Type
be changed.
Remarks Customizable description for the recording plan.
Recording Time Select a default time template or click Create Time Template to add a
9 new time template. See "3.1.6 Adding Time Template".

Related Operations

® FEnable/disable a recording plan

BB means that the plan has been enabled. Click the icon and it becomes B ond it means
that the plan has been disabled.

® (lick : Copy the recording plan to other channels.
® Edit a recording plan

Click & of corresponding plan to edit the plan.
e ClickElto delete recording plans one by one.

41



a/hua

TECHNOLOGY

User's Manual

3.1.4.2 Adding Center Recording Plans in Batches

Add a center recording plan of general or motion detection videos for multiple channels at the

same time.

3.1.4.2.1 General Recording Plan

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Storage Plan > Recording Plan.

Organization

Figure 3-19 Center recording plan

Step2  Select General Recording Plan > Add General Recording Plan.

Step3  Configure the parameters, and then click OK.

Table 3-3 Parameter description

Parameter Description

Enable Turn on or off the recording plan.

Position Videos will be stored on the server by default. It cannot be changed.
Select Main Stream , Sub Stream 1 or Sub Stream 2.

Stream Type Videos recorded on the main stream will have the best quality, but they
require more storage.

Remarks Customizable description for the recording plan.

Recording Time Select‘ a default time terrlulplate or c!ick C'reate Time T?mplate toadda
new time template. See "3.1.6 Adding Time Template".

Recording Channel |Select the channels you want to add the recording plan for.

42



a/hua

TECHNOLOGY User's Manual

3.1.4.2.2 Motion Detection Recording Plan

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Storage Plan > Recording Plan.

Figure 3-20 Center recording plan

Organization

Step2 Select Motion Detection Recording Plan > Add Motion Detection Recording Plan.
Step3  Configure the parameters, and then click OK.

Table 3-4 Parameter description

Parameter Description
Enable Turn on or off the recording plan.
Position Videos will be stored on the server by default. It cannot be changed.

® General recording: The device will continuously record videos within
the defined periods.

® Motion detection recording: The device will continuously record videos
within the defined periods on motion detections.

Recording Type

Select Main Stream, Sub Stream 1 or Sub Stream 2.

Stream Type Videos recorded on the main stream will have the best quality, but they
requires more storage.

Remarks Customizable description for the recording plan.

Select a default time template or click Create Time Template to add a

Recording Time new time template. See "3.1.6 Adding Time Template".

Recording Channel | Select the channels you want to add the recording plan for.

Related Operations

® FEnable/disable a recording plan
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B means that the plan has been enabled. Click the icon and it becomes B nd it means
that the plan has been disabled.

® Edit a recording plan

Click B of corresponding plan to edit the plan.
® Edit a recording plan

Click & of corresponding plan to edit the plan.
o B select multiple channels, and then delete them at the same time.

and KEBEER: Select multiple channels, and then enable or disable them at the same time.

3.1.5 Adding Video Retrieval Plan

Configure a video retrieval plan to upload the videos that devices record when they are
disconnected from the platform. During the defined period, videos will be automatically uploaded
to the platform. The platform supports uploading videos within the past 7 days, including the day
when the retrieval plan is executed. You can add a retrieval plan for each channel one by one, or
add one for multiple channels in batches.

3.1.5.1 Adding Retrieval Plan One by One

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Click 2.

Figure 3-21 Add a retrieval plan for a channel

Config

Step3  Select a device, and then click Add Retrieval Plan.
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Figure 3-22 Add a retrieval plan

9 Recording Retrieval

Channel Name

Step4  Configure the parameters.

Table 3-5 Parameter description

Parameter Description

Enable Turn on or off the retrieval plan.

Select a period, and then the videos within the defined period will
be uploaded. The platform supports uploading videos from devices
within the past 7 days at most. Videos from the current day will also
be included.

Backup Storage for Retrieval

Select the stream type of the videos that you want to upload.

Stream Type If the videos are recorded on sub stream 1 and Main Stream is
configured in this retrieval plan, uploading will fail.

Schedule Configure when to upload videos every day. CIickE‘a to configure
specific periods. You can configure up to 6 periods.

Step5 Click OK.
Related Operations

® FEnable/disable retrieval plan

B means that the plan has been enabled. Click the icon and it becomes B and it means
that the plan has been disabled.

® Edit retrieval plan

Click & of corresponding plan to edit the plan.
® ClickEto delete recording plans one by one.

3.1.5.2 Adding Retrieval Plans in Batches

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Storage Plan > Recording Retrieval > Video Retrieval.
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Figure 3-23 Video retrieval

Organization

ckup Storage for Retrieval

Step2 Click Add Video Retrieval Plan.

Figure 3-24 Configure a video retrieval plan

9 Add Video Retrieval Plan

Basic Info

Enable
—o

Retrieval Channel

Select Channels Selected(0
Q Channel Name Device Name Operation

» i Root

- Cancel

Step3  Configure the parameters, and then select channels in the Retrieval Channel section.

Table 3-6 Parameter description

Parameter Description

Enable Turn on or off the retrieval plan.
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Parameter Description

Select a period, and then the videos within the defined period will
be uploaded. The platform supports uploading videos from devices
within the past 7 days at most. Videos from the current day will also
be included.

Backup Storage for Retrieval

Select the stream type of the videos that you want to upload.

Stream Type If the videos are recorded on sub stream 1 and Main Stream is
configured in this retrieval plan, uploading will fail.

Schedule Configure when to upload videos every day. CIickE‘a to configure
specific periods. You can configure up to 6 periods.

Step4  Click OK.
3.1.5.3 Adding Retrieval Plan for MPT Devices

3.1.5.3.1 Adding One by One

The procedures are the same as other devices. For details, see "3.1.5.1 Adding Retrieval Plan One by
One".

3.1.5.3.2 Adding in Batches

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Storage Plan > Recording Retrieval > File Retrieval.

Figure 3-25 File retrieval

Organization

Step2 Click Add File Retrieval Plan.
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Figure 3-26 Configure a file retrieval plan

9 Add File Retrieval Plan

Basic Info

Enable
—e

Retrieval Device

Q Device Name

Operation

Step3  Configure the parameters, and then select MPT devices in the Retrieval Device section.

Table 3-7 Parameter description

Parameter

Description

Enable

Turn on or off the retrieval plan.

Backup Storage for Retrieval

Select a period, and then the videos within the defined period will
be uploaded. The platform supports uploading videos from devices
within the past 7 days at most.

L1

Videos from the current day will also be uploaded.

Execute retrieval plan only
when Wi-Fi is connected

When selected, videos on MPT devices will be uploaded only when
they are connected to a Wi-Fi network.

If it is not selected and MPT devices are connected to the mobile
network, uploading videos might result in additional charges.

Time to Execute Plan

Configure when to upload videos every day. Click E‘H to configure
specific periods. You can configure up to 6 periods.

Step4 Click OK.
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3.1.6 Adding Time Template

Procedure

[Val
~
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—

wn [\ |
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Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Click 2,

Select a channel, and then add a recording plan.
In the Recording Time drop-down list, select Create Time Template.

Creating time template in other pages is the same. This chapter takes creating time
template in Record Plan page as an example.

Figure 3-27 Create time template

Time Template

Step 5

Step 6

Time templ.
Time Template Name: Copy From:

Monday:

Thursday:

Saturday:

s ]
o]
o]
o
o
o]
o

Sunday:

Configure name and periods. You can set up to 6 periods in one day.
Select the Copy From check box, and then you can select a template to copy from.

® On the time bar, click and drag to draw the periods. You can also click =], and then
draw the periods for multiple days.

® You canalso click E to configure periods.
Click OK.

3.1.7 Configuring Video Retention Period

For videos stored on the platform, you can configure video retention period. When the storage
space runs out, new recorded videos will cover the oldest videos automatically.

Procedure

Step 1

Step 2

Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device > Device Config.

Select a camera, and then click Modify.
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Figure 3-28 Go to recording storage configuration page

Device Recording Plan  Add

Recording Time

RecordingRetrieval A

Conditions to Execute Plan

Retention Period (Days)

Enable one or more video types, set the retention period for each one, and then click OK.

(Optional) Configure retention period for multiple channels.
1. Click OK and Copy.
2. Select which channels to apply the configuration.

Only administrators can select All Channels.
3. Click OK.

3.1.8 Configuring Events

You need to set up the event configuration on a device or its channels to receive alarms on the

platform.

Procedure

Step 1

Step 2

Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device > Device Config.

Select a channel or a device, and then click Event Config.

Events that can be configured are different for different types of devices. If you select
Device, you can only configure general events. If you select Channels, various events
supported by different types of channels will be displayed.

Figure 3-29 Go to the event configuration (device)

Config

¥ i Current Site

> Event Info

o e Associated Scheme Event Type Priority

0 B

» B
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Figure 3-30 Go to the event configuration (channel)

Config

Sync People Counting...

Event Info | Event Config

Event Type Priority Time Template
CM IPC-qiuji
=Bl

2 IPPTZ Camera

Step3  Configure events. For details, see "4.1 Configuring Events".

3.1.9 Synchronizing People Counting Rules

If you create, edit or delete people counting rules on a device, you have to manually synchronize
them to the platform.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Click =l
Step3  Select a channel, and then click Sync People Counting Rules.

Figure 3-31 Synchronize people counting rules from the device

- Video Channel Type:

Bullet Camera
¥ {1 Root

P £z FhbTest

Config

Al Rule Config Sync People Counting ...

EventInfo EventConfig
Event Type Priority Time Template

Motion Detection High All-Period Template

Recording Info Add Recorc

Storage Path Time Template
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Step4  Click Sync Rules, and then the system prompts Synchronization Complete.

Figure 3-32 Synchronize people counting rules from the device

9 Sync People Counting Rules

3.2 Adding Role and User

Users of different roles have different menus and permissions of device access and operation. When
creating a user, assign a role to it to give the corresponding permissions.

3.2.1 Adding User Role

Arole is a set of permission. Classify users of the platform into different roles so that they can have
different permissions for operating the devices, functions and other system resources.

® Super administrator: A default rule that has the highest priority and all the permissions. This role
cannot be modified. A super administrator can create administrator roles and common roles.
The system supports 3 super administrators at most.

® Administrator: A default rule that cannot be modified and has no permission of configuring
cascade, authorization, backup and restoring. An administrator can only create common roles.

® Common role: A common role that has no permission of configuring cascade, authorization,
backup and restoring, user management, and device management.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User.

click E8.

Click Add, set role information, and then select device and control permissions and assign
the rule to users.

wn [\
~ |~
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Figure 3-33 Add arole

L1

® [f a device is not selected under Device Permissions or a menu not selected under
Menu Permissions, all users assigned with this role will not be able to see the device
or menu.

® (Click m of a selected organization. All permissions of subsequently added devices
under this organization will also be assigned to users of this role.

Step4  Click OK.

3.2.2 Adding User

Create a user account for logging in to the platform.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User.

Step2  Click A

Step3  Click Add, and then configure the user information.
Table 3-8 Parameter description

Parameter Description
Username Used to log in to the client.
Multi-client Login Allow the user to log in to multiple clients at the same time.
Password

Used to log in to the client.
Confirm Password
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Parameter Description

Enable and enter a name, and then this user will be set as an MPT user.
This is used in the group talk function in the map. For details, see "5.1.4
Map Applications".

MPT User

If you enable this function, you cannot enable Multi-client Login.

Enable Forced
Password Change at The user is required to change the password at first-time login.
First Login

Enable Password

Change Interval Force the user to change the password regularly.

After the password expires, the user cannot log in to the client. If already

Enable Password Expiry logged in, the user will be forced to log out. The user must reset the

Time password through email or contact the administrator.

The PTZ control priority of the user. The larger the value, the higher the
PTZ Control priority. For example, User A has a priority of 2 and User B has a priority
Permissions of 3. When they operate on the same PTZ camera, which is locked, at the

same time, the PTZ camera will only respond to the operations from
User B.

Used to receive emails in various situations, such as password reset,

Email Address .. . .
alarm messages, and visitor registration.

Limit the user to log in from specific computers. One user can be bound

Bind MAC Address to 5 MAC addresses at most.

Select one or more roles to assign the user permissions, such as which

Rol .
o devices are allowed to be operated.

Step4  Click OK.
Related Operations

® Click Elto lock user. The locked user cannot log in to the DSS Client and App.

e ClickEto modify information of a user except the username. Users with a higher level of
permissions can change the passwords of users with a lower level of permissions. Super
administrators can change the passwords of administrators and common roles. Administrators
can change the passwords of common roles.

e Click B to delete a user.

3.2.3 Importing Domain User

When the users in a domain can be used as users on the platform, you can use this function to
import quickly them to the platform.

Procedure
Step1  Configure the domain information.
1. Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter > Active Directory.

2. Click - to enable the function, and then configure the parameters of the domain.
3. Click Get DN to automatically get the basic DN information.
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4. Click Test to check whether the domain information is correct.

5. (Optional) Enable the automatic synchronization function and set a time. Then, the
platform will automatically synchronize news users in domain groups that you have
imported previously, and update the information of the users imported by manual
selection at the defined time every day.

For example, you have imported the entire domain group A. The platform will

synchronize new users in domain group A every day at the defined time. CIickE] to
remove a group on the list, and then it will not be synchronized. For users imported by
manual selection, the platform will check their information, and update if anything
changes.

6. Click Save.

Step2 Import domain users.

1. Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User > User Management.

2. Click Import Domain Users.
3. Select how you want to import users, and then click Next Step.

® |mport by Domain Group : Import all users in the selected group.
©=8

If you import an entire domain group and after the automatic synchronization
function is enabled, the platform will remember that group and automatically
synchronize its new users at the defined time every day, and update the
information of the users imported by manual selection at the defined time every
day. For details, see the previous steps.

® |mport by Domain User : Import selected users in a group.

4, Click ms to select a role for the users.

All the permissions in the role will be assigned to the users.
5. Click OK.

3.2.4 Syncing Domain User

Use this function to delete invalid domain users from the platform.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User > User Management.

Step2  Click Sync Domain Users.

The platform prompts that this operation will delete invalid domain users.
Step3  Click OK.

3.2.5 Password Maintenance

Users can change passwords manually or reset it on the login page. Also, Users with a higher level
of permissions can change the passwords of users with a lower level of permissions. Super
administrators can change the passwords of administrators and common roles. Administrators can
change the passwords of common roles.
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3.2.5.1 Changing Password for the Current User

We recommend changing your password regularly for account safety.
Procedure

Step1 Login to the DSS Client, click H at the upper-right corner, and then select Change
Password.

Figure 3-34 Change password

Step2  Enter the old password, new password, and then confirm the new password. Click OK.
3.2.5.2 Changing Password for Other Users

Users with a higher level of permissions can change the passwords of users with a lower level of
permissions without knowing their passwords. Super administrators can change the passwords of
administrators and common roles. Administrators can change the passwords of common roles.

Procedure

:

tep1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User.

Step2  Click B,
Step3  Select a user, and then click a
Step4 Enable Change Password , enter the new password and confirm password, and then click

OK.
Figure 3-35 Change passwords for other users
Basic Info

Jsername: i-cli i
Username: Multi-client Login:

. Change Password Confirm Password:
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3.2.5.3 Resetting User Password

Users can reset passwords through email addresses and security questions. Only super
administrators can reset passwords through security questions.

Procedure
Step1  Onthelogin page, click Forgot password?.

Step2  Enter the account that you want to reset the password for, and then click Next Step.
Step3  Select how you want to reset the password.

® By security questions. This is only applicable to super administrators.

1. Click Reset Password through Security Questions.
2. Answer the questions, and then click Next Step.

® By email address. This is applicable to all accounts, but an email address must be
configured first. For details, see "3.2.2 Adding User".

1. Click Reset Password through Email Verification.
2. Click Send Verification Code.

3. Enter the verification code that you received from the email address, and then click
Next Step.

Step4  Setanew password and confirm it, and then click Next Step.

The password has been reset.

3.2.5.4 Resetting Security Questions for Super Administrators

Super administrators can reset their security questions that can be used to reset passwords.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User > User Management.

Step2  Click ksl to edit the information of a super administrator.
Step3  Click Reset to reset the security questions after verifying the login password.

3.3 Configuring Storage

Manage the storage of the platform, including adding network disks, setting storage types to store
different types of files, creating disk groups to store files from specified channels, and setting the
storage location and retention period of the images and recorded videos from devices.

3.3.1 Configuring Network Disk

Prerequisites

® The storage server is required to be deployed.
® One user volume of the current network disk can only be used by one server at the same time.

® User volume must be formatted when adding network disk. Check if you have backed up the
data.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Storage.
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Step Select .

tep 2
Step3  Click Add.
Step4  Select server name and mode, enter the IP address of network disk, and click OK.

® Normal mode: All volumes of the network disk will be added. Those used by any user
will be in red.

® User mode: Enter the username and password of a user. Only volumes of the network
disk assigned to this user will be added.

Figure 3-36 Add network disk (normal mode)

D Add NetDisk

- CanCEI

Figure 3-37 Add network disk (user mode)

9 Add NetDisk

Network Disk IP:

- &zl

Step5  Select disk, and then click & to format the corresponding disk.

1. Select user volume, and then click El.
2. Select format disk type, and then click OK.

® Video: Stores videos.
® |mage and File : Stores video files from MPT devices, and all types of images.
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Figure 3-38 Format disk

Initialize Disk

Disk Type:

Video

Related Operations

® To configure disk type, click B

® To format a disk, click =],
1]

Formatting will clear all data on the disk. Please be advised.

3.3.2 Configuring Server Disk

Configure local disk to store different types of files, including videos, ANPR snapshots, incident files,
and face or alarm snapshots. In addition to the local disks, you can also connect an external disk to
the platform server, but you have to format the external disk before using it.

L1

® To set up local storage, you need a physical disk with only one volume or any volume of one
physical disk. Back up the data of the disk or volume before setting its disk type, which will
format and erase all data from it.

® One physical disk with only one volume or any volume of one physical disk can only store one
type of files. If you need to store more than one type of files, you need more than one physical
disks or volumes, but it cannot be the one where you installed the operating system of the
server or the management tool.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Storage.

Select @

Format a disk to set a storage type.

A\

This operation will clear all data on the disk. Please be advised.

W [N
~ |
F%
w N

1. Select user volume, and then click &,
2. Select storage type, and then click OK.

® Video: Stores videos.

® |mages and Files : Stores video files from MPT devices, and all types of images.

® |ncident File : Stores videos and images in the case bank. This disk cannot be
overwritten.
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If you do not set up one or more disk types, you will not be able to properly use
corresponding functions. For example, if you do not set up an Image and File disk,
you will not see images in all alarms.

Step4 Manage local disks.
® |nitialize disk
Click @,
® To configure disk type: Click E

® To format a disk: Select a disk or user volume, click =

3.3.3 Configuring Disk Group

Allocate disk groups for video storage.
Procedure

Step1 Login tothe DSS Client. On the Home page, click EY and then in the Basic Config
section, select Storage.

P
Step2  Click .

Step3 Click Add Disk Group, enter disk group name, and then select a server and disks.
Figure 3-39 Configure disk group

1. Set disk group

up, the disk capacity of th sks in the same group must be close to each other to allow ge data to be written in load balancing mode.

Select Disks
Disk Name Capacity (GB) Disk Name Operation

Izl-vedio

Step4  Click Next Step.
Step5  Select devices or channels on the left.
Step6  Click OK.

3.3.4 Configuring Device Storage

When there are a large number of devices on the platform, it will put too much pressure on the
network disks or local disks because they might produce a lot of face, video metadata, and event
images, and videos that need to be stored. The platform supports setting the storage location and
retention period of the images and videos for storage devices, such as an IVSS, to reduce the
pressure on the server.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Storage > Device Storage Config.

Only organizations with storage devices are displayed, such as NVR and IVSS.

60



a/hua

TECHNOLOGY

User's Manual

Step2  Select an organization, click E’] of a device on the right.

Step3  Configure the parameters, and then click OK.

Table 3-9 Parameter description

Parameter

Description

Event Image Storage
Location

® Save to Central Storage : All images produced by the channels
connected to this device will be stored on the network disks or
local disks of the platform.

® Link to Images on Device : All images produced by the channels
connected to this device will be stored on the device itself. The
platform will obtain images from the device.

Event Video Storage
Location

® Save to Central Storage : All alarm videos produced by the
channels connected to this device will be stored on the network
disks or local disks of the platform.

® Link to Videos on Device : All alarm videos produced by the
channels connected to this device will be stored on the device
itself. The platform will obtain videos from the device.

|

To make sure that alarms videos are complete, we recommend
you set a 24-hour recording plan for the device. Otherwise, the
platform might not be able to obtain videos. For example, a
recording plan of 00:00-14:00 has been configured on the device
so that the channels connected to it will record videos during that
period. If an alarm is triggered on 14:01, the platform will not be
able to obtain videos for this alarm.

Retention Time of Images
and Videos on Device

This function is applicable to the images and videos stored on the
device.

After enabled, the platform will obtain the value from the device, and
you can change it to 1-255. The images and videos that have been
stored longer than this value will be automatically deleted.

A\

Deleted files cannot be recovered. Please be advised.
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4 Businesses Configuration

This chapter introduces the basic businesses, such as storage plan, video monitoring, access
control, alarm controller, video intercom, target detection, face recognition, parking lot, and

intelligent analysis.

4.1 Configuring Events

To receive alarms triggered by devices, you need to configure them on the platform.

4.1.1 Configuring Event Linkage

Configure the event source, and the linked actions. When the event is triggered, the platform will
perform the actions you defined, such as taking a snapshot recording a video.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Event > Event Config.

Step2  Click Add.
Step3  Configure the event source.

Table 4-1 Parameter description
Parameter Description

Device, video channel, alarm
input channel, zone, EAS
alarm channel, access
control channel, radar,
parking lot, people counting
group, lift control channel,
and POS alarm

Select an event source type.

(1

® Before configuring the event, check whether the channel
features match the event type; otherwise the event type cannot
be selected as the alarm source. To configure channel features,
see "3.1.2.5.2 Modifying Device Information".

® |f Alarm Input Channel is selected, check whether the
Triggered Event that you select matches the channel feature
of the alarm input channel you select. Otherwise, the event will
not be triggered.

Soft Trigger

This is a type of event that is manually triggered. Click Add Soft
Trigger Event Type to customize its name and icon. When
viewing the live video image of the configured channel in the
Monitoring Center, you can click the icon to trigger an alarm
manually.

Combined Event

When a combined event is triggered, the platform performs the
defined linked actions. For how to configure combined events, see
"4.1.2 Configuring Combined Event".
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Parameter

Description

Custom Alarm

® DHOP event: Access events developed through Dahua
Hardware Open Platform (DHOP).

® Extended standard event: This is used for events that devices
support, but the platform currently does not. Click Add
Extended Standard Event, and then configure the parameters.

¢ Alarm Source : Access events from encoder devices, video
channels, and alarm input channels.

¢ Event Image : When configuring an event for a video
channel, you can choose whether to subscribe to images
from the event. When subscribing to pictures, the platform
will receive alarm images generated by the alarm source.
However, if the alarm source does not generate alarm
images, subscribing to the event images will cause the
platform to not receive the alarm.

¢ Name and Alarm Code: Enter the name and code of the
event.

Step4  Configure the priority, when the event can be triggered, and other information.

Table 4-2 Parameter description

Parameter

Description

Scheme Name

Enter a name for the scheme.

Priority

The priority level is used to quickly know the urgency of the event
when it is triggered.

Time Template

Select a time template for when the event can be triggered. If you
want to create a new template, see "3.1.6 Adding Time Template".

Holiday Template

If the time template and holiday template overlap, only the holiday
template will be effective. During the defined periods, events will be
received by the platform normally. Outside of the defined periods,
events will not be received by the platform. To create a new template,
follow the steps below.

1. In the drop-down box, click Create Custom Holiday Template.
2. Enter a name for the template.
3. Click Add, and then add a period and adjust the time.

You can add up to 6 periods.

4. (Optional) If there are other holiday templates, you can select
Copy From, and then select a template to copy its periods.

5. Click OK.

Tag

Enter some content that is used for filtering among a large amount of
events.

Step5 Configure alarm linkage actions.

® To link video, enable Linked Action > Link Video, and then configure the

parameters.
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Table 4-3 Parameter description

Parameter Description
¢ Event source: The camera of the alarm itself is linked when the alarm
occurs.
¢ Bound camera: If the channel is bound to one or more video
Camera channels, you can view the real-time videos of the bound channel

when an alarm is triggered. To bind a channel, see "3.1.3 Binding
Resources".

¢ Select camera: Select a camera so that you can view the camera
video when the associated alarm is triggered.

When an alarm is
triggered, display
camera live view on
client

Enable this parameter, and then the platform will open the real-time
video of the channel where an alarm is triggered, and play it in the
defined stream type.

[

After the event is configured, select Local Settings > Alarm, enable
Open Alarm Linkage Video and set how the video will be opened, As
Pop-up or Open in Live View. For details, see "8.3.4 Configuring Alarm
Settings".

Event Recording

The platform will record videos when an alarm is triggered. It will be
saved to the video disk of the platform.

Stream Type

Define the stream type of the recorded video. If you select main stream,
the recorded video will be in higher quality than sub stream, but it
requires more storage.

Recording Time

The duration of the recorded video.

Prerecording Time

When there is recorded video that is stored on the device or platform
before the alarm is triggered, the platform will take the defined duration
of that video, and then add it to the alarm video. For example, when the
prerecording time is set to 10 s, then the platform will add 10 s of video
before the alarm is triggered to the alarm video.

@

For how to configure the pre-recording mode for devices in batches, see
"4.1.3.3 Configuring Alarm Video Pre-recording".

[

¢ If the alarm video is stored on the device, we recommend you
configure a 24-hour recording plan to make sure that there is
prerecorded content to add to the alarm video.

¢ If the alarm video is stored on the platform, the platform will record
videos and use certain input bandwidth continuously.

¢ This parameter is not applicable to alarms in parking lots.

® To trigger a snapshot, enable Trigger Snapshot. The platform takes 2 snapshots, and
save them to the Image and File disk.

Select a video channel, and then it will take a snapshot when an alarm is triggered.
® To link a PTZ action, click Link PTZ, and then select the PTZ channels and presets to be

linked.

® (lick Alarm Output, select an alarm output channel, and then set the duration. The
channel will send out alarm signal when an alarm is triggered.
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Camera:

Select Camera

® To link audio and light, click Link Audio and Light, select the audio and light
channels, and then select the action duration.

® (lick Link Access Control Device, select door channels, and then select a linked
action. When an alarm is triggered, the door channels you selected will be locked,
unlocked, normally open or normally closed.

® Display the live video of specified channels on a video wall when alarms are triggered.

Click Link Video Wall, and then select the channels and video wall.
1]

You must add a video wall and configure its alarm on video wall mode first. For details,
see "5.1.5.1 Configuring Video Wall" and "4.1.3.2 Configuring Alarm on Video Wall".

If you select Camera to Select Camera, you can configure which channels to be
displayed on the specified video wall. When the video wall you select is configure with
the override mode, you can also select Customize Alarm Window, and then you can
select which channels to be displayed on the specified windows of the video wall.

Figure 4-1 Display video of specified windows

. Customize Alarm Window

Select Channels

Step 7

Selected(1)

Channel Organization Video Wall Alarm Mode Window Operation

IP PTZ Camera sD Video Walll “ | Override Mode Window 1 ‘e

17
123 Window 2
AAA Window 3

Video Wall1 Window 4

® To execute an HTTP URL; command, click Link HTTP URL Command . Click Add, and
then configure its request method, HTTP URL, and remarks. You can click & to test if
the command is valid.

® To link emails, enable Email, and click Bl to add the email address, and then an email
will be sent to the selected email address when an alarm is triggered. You can also
manually enter an email address, but you must press Enter to make it valid.

To configure the email template, select Add Email Template from the Email
Template drop-down list.

® Apply an alarm protocol to help users process alarms when they are triggered. Click
Alarm Protocol , and then select a protocol from the Protocol Template drop-down
list.
Or you can click Add protocol template to create a new protocol.

Select one or more users who will receive the notification when an alarm is triggered.

The users will only receive notifications when they are logged in. If you need to add more
users, see "3.2 Adding Role and User".

@-ﬂ_-“.

If the page becomes too long because you need to configure many parameters, you can
use the pane on the right to quickly go to different positions.

Click OK.
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4.1.2 Configuring Combined Event

Configure the relation between the time of trigger of 2 events, and then you can configure what
actions to performed when the event is triggered.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Event > Combined Event Rule Config.

Step2 Click £ to add a rule for combined events.
Step3  Enter a name for the rule, and then configure the details.

For example, select event B occurs and configure the X and Y to be 10 and 50 seconds
respectively. If event B occurs during the 10 seconds to 50 seconds after event A occurs, a
combined event is triggered, and then the platform will perform defined linked actions.

Step4  Click OK.

The previous page displays.
Step5  Click Add, and then configure the parameters of the combined event.

Table 4-4 Parameter description

Parameter Description

Name Enter a name for the combined event.

Rule Select arule.

Source of Combined Event Select the event and event source for event A and B.

Step6 Click OK.
Related Operations

Configure the linked actions for the combined event. For details, see the previous section.

4.1.3 Configuring Alarm Parameter

4.1.3.1 Filtering Repetitive Alarm

If certain alarms are frequently triggered, you can configure an interval during which they can only
be triggered once. For example, a tripwire alarm can only be triggered once in 10 seconds.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and thenin the App Config
section, select Event > Alarm Config > Alarm Storm Config.

Step2 Click Add.

Step3  Select an event, and then configure the interval.

Step4 Click OK.
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4.1.3.2 Configuring Alarm on Video Wall

When an alarm is triggered, the live video of a channel can be linked to a window on a video wall.
The platform supports override and loop modes.

Prerequisites

You must add a video wall first. For details, see "5.1.5.1 Configuring Video Wall".

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Event > Alarm Config > Alarm on Video Wall.

Click E]

Step 2
Step3  Select a mode, and configure related parameters.

Table 4-5 Parameter description
Parameter Description

Alarm on Video Wall Mode

® Override mode: When an alarm occurs, a live video is opened on
the specified window of a video wall. For example, if the live video
of channel 1 is opened on window 1, another alarm is triggered.
The platform will display the live video of channel 2 on window 1.

® | oop mode: Linked live videos will be displayed on windows of a
video wall according to the order of windows. If there are no
available window, the first window will be used. The number at
the end of the name of a window indicates its order. For example,
window(2) indicates it is the second window.

Stay Duration

In either mode, if no other alarms are triggered, the current video will
be closed after the stay duration. If a new alarm is triggered:

® |n override mode, the stay duration of the new video start from
the time when the alarm is triggered. It will be displayed on the
window after the stay duration of the current one ends. For
example, the stay duration is set to 30 s. An alarm is triggered
when video 1 is being played for 15s. At 30 s, video 1 will be
closed, and video 2 will be played. After 15 s, video 2 will be
closed.

® |nloop mode, a new video will be displayed immediately even if
the stay duration of the current video does not end.

The latest alarm video will
immediately override the
one that is currently

playing on the video wall.

This parameter is only available for override mode. After enabled, the
stay duration will not work, and new videos will be displayed
immediately.

Step4  Configure the size, location, and other parameters of a window.

Table 4-6 Parameter description

Parameter

Description

Set the number of windows

There is only 1 window by default. Click it, and then you can set the
number of windows to 4, 9, 16, 32, or 64.
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Parameter

Description

Resize a window

® (lick a window, and then drag its frame near the lower-right
corner to resize it.

Windows(1)

® Right-click a window and then select Properties. Configure the
left margin, top margin, width, and height to resize the window.

Adjust the locations of
windows

Drag the windows to adjust their locations. This operation will not
change the order of the windows. The order is used to determine
which window will be used to display videos first in loop mode.

The number at the end of the name of a window indicates its order.
For example, a window named Window(2) means that it is the
second window.

Change the names of
windows

® Right-click a window, and then select Rename to rename a
window.

® Right-click a window, select Properties, and then rename it in
Window Name.

Step5 Click OK.

4.1.3.3 Configuring Alarm Video Pre-recording

You can configure the pre-recording mode for a device. When an alarm is configured to link pre-
recording from a device, the device will apply the mode you have specified.

Background Information

Pre-recording modes include Platform Cache and Get from Device.

® Platform cache: Alarm videos will be stored on the platform, the platform will record videos and
occupy certain input bandwidth continuously.

® Get from device: Alarm videos will be stored on the device. We recommend you configure a 24-
hour recording plan to make sure that there is prerecorded content for the time of alarms.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Event > Alarm Config > Alarm Storm Config.

Step2 Click an organization, and then all devices and channels in that organization will be
displayed on the right.

Step3  Configure the pre-recording mode.
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® (lick Ed of a channel, select a mode, and then click OK.
® Select multiple channels, click Edit, select a mode, and then click OK.

4.2 Configuring Map

4.2.1 Preparations

Devices are deployed. For details, see device user's manuals.
Basic configurations of the platform have been finished. For details, see "3 Basic Configurations".
If you need to use a raster map, prepare an image of the map.

To show device alarms on the map, make sure that Map flashes when alarm occurs is enabled
in Home > Management > Local Settings > Alarm.

4.2.2 Adding Map
4.2.2.1 Adding Vector Map

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Map.

Step2 Inthe map list, select the vector map, and then click #]
Figure 4-2 Map

Map Relationship Main Map

Vector Map -

Sub Map of Google Maps Offline

+ Add Sub Map

Step3  Configure the parameters.
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Figure 4-3 Map information

Map Mode

® QOnline Offline

Map Link:

Map Initial Status

Central Latitude of Map: Central Longitude of Map:

30.1892863 ‘ 120.1782

Map Initial Zoom Level: Min Map Display Level:

10 3

Max Map Display Level:
21

® Online map

1. Select Online.
2. Configure the information of the map, and then click OK.
® Offline map

1. Select Offline.
2. Click Import and import offline map.
3. Configure map information, and then click OK.

Table 4-7 Parameter description

Parameter Description

Map Link Enter the URL of the map. Only Google Maps is supported.

Central Latitude of Map

Define the center of the map by entering its latitude and longitude.

Central Longitude of  |\yhen opening the map, this will be the center of the map by default.
Map

The default zoom level when opening the map.

Map Initial Zoom Level | The |ower the level is, the map will contain more areas, but less details.
The higher the level is, the map will contain less areas, but more details.

The minimum level you can zoom out on the map.

Min Map Display Level | The |ower the level is, the map will contain more areas, but less details.
The higher the level is, the map will contain less areas, but more details.

The maximum level you can zoom in on the map.

Max Map Display Level | The |ower the level is, the map will contain more areas, but less details.
The higher the level is, the map will contain less areas, but more details.

Step4  Add asub map.
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If there is a specific area on the map that you want to view its detailed information, you
can add an image of it on the map as a sub map. For example, you can add a plane image
of a parking lot on the map.

1. On the map resource tree on the left, click the name of the map that you have just
added, or open the GIS map and click Add Sub Map.

2. Name the sub map, upload a map picture, and then click OK.

3. Drag the map to adjust its position, and then click OK.

The sub map is added.

Related Operations

Hide Device Name

Only display the icons of devices.
Satellite Map

View the satellite map.
Delete Devices

To delete a device from the map, click it and then click Delete Resource.
Show Device

Select which type of resources you want to display on the map.
Move

To move a device, click Move and then drag the device on the map.
Select

To select one or more devices, click Select, and then click on the devices on the map one by
one.

Pane

To select devices in batches, you can click Pane, and then draw a frame on the devices to select
the device.

Clear

To clear all markings on the map, click Clear.
Add Sub-map

To add a sub map on the current map, click Add Sub Map , click on the map to locate it, enter a
name, upload a map picture and then click OK.

Length

Select Box > Length, connect two points with a line on the map (double-click to finish
drawing), and then the distance between the points is shown.
Area

Select Box > Area, select a region on the map (double-click to finish drawing), and then the
area is measured.

Add Mark

Select Box > Add Mark, and then mark information on the map.
Reset

Select Box > Reset to restore the map to its initial position and zoom level.
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4.2.2.2 Adding Raster Map

A raster map is suitable for places where you want to view their detailed information, such as a
parking lot. You can add multiple ones.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config

section, select Map.

Step2  Select Main Map, and then click Add Map.
Step3  Enter the map name, select the picture and then click OK.

Figure 4-4 Add main map

Name: Description:

Local Area

Map:

Step4  Add a child map.

1. Click the added raster map, and then click Add Sub Map.
2. Enter the map name, upload the picture, and then click Next Step.
3. Drag the picture to the desired position and click OK.

Related Operations

Hide Device Name

Only display the icons of devices.
Delete Devices

To delete a device from the map, click it and then click Delete Resource.
Show Device

Select which type of resources you want to display on the map.
Move

To move a device, click Move and then drag the device on the map.
Select

To select one or more devices, click Select, and then click on the devices on the map one by
one.

Pane

To select devices in batches, you can click Pane, and then draw a frame on the devices to select
the device.

Clear
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To clear all markings on the map, click Clear.
® Add Sub-map

To add a sub map on the current map, click Add Sub Map, click on the map to locate it, enter a
name, upload a map picture and then click OK.

® Map scale
Select Map Scale > Configure the map scale, draw a line one the map, and then enter its
actual distance.

® |ength

Select Box > Length, connect two points with a line on the map (double-click to finish
drawing), and then the distance between the points is shown.

® Area

Select Box > Area, select a region on the map (double-click to finish drawing), and then the
area is measured.

® Add Mark

Select Box > Add Mark, and then mark information on the map.
® Reset

Select Box > Reset to restore the map to its initial position and zoom level.

4.2.3 Marking Devices

Link a device to the map by dragging it to the corresponding location on the map according to its
geographical location.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Map.

Step2  Click the map.
Figure 4-5 Map

Map Relationship Main Map

Q + AddMap

Step3  Drag the device channel from the left device tree to the corresponding location of the
map.

G

If you mark a radar on the map, you can configure the Radar-PTZ linkage function. For
details, see "4.2.4 Configuring Radar-PTZ Linkage".
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4.2.4 Configuring Radar-PTZ Linkage

A radar can meet most security needs because it can penetrate fog, smoke, and dust. After a target
is detected by the radar, you can view real-time videos of PTZ cameras to understand the situation
better and faster.

Before configuring the function, you must complete the following configurations first:

® The radar and PTZ cameras are directly added to the platform through their IP addresses. Also,
they must be on the same network, or different networks that can connect to each other. One
radar can link up to 8 PTZ cameras.

® Configure a vector or raster map. If you use a raster map, you must configure the map scale so
that the alarm area and detection area of the radar can be displayed normally.

® [f you also need to monitor the area around the radar, you can bind it with video channels. For
details, see "3.1.3 Binding Resources".

4.2.4.1 Configuring Linkage

Configure the linkage between the radar and PTZ cameras. When an alarm is triggered, PTZ
cameras will track the target. Operations on a vector map or raster maps are similar, and this section
uses vector map as an example.

Procedure
Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Map.
Step2  Click the vector map to openit.
Step3 Inthe device tree on the left, drag the radar channel on the map.

Figure 4-6 Mark a radar

leidal191_1

Name:

Organization:

Detection Range: 90°, 1000m, 1500m

Heading Angle: 0°

Step4  Click Eﬂ and then configure the parameter.
1. In the device tree, select one or more PTZ cameras to be linked to the radar.
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If you already configured related parameters on the webpage of the radar, the
platform will automatically obtain the information of the PTZ cameras. Click Bind to
save the linkage relationship and skip the following steps.

2. Click Bind and Configure to save the linkage relationship, and then go to the
webpage of the radar.

3. On the webpage of the radar, configure the parameters related to radar-PTZ linkage,
such as upload an image of the map, set the position and heading angle of the radar,
and, calibrate the PTZ cameras. For details, see the user's manual of the radar.

4.2.4.2 Configure a Radar Event

Configure an event so that an alarm will be triggered after a target enters the warning area and
alarm area of the radar, and then the platform will perform the defined linkage actions, such as
taking a snapshot.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Event > Event Config. Click Add, and then configure the parameters. For
details, see "4.1.1 Configuring Event Linkage".

4.3 Personnel and Vehicle Management

Configure personnel and vehicle information for the applications of access control, vehicle control,
and video intercom.

® Personnel information contains card number, password, face picture, and more. People bound
with vehicle information will be displayed in the vehicle list.

® \ehicle information helps to confirm the entry of the vehicle into a certain area. Vehicle bound
with personnel information will be displayed in the personnel list.

4.3.1 Adding Person and Vehicle Groups

Add person and vehicle groups to easily manage people and vehicles. People and vehicles use the
same groups. Only administrators can add, edit, and delete person and vehicle groups.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Personal and Vehicle Info.

Step2  Click Person List or Vehicle List.
Step3  Click E3 and then configure the parameters.

Table 4-8 Parameter description

Parameter Description

This is for permission control. For example, if a user cannot access

Parent Group Group A, then the user cannot access all the groups under Group A.

Group Name Enter a name for the group.
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4.3.2

Parameter Description

Only the roles and their users can view this group.

Roles Allowed Access o=

Click & to see the users assigned with the roles.

Step4  Complete configuration.

® (lick Add to add the group and exit the page.

® (lick Save and Add Person to add people to the group. For details, see "4.3.2
Configuring Personnel Information”.

Configuring Personnel Information

Add people to the platform and grant them access to different access control devices, entrance and
exits permissions, and more.

el

To collect fingerprints or card number, connect a fingerprint collector or card reader to the
computer where the PC client is installed.

4.3.2.1 Extending Person Information
You can customize more information you want to configure for persons. If existing information is
not enough, you can add more information for a person. This function is available to administrators.
Others users can only configure information for attributes that have been added. You can add up to
10 attributes.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Step2  Select Person List > More > Enable More Info.
Step3  Click Add, enter a name for the attribute, and then click OK.

This attribute will be displayed in the Additional Info section of a person's information.

Figure 4-7 More information

O Edit Person

Phone No. Remarks

Additional Info
Nickname
ID Type

Others

Birthday Region

1995 = = ] Unknown

Company Department

.
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L1

If you change the name of the attribute or click to disable it, the information you have

configured will still be on the platform. But if you click E to delete the attribute, the
information you have configured will also be deleted and cannot be recovered.

4.3.2.2 Adding a Person

Procedure
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Log in to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Select Person List > Persons > Add.
Click Person Info, and then configure the information of the person.

® Configure the basic information.

1. Hover over the profile, select Add Image > Select from Local Folder, and then follow
the on-screen instructions to upload an image from your computer. Or if your
computer is connected to a camera, you can select Add Image > Snapshot to take an
image.

Figure 4-8 Basic information
Basic Info

1D
00006304

Name

John Wick

Gender

Male ?o @

Person Group Email

All Persons and Vehicles [ John_V

® When taking a picture with a camera, click B and then you can select a camera,
pixel format, resolution, and image quality. These parameters are only effective on
the current PC client.

® You can upload or take 2 images for better recognition results. Only certain devices
support this function. The 2 icons under the images indicate the first and second
images. If the icon is in blue, it means the corresponding image is selected.

@-ﬂ_ﬂ.

You can import images for multiple people at the same time. For details, see "4.3.2.7
Importing Images of Persons".

2. Enter the information of the person as necessary.

® The D is required and must be unique. It can be up to 30 characters, and letter-
number combination is also supported.

® The name of the person can be up to 127 characters.

® The person can be added to up to 5 person groups. Click . to set one as the main
person group, which will be used in attendance shift.
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3. (Optional) Click Show More, and then enter the information of the person.

The nickname will be used in the contact information for VTOs.

® (Configure the verification information for unlocking doors or using lifts.

Table 4-9 Parameter description

Parameter

Description

Card

1.
2.

Click Settings, select a device to issue cards, and then click OK.

Click , swipe a card on the device you select, the card number
will be recognized and displayed. Or manually enter the card
number.

||

One person can have up to 5 cards. A card number is 8-16 numbers.
Only second-generation access control devices support 16-digit
card numbers. When a card number is less than 8 numbers, the
system will automatically add zeros prior to the number to make it 8
digits. For example, if the provided number is 8004, it will become
00008004. If there are 9-16 numbers, the system will not add zero to
it

. cickE

(Optional) Click mM to add more cards. You can add up to 5 cards for
each person.

After adding a card, you can:

o Ez Set a card as duress card. When opening door with a duress

card, there will be a duress alarm. Click this icon, it turns into E,
and [ is displayed at upper right, which indicates that the card is

set as a duress card. To cancel the duress setting, click B

© E: Update the card number.

© ﬂ: Remove the card, and then it has no access permissions.
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Parameter Description

1. Click Settings, select a fingerprint scanner, and then click OK.
2. Click Add, and then follow the on-screen instructions to collect your
fingerprint on the scanner.

3. Click Add Fingerprint.

4. (Optional) Click Add to add more fingerprints. You can add up to 3
fingerprints for each person.

After adding a fingerprint, you can:

Fingerprints o : Set the fingerprint as the duress fingerprint. When opening
doors with the duress fingerprint, there will be a duress alarm. Click

this icon, it turns into E which indicates that the fingerprint has
been set as the duress fingerprint. Click it again to reset the duress
fingerprint as a normal one.

o : Change the name of the fingerprint.

o ﬂ: Delete the fingerprint, and then it has no access permissions.

The password must be used with a card, person ID, or fingerprint to
unlock the door. For details, see the user manual of the access control
device you are using.

Click , enter a password, and then click M
Password

After adding a password, you can:

o : Change the password.

o ﬂ: Delete the password, and then it has no access permissions.

® |f the person has one or more vehicles, click Vehicle Info to add their information to
the platform, so that you can grant access permissions to this person's vehicles later.

¢ If the vehicles have been added to the platform, click Select from Vehicle List, and
then select the vehicles for this person.

¢ If the vehicles have not been added to the platform, click , enter the plate
number, and then select a color and brand.

Step4  If the personis a resident, click Video Intercom, and then configure the room

information.
Table 4-10 Parameter description

Parameter Description

The number of the room this person lives in. It is displayed in the
Room No. . . .

access records and video intercom operation records.

When several people live in the same room, you can set one of them
Homeowner as the homeowner.

Only the homeowner can register an account on DSS Agile VDP.
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Parameter Description
This function is only available for the homeowner. After you select the
option, you must enter an email address for the person. It will be used
as the username for the person to log in to DSS Agile VDP.
After the person is added, the platform will send the username and
password to the email address.
[

APP User If the person does not receive the email, you can click Send Email to

send a new email.

A

If you cancel selecting this option after an App account is created for
the person, the App account will be deleted. This person can no
longer log in to the App. If this person is a homeowner, all App
accounts in the corresponding room will be deleted, and all people in
this room can no longer log in to the App.

Step5 Click Access Control, and then configure the access permissions for this person.

1. Select an access type.

+ Add

Rule Name

123

General: When the person uses an access point, a general event is reported.

VIP: When the person uses an access point, a VIP event is reported.

Visitor: When the person uses an access point, a visitor event is reported. Also, the
person has limited access of 200 times. After the 200 times are used up, the person
cannot use an access point.

Patrol: When the person uses an access point, a patrol event is reported.

Blocklist: The person cannot use an access point. Also, a blocklist event is reported.
Extend time: When the person uses an access point, an extend time event is
reported. If the access point is a door, the door will stay unlocked for additional 5
seconds.

Configure the access rule validity period. The access rules are only effective within this
period.

Select Add > Add, and then configure the access rules.
©=a

If you already added access rules of general verification, this page will display them for
you to select.

Figure 4-9 Available access rules

Access Point Type Time Plan

Door ® All-Period Template

Table 4-11 Parameter description

Parameter

Description

Rule Name

Enter a name for the rule.
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Parameter

Description

Access Point Type

Select Door or Lift.

Time Template

Select a time template to define when the rule will be effective. For how
to create a new template, see "3.1.6 Adding Time Template".

Lift supports the all-period template by default. It cannot be changed.

Holiday Plan

Select a holiday plan when the rule will not be effective. You can add up
to 4 holiday plans. Follow the steps below to create a holiday plan:
L]

Lift does not support holiday plans.

a. Select Add Holiday Plan in the drop-down list.
b. Enter a name for the holiday plan.
c. Click Add to add a holiday.

You can add up to 16 holidays.
d. Configure the effective periods for each day in the holiday.

You can drag on the timeline below, or cIickE to configure the time
more accurately. You can add up to 4 periods.

e. Click OK.

Holiday Plan Details

Holi

000 200 400 600 800 10:00 1200 1400 1600 18:00 20:00 2200

Select by Zone

Click I to enable this function and select one or more zones. This
person will have access permissions to all the access points in these
zones.

[

For how to configure a zone, see "4.5.2 Configuring Zone".

Select by Access Point

Click Il to enable this function and select one or more access points.
This person will have access permissions to all these access points.

4. Click OK to finish adding the rule.
5. Select one or more rules for this person, and then click OK.

Step6  If you want to recognize this person by face images, add the person to a face arming

group.

1. Click Il next to Face Arming to enable the function.
2. Select aface arming group.
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o=

You need to create a face arming group first. To add one, select Add Face Arming Group
in the drop-down list. For details, see "4.4.1.1 Creating Face Arming Group".

Step7  If this person has one or more vehicles, you can grant parking lot access permissions to
them.

1. Click Il next to Parking Lot to enable the function.

2. If this person has one or more parking spaces, click B (0 enable Available Parking
Spaces the function, and then configure the number of the parking spaces.

For example, if this person has 2 vehicles when there is only 1 parking space, vehicle B
will not be able to enter if vehicle A is already in the parking lot.

3. Click Add to select the vehicle of this person, and then select which one or more
vehicle group it belongs to, and for how long it has access permission to the parking
lot.

o=

If there are no available vehicle groups, select Add Group in the drop-down list, and
then to add one. For details, see "4.8.3 Managing Vehicle Group".

Figure 4-10 Parking lot vehicle group

Parking Lot —e

Available Parking Spaces

1

+ Add

Plate No. Vehicle Group Validity Period Operation

AB12345 General 2023-11-30 00:00:00 - 2023-12-30 23:59:59 )

Step8  Click OK.
Related Operations

° CIickn to edit the basic information of a person.
® To delete a person:

¢ Click E to delete a person and associated permissions.
¢ Select multiple people, and then click Delete to delete them and associated permissions. If
you delete more than 10 persons, you must verify your login password.

¢ Select a person and vehicle group, and then click & to delete all the persons and their
permissions in the group. To perform this operation, you must verify your login password.
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Figure 4-11 Delete all persons in a group

L .: View authorization exception of a person.

® To search for a person, enter key words in the _

If you select Include Sub Groups, all the persons in the selected group and the sub groups in
this group will be displayed.

4.3.2.3 Importing Multiple People

Prepare the information of the people first, and then you can import them to the platform quickly.

Prerequisites
® Prepare an xlsx file that includes the information of the people you want to import, their face
images (optional), and then compress them into a zip file. The .xlsx file can include information
of up to 10,000 people. The zip file cannot be larger than 1 GB.
® |f a person belongs in a first-person unlock rule, set the access type of the person to General.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.
Step2  Click E&.
Step3  Select Import > Import from File.

Figure 4-12 Import personnel information

Import

Step4 Import the personnel information file.
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1

If there is no personnel information file, click Template Download and follow the
instructions on the page to create personnel information.

Step5 Click OK.

The following cases might occur during an import:

® |f there are failures, you can download the failures list to view details.

® Read carefully the instructions in the template to make sure all the information is
correct.

® Cannot read the contents with a parsing error reported directly.
Related Operations
® Export personnel information.

Select an organization, click Export, and then follow the instructions on the page to save the
exported information to a local disk.

® Download template.

To add personnel information in batches, you can download the template, fill in the information,
and then import it.

4.3.2.4 Synchronizing Person in Domain

Create persons based on the information imported from the domain. Also, the information of the
persons can be kept up-to-date with that in the domain.

Prerequisites
Configure the information of the domain. For details, see "7.4.9 Configuring Active Directory".

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Step2 Click Sync Person in Domain.

Step3  Import persons in the domain to the specified person group.
Table 4-12 Parameter description

Parameter Description

Import all or certain people in the selected
domain group to the selected person group on
the platform. After importing the entire
domain group, the group will be added to the
automatic synchronization list. After setting
the time, the platform will automatically
Manual Sync Sync Add synchronize the information of new and
existing people in the domain group at the
defined time every day.

When you import the same entire domain
group again, the platform will import the new
people and update the existing people.
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Parameter Description

When this option is selected, the platform
automatically detects and displays the people
Sync Delete that have been deleted from the domain. You
can select whether to remove them from the
platform.

® For people imported from an entire domain
group, the platform immediately imports
the new people or updates the existing

Sync Now people's information.

® For people imported by manual selection,
the platform immediately updates their
information.

The list holds the domain groups that have
been imported entirely. After setting the time,
the platform will synchronize the new people
and update the information of the existing
people every day. For people import by

Auto Sync manual selection, the platform will update

their information. Click E] to remove the
group, the platform will not synchronize the
new people, but will still update the
information of the existing people.

Step4  Click OK.

4.3.2.5 Moving People in Batches

Move people ion batches to another person group. This operation will delete the access rules of the
current group, and apply those of the target group on the people.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info > Personal List.

Step2 Select a person group, and then the people in this group are displayed on the right.
=

Select Include Sub Group to display all the people in this group and all its sub groups.
Step3  Select multiple people, and then click Move To.
Step4  Select a target group, and then click OK.
Step5 Click OK again.

4.3.2.6 Extracting Personnel Information

When personnel information has been configured on access control devices or door stations, you
can directly synchronize the information to the platform.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Step2  Click B4
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Step3  Click Import,

Person Group

+ 7

i All Persons

and then select Import from Device.
Figure 4-13 Import from device
All Persons
+ Add & Delete ¥ s Export

Racir Infn Authantication Infn

Import from Device

Acquired person information: 2

Step4  Click , select a channel from an access control device or door station, and then click

OK.

Figure 4-14 Extract task list

Import from Device

9 Acquire Task List

Select D

¥ /i Root

- CE”-I € El

Step5 Double-click a result to view the detailed information.
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Step6  Synchronize personnel information to the platform, or export information.

Figure 4-15 Personnel extraction results

Import from Device

9 220

¥ Importall

MName Access Type Authorization Information
General X1 =mXx5 [ xo
General X1 =mx5 [ xo
General B0 1 Ii'-jI
General v X5 @ xo
General i X5 @ xo

1003 General K X2 Iy

1001 General X! X2 I

~ P r B v n
General x0 x i .}l X0

General X0 X1 [ xo0

Total of B0 Record(s) 1 7 3 20

® To add all the personnel information to the platform, click Import All.

® To add part of the information, select the people of interest, and then click Import
selected.

® To export information, select the people you want, and then click Export.

4.3.2.7 Importing Images of Persons

If people are added to the platform but their images have not been configured, you can import
images for multiple people at the same time.

Prerequisites

You can upload up to 10,000 images in a zip file that can be up to 1 GB. Also, each image should
meet the following requirements:

® A person can have up to 2 images, but only certain devices support recognizing people with 2
images.

® The image must be in .jpg format, and has a resolution ranging from 150x300 to 540x1080. It is
preferred that it be 500x500. The image must not exceed 100 KB.

® Make sure that there is only 1 face in the image, with proportions between 1/3 and 2/3 of the
whole image. The aspect ratio of the image must not exceed 1:2.

® Both eyes should be open with a natural expression. Expose the forehead and face, and keep
hair away from blocking it. The bear shape should be similar to the original image's.
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® Normal light colors should be used (without whitening, yellowing, and backlight). ltems should
not block the face (such as hat, face mask, and glasses). The image must be processed by
Photoshop.

® Use an image with a white background.

Procedure
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Log in to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info > Person List > Persons.

Click Import, and then select Import Person Images.

Click Download Template to save the zip file to your computer. It contains the
instructions on how to prepare images, and 2 images for reference.

Prepare images according to the requirements, and then rename them in the format of
Person ID-Person Name-1.

1 means the first image of the person. Change it to 2 to make the second image of the
person.

Compress the images into a .zip file.

Click Import File, and then open the .zip file.

The page will display the number of successes and failures. Click Download Failure List
to see the reasons for the failures.

4.3.2.8 Issuing Cards in Batches

Procedure

Person Group

+ s

Step 4

Log in to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Click E&.

Select the people to issue card to, and then click Batch Issue Card.

Figure 4-16 Issue card in batches

All Persons

s Import A Export

Set term of validity.
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Step5 Issue cards to personnel.
Step6  Supportissuing cards by entering card number or by using a card reader.

® By entering card number

Figure 4-17 Enter card number

9 Batch Issue Card

tive Period:

lssue Card £

1D Name Operation
[]
2890 &

andy

1. Double-click the Card No. input boxes to enter card numbers one by one.
2. Click OK.

® By using a card reader
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1. Click B.
2. Select a card reader or device, and then click OK.

Figure 4-18 Reader manager

3. Select people one by one and swipe cards respectively until everyone has a card
number.
4. Click OK.

4.3.2.9 Viewing Certain People and Information

View certain people and their information by searching for keywords or filtering the type of
information to be displayed, such as ID, name, license plate, and access permission status.

Search for Certain People

Select a person and vehicle group, enter keywords in the search area on the upper-right corner, and

then click [.] or press Enter to search for people who have that information. If Include Sub Groups
is selected, the platform will also search for people in the sub groups of the one you select.

Filter person information

CIick on the upper-right corner to select which information to be displayed. For example, when
Email is selected, the email addresses of the people in the list will be displayed.

Figure 4-19 Display email addresses

Organization Certificate v Operation

B |
All Persons and Vehicles =2 M2 B1 & Ea |
ID:8078418

Certain information can be used to further filter person information. For example, you can choose
to display or hide people with no linked ID.
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Figure 4-20 Filter by linked ID

Linked ID

All
Has Linked ID
Mo ID Linked

4.3.2.10 Editing Person Information

Modify personnel information including basic information, authentication details, and
authorization. Person ID cannot be modified.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Step2  Click B8

:

Step3  Click Bl to edit information. For details, see "4.3.2.2 Adding a Person".
4.3.2.11 Configuring Access Rule

An access rule defines the permission and effective time of that permission to lift or door channels.
Configure an access rule for a person and vehicle group, and then it will be applied to all the people
inside the group. Only administrators can configure access rules.

Procedure

tep1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info > Person List.

:

Step2  Click a group, and then click Access Rule.
Step3  Click Add. This page displays rules that have been added. You can select and use any one
of them directly.
Step4  Click Add, and then configure the parameters of the new access rule.
(L1
When configuring an access rule for a person and vehicle group, you can only configure
general verification rules. If you want to configure other types of rules, see "4.5.3
Configuring Access Rule".
Table 4-13 Parameter description
Parameter Description
Rule Name Enter a name for the rule.
Access Point Type Select Door or Lift.
Rule Type Only General Verification is available. For this type of rules,
yp doors can be unlocked by cards, fingerprints, and passwords.
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Parameter

Description

Time Template

Select when this rule is effective. If you want to create a new time
template, see "3.1.6 Adding Time Template".

Holiday Plan

Select when this rule is not effective. You can add up to 4 holiday
plans. Follow the steps below to create a new holiday plan:

1. Select Add Holiday Plan in the drop-down list.
2. Enter a name for the holiday plan.
3. Click Add to add and configure a holiday.

You can add up to 16 holidays.
4. Configure the effective periods for each day in the holiday.

You can drag on the timeline, or cIickE to configure the
periods more precisely. You can configure up to 4 periods.
5. Click OK.

Holiday Plan Details

800 1000 1200 14:00 1600 1800 20:00 2200 2400

o

Select by Zone

People can access all the access points in the selected zones.

Select by Access Point

People can access the selected access points.

Step5  Select the access rules, and then click OK.

9 AddRule

+ Add

®  Rule Name

Figure 4-21 Select access rules

Access Point Type Time Plan

Door ® All-Period Template

Door ® All-Period Template
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4.3.3 Vehicle Management

Manage vehicle information including vehicle type, owner, entry and exit permissions and arming
groups.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Personal and Vehicle Info.

Step2  Click &
Step3  Add vehicles.
® Add vehicles one by one
1. Click Add.
2. Inthe Owner Info section, click Select from Person List to select the owner of the
vehicle.

3. Configure the information of the vehicle in the Vehicle Info section, such as the
vehicle group, plate number (required and unique), vehicle color, brand and more.

If you have selected an owner, you can add multiple vehicles.

4. Click - to enable Parking Lot Vehicle Group, and then you can set the available
parking spots for the selected person, and grant access permissions by adding vehicles
into entrance and exit vehicle groups.

Figure 4-22 Parking lot vehicle group

Parking Lot Vehicle Group —®

Parking

1

+ Add
Plate No. Vehicle Group Validity Period Operation

ABC12345 General Long Term e

If the owner has more vehicles than the set parking spots, once no parking spots
available, owner cannot access the parking lot.

5. CIick- to enable Vehicle Arming Group, and then click Add to arm the vehicles
you have just added.

Figure 4-23 Vehicle arming group

Vehicle Arming Group —®

+ Add

Plate No. Vehicle Arming Group Validity Period Operation

ABC12345 High Risk Vehicle Long Term ]
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For arming group details, see "4.4.2.1 Creating Vehicle Arming Group".
6. Click OK.

® Add vehicles in batches

1. Click Import, and then click Template Download.

2. Fill'in the template, and then select Import > Import File. Select the file and import
the information to the platform.

The platform supports downloading files that failed to import for you to check and fix.
Step4  (Optional) Export vehicle information to local storage as needed.

Figure 4-24 Export vehicle information

Login Password:

Confirm Encryption Password:

® (lick Export and then enter required information, such as passwords for login and
encryption, to export all the items.

® Select vehicles, and then click Export to export only the selected information.
Related Operations

® You can search vehicles by entering keywords in search box at the upper-right corner.
® (lick Ed or double-click the column to edit the vehicle information.

e Click [ to delete vehicles one by one. You can also select multiple vehicles and then click
Delete at the top to delete in batches.

4.4 Watch List Configuration

Configure face and vehicle watch list for future investigation.
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® For face watch list, you can create and arm face comparison groups to recognize faces.

® For vehicle watch list, you can create vehicle comparison groups, add vehicles and then link
devices for plate recognition.

4.4.1 Face Arming List

Configure a face arming list and send the it to devices for face recognition and alarms.

4.4.1.1 Creating Face Arming Group

Only administrators can add, edit, and delete person and face arming groups.

Prerequisites

® Make sure that the devices for face recognition have been successfully configured onto the
Platform.

® Make sure that the basic configuration of the Platform has completed. For details, see "3 Basic
Configurations". During the configuration, you need to pay attention to following parts.

¢ When adding devices on the Device page, set the Device Category to Encoder.

Figure 4-25 Device category

9 Add Device
1.Login Information

Add Mode: Access Protocol:

IP Address Dahua

| Encoder

IP Address: Device Port:

Username:

admin

Organization:

Root

¢ When adding devices like NVR or IVSS which support face recognition, set the device feature
to Face Recognition. For details, see "3.1.2.5 Editing Devices".
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Figure 4-26 Feature configuration

9 All Device

Channel Number:

Basic Info

3

Channel Name Features Keyboard Code

Y Alarm Input Channel vir 200_1

Output Channel

¢ Make sure that you have configured at least one disk with the type of Images and Files to
store face images. Otherwise, the snapshots cannot be displayed.

Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then select Arming List >
Face Arming List.

Step2  Click Add, and then configure the parameters.

Table 4-14 Parameter description

Parameter Description

Face Arming Group Name Enter a name for the group.

You can use colors to quickly differentiate each group. For

Col -
olor example, red indicates key targets.

Only the roles and their users can view this group.

Roles Allowed Access o

Click & to see the users assigned with the roles.

Step3 Click Add.

4.4.1.2 Adding Faces

Add people to face arming groups. Their faces will be used for face comparison.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then select Arming List >
Face Arming List.

Step2  Click [ﬁ] of a group you want to add people to it.

® Add people by person groups. This is the most efficient way, provided that you have
created person groups based on the access permissions. For details, see "4.3.2
Configuring Personnel Information".

Click Add by Person Group , select one or more groups, and then click OK. You can
also select Include Sub Groups to include the people in the sub groups of the groups
you select.

® Select the people you want to add. This is applicable to people in different person
groups have the same access permissions.

Click Add by Person, select the people you want to add, and then click OK.
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4.4.1.3 Arming Faces

The faces of the people in face arming groups will be sent to devices for real-time face recognition.
If the similarity reaches the defined threshold, alarms will be triggered.

Procedure
Step 1

:

wn
~
D

N

Log in to the DSS Client. On the Home page, click EY and then select Arming List >
Face Arming List.

Click B of the face arming group you want to arm.
Click Add, select one or more devices or channels, and then click OK.

The platform will send the information of the face arming group to the devices and

channels you selected, and display the progress. If exceptions occur, you can cIick. to
see the reason.

Figure 4-27 Send face arming group

Send Face Arming Group
Face Arming Group: ccc
Selected (2)

Send to Organization Operation

Current Site

1
v B = IpC IPC e

o) IPC(nvr-66) e
v B .
» | £3 bianmagi
> o
¥ B B3 nvr-66
B2 rc

‘E-\ nvr-66_3

After the face arming group is successfully sent, click Next Step.

Click Add, select the channels you want to arm, and then configure the similarity for each
channel.

When the similarity between the face captured by the channel and a face in the face
arming group reaches or is greater than the defined value, it is considered a match.
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Arm Face Arming Group

Face Arming Group: ccc

¥ |W| i Current Site
» B ipC
i

P[]

Click OK.

(Optional) View exceptions and arm the face arming group again.

Figure 4-28 Arm face arming group

Selected (3)
Q 12

Device

nvr-66

Similarity

IP PTZ Cam... 8

IPC

Operation

1. Click . to view why arming failed and address the issue.
2. Click Send Again to arm the face arming group again.

4.4.2 Vehicle Watch List

Create a vehicle comparison group and add vehicles to it. After a vehicle comparison group is sent
to ANPR cameras for recognition, alarms will be triggered if the vehicles in the group are captured
and recognized.

4.4.2.1

Creating Vehicle Arming Group

A vehicle arming group contains the information of multiple vehicles. When arming the group, you
can arm all the vehicles inside the group at the same time. Only administrators can add, edit, and
delete person and face comparison groups.

Procedure
Step1 Login tothe DSS Client. On the Home page, click , and then click Watch List >
Vehicle Watch List.
Step2  Click Add, and then configure the parameters.
Table 4-15 Parameter description
Parameter Description

Vehicle Arming Group Name

Enter a name for the group.

Color

You can use colors to quickly differentiate each group. For

example, red indicates key targets.
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Parameter Description

Only the roles and their users can view this group.

Roles Allowed Access o=

Click & to see the users assigned with the roles.

Step3  Click Add.
4.4.2.2 Adding Vehicles

Add vehicles to vehicle arming groups. After armed, devices will recognize their plate numbers and
trigger alarms.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then click Watch List >
Vehicle Watch List.

Step2 Click [ﬂ of a group, or double-click a group, an then click Select from Vehicle List.

® Add vehicles by vehicle groups. This is the most efficient way, provided that you have
created vehicle groups. For details, see "4.3.2 Configuring Personnel Information".

Click Add by Vehicle Group, select one or more groups, and then click OK. You can
also select Include Sub Groups to include the vehicles in the sub groups of the
groups you select.

® Select the vehicles you want to add. This is applicable to vehicles that you want to add
are in different vehicle groups.

Click Add by Vehicle, select the vehicles you want to add, and then click OK.
4.4.2.3 Arming Vehicles

The plate numbers of the vehicles in comparison groups will be sent to devices for real-time
recognition and trigger alarms.
Log in to the DSS Client. On the Home page, click , and then arm the vehicle on the Event page.

Click Add to add an event to arm a vehicle watch list. For how to configure events, see "4.1
Configuring Events".
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Event Source

4.5 Access Control

Event Source Type

Device

Video Channel

Alarm Input Channel
EAS Alarm Channel
Access Control Channel
RELEL

Parking Lot

Lift Control Channel

Soft Trigger

POS Alarms

Combined Event

® Access control

® Advanced functions

4.5.1 Preparations

Figure 4-29 Arm vehicle event

® High Risk Vehicle

¥ Audio Detection

Audio

Issue cards, collect fingerprints and face data, and apply permissions, so that the authorized
people can open door by using card, face or fingerprint.

Configure advanced access control rules such as First-card Unlock, Multi-card Unlock, Anti-pass
Back and Interlock to enhance security.

Make sure that the following preparations have been made:

Access control devices are correctly deployed. For details, see the user manual of the device you

are adding to the platform.

Basic configurations of the platform have been finished. See "3 Basic Configurations" for details.

¢ When adding access control devices, select Access Control as the device category.

¢ (Optional) You can bind video channels to access control channels, so that you can monitor
the area near access control devices. For details, see "3.1.3 Binding Resources".

¢ Add persons to the platform For details, see "4.3 Personnel and Vehicle Management".
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4.5.2 Configuring Zone

A zone is a collection of access permissions to doors and lifts. Create zones to quickly define
security control areas with different permissions. Only the administrator can add, edit and delete

zones.

4.5.2.1 Adding a Zone

Procedure
Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.
Step2  Click Ea.
Step3  Configure the information, and then click OK.
Table 4-16 Parameter description
Parameter Description

Parent Zone

Select a parent zone for permission management. For example, if a
user has permissions for zone A, the user also has permissions for all
sub zones under zone A by default. Additional permissions can be set
for the sub zones.

Zone Name Enter a name for the zone.

Icon

Select an icon for the zone. Icons are used for users to quickly identify
different zones.

Roles Allowed Access

Only the selected roles and their users can access this zone.
O

Click & to see the users assigned with the roles.

4.5.2.2 Adding Zones in Batches

Procedure

Step 1

Step 2

Step 3

Step 4

Log in to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Click a zone, and then click Hal.

All zones will be added as sub zones of the one you select.
Click Add to add more levels.

There is only 1 level by default. There can be up to 8 levels of zones. For example, if the
zone you select is a level 3 zone, you can only add 5 levels of zones under it.

Configure the parameters for each level, and then click OK.

You can check the results for your current configurations.
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Quick Add

Figure 4-30 Add zones in batches

Level Zone Name

1 Building
2 Floor

3 Unit

Start Zone No. Quantity Select Icon  Operation Results
1 2 © B - & v SectionBE @

v B Buildingl @

1 3 0 L - @ v & Floorl @

1 5 w

Unit5 @
» & Floor2 ©
» & Floor3 ©

» B Building2 @

Table 4-17 Parameter description

Parameter Description
The number indicates the level of the zone. The region with a larger
Level number is a sub zone of the region with the smaller number. For
example, the level 2 zone is a sub zone of the level 1 zone.
Zone Name Enter a name for the zone.

Start Zone No.

Enter a start number and then all the zones of this level will be
automatically numbered. For example, if the start number is 1 and the
quantity of zones is 3, then zones will be numbered as zone 1, zone 2, and
zone 3.

Enter a number for each zone. The number of each level of zones = upper

Quantity levels x the current level. For example, the numbers of level 1,2 and 3 are
1,2, and 3. Then, the number of level 3 zones = 1x2x3 = 6.
Select an icon for the zone. Icons are used for users to quickly identify
Select Icon

different zones.

Step5 Click OK.

The roles that are allowed to access the parent zone will be automatically applied to the

sub zones.

4.5.2.3 Editing and Deleting Zone

Only administrators can edit and delete zones.

Log in to the DSS Client. On the Home page, click , and then in the App Config section, select
Access Control > Zone Management.

® (lick a zone and then click to edit the information of the zone, including the name, icon, and

roles allowed access.
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® (lick azone and then cIickE to delete it. After deleting the zone, all information related to the
zone will also be deleted, including sub zones, access rules, and maps. Access points in this zone
and its sub zones will be moved to the root zone.

4.5.2.4 Moving Access Point

Access points include door and lift control channels. The access points in a zone can be moved to
other zones. After you add access control devices, video intercom devices with access control
functions, and lift control devices to the platform, access points of door and lift control channels
will be generated and added to the root zone by default. You need to allocate them to other zones.

Procedure

Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Step2 Click a zone, and then click Access Point.

All access points and sub zones will be displayed.
Step3  Move the access points.

After moving the access points, access rules of the current zones will not be applied to
them, and their information on the map will also be deleted. The access rules of the target
zone will apply to them.

(L1
Access points that have been configured with access rules cannot be moved.
® Move an access point.

¢ Drag an access point to a sub zone.

Figure 4-31 Move an access point

Access Rule Map Info

¢ Right-click an access point, select Move To, and then select a zone.
® Move multiple access points.

1. Drag to select multiple access points. Or hover the mouse over an access point,
click the checkbox to select it, and then repeat the operations to select multiple
access points.

Figure 4-32 Drag to select multiple access points

Access Rule Map Info

m W

Building 1
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2. Drag the access points to a sub zone. Or click Move To and then select a zone. Or

right-click any selected access point, click Move To and then select a zone.
©=n

You can also drag to select access points in the search result.
4.5.2.5 Configuring Access Point

4.5.2.5.1 Viewing Access Point Details

View the information of an access point, including the name, type, zone it belongs to, linked
resources, and access rules.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Step2 Click a zone, and then click Access Point.
Step3 Double-click an access point to view its details.

® Access Point Name : The name of the access point that can be changed.

® Access Point Type : Displays the type of the access point, door or lift.

® Zone Name: Displays the name of the zone the access point belongs to.

® Linked Resources : Displays the channel name and type of the access point, the name
and type of the intercom device it belongs to, and video channels that are bound to it.
If you want to bind resources to this access point, you can click Channel Binding to
quickly go to the page. For details on channel binding, see "3.1.3 Binding Resources".

® Access Rule : Displays the access rules applied to this access point itself, and from the
zone it belongs to. Double-click a rule to view its details. You can add or delete the
rules, but the rules from the zone cannot be deleted.

4.5.2.5.2 Setting Boundary

Setting access points as boundaries to count people that entered, exited, or entered but did not
exit.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Step2 Click a zone, and then click Access Point.
Step3  Right-click an access point and select Set as Boundary.

£I will be displayed on the lower-right corner of the icon of the access point.
4.5.2.6 Configuring Access Rule for a Zone

An access rule defines the permission and effective time of that permission to lift or door channels.
Configure an access rule for a zone, and then it will be applied to all the access points inside. Only
administrators can configure access rules.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Step2 Click azone, and then click Access Rule.
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Step3  Click Quote. This page displays rules that have been added. You can select and use any

one of them directly.

Step4  Click Add, and then configure the parameters of the new access rule.

When configuring an access rule for a zone, you can only configure general verification
rules for doors. If you want to configure other types of rules, see "4.5.3 Configuring Access

Rule".
Table 4-18 Parameter description
Parameter Description
Rule Name Enter a name for the rule.

Access Point Type

Only Door is available.

Rule Type

Only General Verification is available. For this type of rules,
doors can be unlocked by cards, fingerprints, and passwords.

Time Template

Select when this rule is effective. If you want to create a new time
template, see "3.1.6 Adding Time Template".

Holiday Plan

Select when this rule is not effective. You can add up to 4 holiday
plans. Follow the steps below to create a new holiday plan:

1. Select Add Holiday Plan in the drop-down list.
2. Enter a name for the holiday plan.
3. Click Add to add and configure a holiday.

You can add up to 16 holidays.
4. Configure the effective periods for each day in the holiday.

You can drag on the timeline, or click[a to configure the
periods more precisely. You can configure up to 4 periods.
5. Click OK.

Holiday Plan Details

000 200 400 £00 800 1000 1200 14100 1600 1800 20:00 22-

Select by Person Group

Select one or more person groups, and then all the persons in
the groups will have permissions to access all the door channels
in the zone.

@

Select Link Sub Node, and then you can select a zone and all its
sub zones at the same time.
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Parameter Description

Select one or more persons, and then they will have permissions
to access all the door channels in the zone.

o=

Select Include Sub Groups to display all the persons in the
selected group and its sub groups.

Select by Person

Step5  Select the access rules, and then click OK.

Figure 4-33 Select access rules

9 Quote Rule

+ Add

®  Rule Name Access Point Type Time Plan

(] o Door ® All-Period Template

= Door © All-Period Template

4.,5.2.7 Configuring Map

On the map of a zone, you can mark access points and sub zones so that you can better manage
them and quickly locate events. You can configure a map for each zone. Besides administrators, any
user can configure maps for zones if they have permissions to access the zones. But if a user does
not have access to the map function, the user will not be able to configure the map for any zone.

4.,5.2.7.1 Adding Map

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Step2 Click a zone, and then click Map Info.
Step3  Click Configure Map to add a map for the zone.
® Select a map that has been added to the platform.

® Upload an image as the map. After added, the map will be added to the platform as a
main map. To know more about maps, see "4.2.2 Adding Map".

Step4  Click OK.

4.5.2.7.2 Marking Access Point and Sub Zone

Procedure

Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Zone Management.

Step2 Click a zone, and then click Map Info.
Step3 Drag a sub zone or access point to the map.

106



CaZ!o!ya User's Manual

Figure 4-34 Drag and mark
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When marking a sub zone, you need to configure a map for it.

® |f a map was added as the sub map of the current map, you can select it directly as the
map for the sub zone.

® |f no map was added for the sub zone, you can add a new map for it. The new map will
be added as the sub map of the current one.

® |f you added a map for the sub zone, but it is not a sub map of the current one, you
cannot mark the sub zone on the map.

©=n
If you want to configure maps first, see "4.2 Configuring Map".
Related Operations
® Hide Access Point Name

Only displays the icon of access points.
® Show Access Point

Select which types of access points to be displayed on the map.
® Move

Click Move, and then you can adjust the locations of the sub zones and access points on the
map.

® Reset
Restore the map to its initial position and zoom level.

® Remove Map

Remove the map from this zone. This operation will not delete the map from the platform.
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4.5.3 Configuring Access Rule

An access rule defines the permission and effective time of that permission to lift or door channels.
Only administrators can configure access rules.

4.5.3.1 Viewing Access Rule Details

This page displays all access rules on the platform, including those configured for a person, person
group, zone, and access point.

Log in to the DSS Client. On the Home page, click , and then in the App Config section, select
Access Control > Access Rule > All Rules.

® Double-click a rule to view its details.

® (lick =l of a rule to view its authorization progress. If exceptions occur, click . to view their
details. Follow the reason and prompt to handle the exception, and then click Send Again to
send the rule again, but it only applies to General Verification rules. For other types of rules,
you can only send them again manually.

4.5.3.2 Configuring General Verification

Grant permissions to persons so that they can verify their identifications and access doors or lifts
within the effective periods.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.

Step2  Click Add.
Step3  Configure the parameters, and then click OK.
Table 4-19 Parameter description
Parameter Description
Rule Name Enter a name for the rule.

Select Door or Lift, and then the platform will only display

Access Point Type corresponding channels.

Rule Type Select General Verification.

Select when this rule is effective. If you want to create a new time

Time Template template, see "3.1.6 Adding Time Template".
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Parameter

Description

Holiday Plan

Select when this rule is not effective. You can add up to 4 holiday
plans. Follow the steps below to create a new holiday plan:

1. Select Add Holiday Plan in the drop-down list.
2. Enter a name for the holiday plan.
3. Click Add to add and configure a holiday.

You can add up to 16 holidays.
4. Configure the effective periods for each day in the holiday.

You can drag on the timeline, or cIickE to configure the
periods more precisely. You can configure up to 4 periods.
5. Click OK.

Holiday Plan Details

Holiday Plan Name
Holiday Plan 1

Select by Zone

Select one or more zones, and then this rule will be applied to all
access points in the zones.
@

Select Link Sub Node, and then you can select a zone and all its
sub zones at the same time.

Select by Access Point

Select one or more access points.

o=

Select Include Sub Zone to display all the access points in the
selected zone and its sub zones.

Select by Person Group

Select one or more person groups, and then all the persons in
the groups will have permissions to access the selected access
points.

@

Select Link Sub Node, and then you can select a zone and all its
sub zones at the same time.

Select by Person

Select one or more persons, and then they will have permissions
to access the selected access points.
e

Select Include Sub Groups to display all the persons in the
selected group and its sub groups.
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4.5.3.3 Configuring Normally Open

Within the effective periods, all people can pass access points without verifying their identifications.

Procedure
Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.
Step2 Click Add.
Step3  Configure the parameters, and then click OK.
Table 4-20 Parameter description
Parameter Description
Rule Name Enter a name for the rule.

Access Point Type

Only Door is available.

Rule Type

Select Normally Open.

Time Template

Select when this rule is effective. If you want to create a new time
template, see "3.1.6 Adding Time Template".

Holiday Plan

Select when this rule is not effective. You can add up to 4 holiday
plans. Follow the steps below to create a new holiday plan:

1. Select Add Holiday Plan in the drop-down list.
2. Enter a name for the holiday plan.
3. Click Add to add and configure a holiday.

You can add up to 16 holidays.
4. Configure the effective periods for each day in the holiday.

You can drag on the timeline, or click[a to configure the
periods more precisely. You can configure up to 4 periods.
5. Click OK.

Holiday Plan Details

Holiday Plan Name
Holiday Plan 1

800 1000 1200 14:00 1600 1500 20:00 2200 24:00

Access Point

Select one or more doors.
o=

Select Include Sub Zone to display all the access points in the
selected zone and its sub zones.
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4.5.3.4 Configuring Normally Closed

All people are not allowed to pass access points.

Procedure
Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.
Step2 Click Add.
Step3  Configure the parameters, and then click OK.
Table 4-21 Parameter description
Parameter Description
Rule Name Enter a name for the rule.

Access Point Type

Only Door is available.

Rule Type

Select Normally Closed.

Time Template

Select when this rule is effective. If you want to create a new time
template, see "3.1.6 Adding Time Template".

Holiday Plan

Select when this rule is not effective. You can add up to 4 holiday
plans. Follow the steps below to create a new holiday plan:

1. Select Add Holiday Plan in the drop-down list.
2. Enter a name for the holiday plan.
3. Click Add to add and configure a holiday.

You can add up to 16 holidays.
4. Configure the effective periods for each day in the holiday.

You can drag on the timeline, or click[a to configure the
periods more precisely. You can configure up to 4 periods.
5. Click OK.

Holiday Plan Details

Holiday Plan Name
Holiday Plan 1

800 1000 1200 14:00 1600 1500 20:00 2200 24:00

Access Point

Select one or more doors.
o=

Select Include Sub Zone to display all the access points in the
selected zone and its sub zones.
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4.5.3.5 Configuring First-person Unlock

Any person can access doors only after the persons you specify pass through. When you specify
multiple persons, other persons can access doors after any one of specified persons pass through.

Prerequisites

Persons can only be set as first persons when they have permissions to access doors. For how to use
general verification rules to grant permissions to persons, see "4.5.3.2 Configuring General
Verification".

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.

Step2  Click Add.
Step3  Configure the parameters, and then click OK.
Table 4-22 Parameter description
Parameter Description
Rule Name Enter a name for the rule.
Access Point Type Only Door is available.
Rule Type Select First-person Unlock.
® Normal: Other persons must verify their identifications to
Rule Type after Unlocked by pass.
First Person ® Normally Open : All people can pass without verifying their

identifications.

Select when this rule is effective. If you want to create a new time

Time Template template, see "3.1.6 Adding Time Template".

Select one or more doors.
(@

Access Point . s
Select Include Sub Zone to display all the access points in the

selected zone and its sub zones.

Select one or more persons, and then they will have permissions

to access the doors.
=8

Select Include Sub Groups to display all the personsin the
selected group and its sub groups.

Access types that will affect the rule are listed below. For how to

Person
configure access types, see "4.3.2.2 Adding a Person".

® First-person unlock rules only support General access type.

® People whose access types are Patrol will not be restricted
by the rule. When no one in the first-person unlock rule
unlocks the door, People whose access types are Patrol can
still unlock it.
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4.5.3.6 Configuring Multi-person Unlock

Multiple unlock groups must swipe their cards on doors in the specified order to unlock them.

Prerequisites

Persons can only be added to unlock groups when they have permissions to access doors. For how
to use general verification rules to grant permissions to persons, see "4.5.3.2 Configuring General
Verification".

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.

Step2  Click Add, and then configure the parameters.

Table 4-23 Parameter description

Parameter Description

Rule Name Enter a name for the rule.
Access Point Type Only Door is available.

Rule Type Select Multi-person Unlock.

The all-period time template is used by default and cannot be

Time Template changed.

Select one or more access points.
o=

Select Include Sub Zone to display all the access points in the
selected zone and its sub zones.

Access Point
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Parameter Description

Configure up to 4 unlock groups. Persons must verify their
identifications in the group order to unlock doors.

1. Click Add.

2. Enter a name for the group.

3. Add one or more persons to the group. You can add up to 50
persons to the group. Select Include Sub Groups to display
all the persons in the selected group and its sub groups.

® A person can only be added to one group.
® [f a person has been selected in a first-person rule, we do
not recommend add the person to a multi-person unlock
group because when the person access a door, the
platform will execute the first-person unlock rule.
® Persons with access types as Patrol and VIP cannot be
added to the group. Also, multi-person unlock rules do not
apply to them. For how to configure access types for
persons, see "4.3.2.2 Adding a Person".
4. Click OK.
5. (Optional) Repeat the steps below to add more groups.
6. Select the groups you added, and then click OK.

Person

Multi-persen Unlock Group List

+ Add

B Multi-person Unl...  Quantity

Group 1 1

Group 2 2

Group3 1

7. Click the up or down arrows to adjust the group order, and
then click OK.

Step3  Configure the unlock method for each group, including card, password, fingerprint, and
face.

Figure 4-35 Configure unlock methods

+ Add Q  Selected(3)

® Multi-person...  Quantity Operation Multi-person ... Number of Va... Unlock Mode Operation

B Group1 3 LA Group1 3 Cad +| 4 4 @

3 s @ Card
. Erm - 4 ® Group 2 3 Al + 4 O

Password

Group 3 3 + 4 O
Fingerprint

B Growp3 3 S B

Face

Step4  Click OK.
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4.5.3.7 Configuring Anti-passback

People can only pass in the defined order. For example, if people want to go to building D, they
must go through building A, B, and Cin this order. They cannot enter building D directly.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.

Step2  Click Add.
Step3  Configure the parameters, and then click OK.

Table 4-24 Parameter description

Parameter Description

Rule Name Enter a name for the rule.
Access Point Type Only Door is available.
Rule Type Select Anti-passback.

The difference between the 2 types is that you can select only
the door channels of an access control device for Local Anti-
passback, and you can select all the door channels in a zone for
Global Anti-passback. If you select Global Anti-passback, you

Anti-passback Type can conﬁgure the offline operation strategy at the same time:

® Execute : Offline access points will execute the anti-passback
configurations.

® Do Not Execute : People can pass normally through offline
access points.

If people do not pass in the defined order, they will not be
allowed to pass any door within the reset time. After the reset
time, they must follow the order from the beginning. The reset
time can be between 5 minutes and 24 hours.

Reset Time

Select when this rule is effective. If you want to create a new time

Time Template template, see "3.1.6 Adding Time Template".
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Parameter Description
Select when this rule is not effective. You can add up to 4 holiday
plans. Local Anti-passback does not support holiday plan.
Follow the steps below to create a new holiday plan:
1. Select Add Holiday Plan in the drop-down list.
2. Enter a name for the holiday plan.
3. Click Add to add and configure a holiday.
You can add up to 16 holidays.
4. Configure the effective periods for each day in the holiday.
You can drag on the timeline, or click[a to configure the
) periods more precisely. You can configure up to 4 periods.
Holiday Plan

5. Click OK.

Holiday Plan Details

Holiday Plan Name
Holiday Plan 1

800 1000 1200 14:00 1600 1500 20:00 2200 24:00

o

Access Point

Add doors to different groups, and then people must pass in the
group order to access the doors in the last group.

1]
If you select the Anti-passback Type to Global Anti-passback,
the platform will only display devices that support this function.

@-ﬂ_ﬂ.

When configuring a global anti-passback rule, select Include Sub
Zone to display all the access points in the selected zone and its
sub zones.

4.5.3.8 Configuring Multi-door Interlock

When a door is unlocked, people cannot pass through any other door. This rule has 3 types:

® | ocal interlock: Only door access points of 1 device are supported. The platform will generate
interlock groups based on the number of door access points of the device you select. Each
group can contain 2 to 4 door access points. After a door is opened, other doors in the same
group cannot be opened, but those in other groups can still be opened.

® Global interlock within groups: Only 1 interlock group is supported. The group can contain 2 to
4 door access points. After a door is opened, other doors cannot be opened.

® Global interlock between groups: Only 2 interlock groups are supported. Each group can
contain 1 to 4 door access points. After a door is opened, other doors in the same group can still
be opened, but those in other groups cannot be opened.
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Procedure

Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.

Step2 Click Add.
Step3  Configure the parameters, and then click OK.
Table 4-25 Parameter description
Parameter Description
Rule Name Enter a name for the rule.
Access Point Type Only Door is available.
Rule Type Select Multi-door Interlock.
Select an interlock type. If you select a global interlock rule, you
can configure the offline execution strategy at the same time:
Interlock Type ® Execute : Offline access points will execute the interlock

configurations.
® Do Not Execute : People can pass normally through offline
access points.

The all-period time template is used by default and cannot be

Time Template changed.

Select an access control device, and then add its doors to
different groups. When a door in any group is unlocked, people
cannot pass through any other door.

[

If you have configured a remote verification rule at the same
time for any door here, people cannot unlock the door if multi-
Access Point door interlock is effective. For example, if a person unlocks a
door in group 1, other people cannot open any door in group 2
through remote verification.

@-ﬂ_ﬂ.

When configuring a global interlock rule, select Include Sub
Zone to display all the access points in the selected zone and its
sub zones.

4.5.3.9 Configuring Remote Verification

When people want to pass a door configured with remote verification, they can only pass after the
platform confirms.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > All Rules.

Step2 Click Add.
Step3  Configure the parameters, and then click OK.
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Table 4-26 Parameter description

Parameter Description

Rule Name Enter a name for the rule.
Access Point Type Only Door is available.

Rule Type Select Remote Verification.

Select when this rule is effective. If you want to create a new time

Time Template template, see "3.1.6 Adding Time Template".

Select one or more doors.
e

Select Include Sub Zone to display all the access points in the
selected zone and its sub zones.

Access Point

Results

When a person wants to unlock a door, a pop-up will be displayed on the platform. You can open
the door or ignore the request.

Figure 4-36 Remote verification

Remote Verification

Access Point:
Time: 2023-05-1511:22:44
Person Name: wmm-13001
ID: 13001

Gender:  Unknown

Person Group: wmm-test

Card No.: 7BCC1A2A
Phone No.:
ID No.:

4.5.3.10 Viewing Rule Exception

After adding rules, exceptions might happen when they are being applied to access points. The
platform displays all exceptions on this page and provide reasons and prompts for each one. You
can handle the exceptions accordingly and then quickly send the rules again in one click, but it only
applies to General Verification rules. For other types of rules, you can only send them again
manually.

Log in to the DSS Client. On the Home page, click , and then in the App Config section, select
Access Control > Access Rule > Rule Maintenance > All Abnormalities.

Click the name of a person or access point to quickly go to the corresponding page for
configurations. Handle the exceptions according to the reasons and prompts, and then click Send
Again to send the rules again.
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4.5.3.11 Verifying Consistency of Person Information

Rules will not be applied successfully if the people on the devices and the platform are not the
same. You can use this function to check the people on a device against those on the platform, and
quickly address issues if any occurs.

Prerequisites

Before using this function, you must configure an Image and File disk for the server where the
device is added to. For details, see "3.3 Configuring Storage".

Procedure

Step 1

Step 2

te

:

te

:

Log in to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Access Rule > Rule Maintenance > Consistency
Verification.

Select an access control device, and then click Verification.
A verification record will be generated on the right. If Completed is displayed, it means

that the people on the device match those on the platform, and the device pass the
verification.

If any issue occurs, click View Details to view its details.
Click One-click Process to automatically address all issues.
The following issues might occur and how the platform will address each of them:

® A person is not on the device: The person will be added to the device.
® A person is not on the platform: The person will be deleted from the device.

® The information of a person on the device is not the same as the platform: Update the
information on the device.

4.5.4 Configuring Public Passwords

For a door, any person with the public password can unlock it. You can configure up to 1,500

passwords.
Procedure

Step1 Loginto the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Public Password.

Step2  Click Add.

Step3  Enter a name for the password, configure the password, and then select the door
channels from access control and video intercom devices that the password will be
applied to.

Step4  Click Save.

Step5 (Optional) If exceptions occur, click m to view details. Handle the exceptions according

to the reasons provided by the platform, and then click Send Again.
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4.5.5 Configuring Time Templates

Configure time templates for different access control strategies. For example, employees can only
gain access to their offices during work time.

Procedure

Log in to the DSS Client. On the Home page, click , and then in the App Config
section, select Access Control > Door Groups.

Click B,

Click Create Time Template from the Time Template drop-down list when adding or
editing a door group.

Figure 4-37 Time template

Time Template

Time Template Name

Copy From:

riod Template

Monday:

Thursday:

Friday:

Saturday:

o]
o]
o]
o]
o]
2]
o]

Sunday:

Cancel

Enter the template name, set time periods, and then click OK.
There are two ways to set time periods:

® Drag your mouse cursor on the time bars to select time sections. To remove a selected
time section, click on the time bar and drag.

e Click & and then set time periods in the Period Setup dialog box.

[

® You can add up to 6 periods for each day.
® To use an existing template, select the Copy From check box and then select a
template in the drop-down list.
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4.5.6 Configuring Access Control Devices

If an access control device is online, you can restart it, and synchronize its time with the platform.
Also, you can set a person as the administrator, and then the person can log in to the configuration
page of the access control device to configure parameters.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device > Device Config.

Step2 Select an access control device from the device tree.

Figure 4-38 Select an access control device

¥ im Root
P r2aa

» 27 test-dms

Device Administrators...
ol

» '.%.' [j‘,"’-'l

» A root

Step3  Configure the access control device.

® (lick Restart Device to restart the device.

® (lick Device Administrators Config and add people from person groups. Then, the
people can use their usernames and passwords to log in to the configuration page of
the device.

® (Click E at the upper-right corner to go to the web page of the device.

4.5.7 Configuring Door Information

You can configure door status, modes, alarms and more.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the Basic Config
section, select Device.

Step2  Select a door channel in the device tree, and then click Door Config on the right.
Step3  Configure door information, and then click OK.

121



@/hua

User's Manual

Figure 4-39 Door configuration

Reader Direction:

In Reader 1

Mode:

Normal

= Out Reader2

Enable Door Sensor:

Enable Alarm:

- Duress

—e

Unsuccessful Attempts Exceeding Limit

Public Password:

Unlock Duration:

5

Unlock Method:
OR

. Card

[

Unlock Timeout:

Unlock by Period
~ &

. Password

. Fingerprints

The page is only for reference, and might vary with different access control devices.

Table 4-27 Parameter description

Parameter

Description

Reader Direction

Indicates the in/out reader based on the wiring of ACS.

Mode

Set access control status to Normal , Normally Open, or Normally
Closed.

Enable Door Sensor

You can only enable forced entry and timeout alarms when the door
sensor is enabled.

Enable Alarm

® Duress: Entry with the duress card, duress password, or duress
fingerprint triggers a duress alarm.

® Unsuccessful Attempts Exceeding Limit: If failed to unlock the door
for certain times, an alarm will be triggered.

® Forced Entry: If the door is unlocked by methods you have not
configured, the door contact is split and triggers an intrusion alarm.

® Timeout: Unlock duration timeout triggers a timeout alarm.

Public Password

Enable this function, and then you can use a public password to unlock
the door. For how to configure a public password, see "4.5.4 Configuring
Public Passwords".

Unlock Duration

Sets up for how long the door will unlock. The door locks automatically
after the duration.

Unlock Timeout

Unlock duration exceeding the Unlock timeout triggers a timeout
alarm.
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Parameter Description

You can use any one of the methods, card, fingerprint, face, and
password, or their combinations to unlock the door.

® Select And, and select unlock methods. You can only open the door
using all the selected unlock methods.

® Select Or and select unlock methods. You can open the door in one
of the ways that you configured.

Unlock Method

For each day of the week, you can set up to 4 periods, and the unlock
method for each period. For example, card is set for Monday
08:00-12:00, then people can only user their cards to open the door
Unlock by Period every Monday from 08:00 to 12:00.

Use the Copy to function to quickly apply the current configurations to
one or more days.

4.6 Video Intercom

4.6.1 Preparations

Make sure that the following preparations have been made:

® Access control devices are correctly deployed. For details, see the corresponding user’s manuals.

® Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".

¢ When adding video intercom devices on the Device page, select Video Intercom as the
device category.

¢ When adding access control devices that support intercom, select Device Category to
Access Control in Login Information, and then select Access Control Recognition
Terminal.

® The platform automatically creates a room after you add a VTH. For details, see "4.6.4
Configuring Room".

® Any configuration modification on the device will not be reported to the platform. You need to
go to the device modification page of Web Manager to manually synchronize the modification.

4.6.2 Call Management

Create call group, management group and relation group respectively and define restricted call
relations. This function is only available for administrators.

A\

Click Bl on the page of call group, management group or relation group, the system will restore
management group and relation group to their original status.
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4.6.2.1 Configuring Call Group

Only devices in the same call group can call each other.

® A call group will be automatically generated after you add to the platform a VTO or access
control device that supports intercom. All VTHs in the same unit will also be automatically added
to the group. 2 VTHs or a VTH and VTO in the group can call each other.

® A call group will be automatically generated after you add a second confirmation station to the
platform. Add the VTHs in the same house to the group, then the second confirmation station
and the VTHs can call each other.

® A call group will be automatically generated after you add a fence station to the platform. All the
VTHs on the platform will be automatically added to the group by default, then the fence station

and the VTHs can call each other. You can also click to edit the VTHSs in the group, so that the
fence station can only call certain VTHs.

® After added to the platform, VTHs will be automatically added to corresponding groups if they
are associated with VTOs, second confirmation stations, or fence stations, so that they can call
each other.

4.6.2.2 Adding Manager Group

Divide administrators into different groups and link them to call groups in different combinations.
This is useful when certain administrators can only answer calls from certain devices. Administrators
include VTS and users with permissions to use the video intercom function and operate the devices.
VTS will be automatically added to the default manager group after added.

Procedure
Step1 Login tothe DSS Client. On the Home page, click EY and thenin the App Config
section, select Video Intercom.
Step2 Click B
Step3  Click Manager Group Config.
Step4 Click Add Group.
Step5 Enter group name, select administrator account or VTS, and click OK.

The added management group is displayed in the list.
L]

® To transfer members, click l&d and move the member to other groups.

® To manage group members, click B to add or delete group members.
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Figure 4-40 Edit manager group

Add Manager Group

Group Name:

Control Permissions Selected(0)

Select All

system

4.6.2.3 Configuring Relation Group

Link call groups and manager groups, and VTOs or VTHs in a call group can only call administrators
or VTSs of a linked manager group. There are 2 types of relations:

® A call group links to 1 manager group.

All online administrators in the manager group will receive the call when any device is calling. If
an administrator answers, it will stop ringing for other administrators. The call will only be
rejected if all administrators reject it.

A call group links to multiple manager groups.

Priorities vary for different manager groups. When any device is calling, all online administrators
in the manager group with the highest priority will receive the call first. If no one answers for 30
seconds, then the call will be forwarded to the manager group with the second highest priority.
If still no one answers, the device will prompt that there is no response for the call.

Procedure
Step1 Login tothe DSS Client. On the Home page, click EY and then in the App Config
section, select Video Intercom.
Step2 Click B,
Step3  Click Relation Group Config.
Step4 Click Add.
Step5 Enterthe group name, and then select one or more call groups and manager groups.
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Step 6

Figure 4-41 Add a group relation
Add Relation Group

Group Mame:

Security Team A

Call Group Manager Group

Manager Group
B Select All B select All

B Unit Vo G
U
Unit VTO

B rence VIO Group1 {

Operation

The upper manager group has higher priority.

Because only up to 2 manager groups will receive a call, we recommend you select no
more than 2 manager groups.

Click M or B to adjust priorities of the manager groups, and then click OK.

4.6.3 Configuring Building/Unit and Call Mode

Make sure the status of building and unit of the DSS client is the same as the VTO. If building and
unit are enabled on the platform, they must also be enabled on the device, and vice versa;
otherwise, the VTO will be offline after it is added. That also affects the dialing rule. Take room 1001
unit 2 building 1 as an example, the dialing rule is as follows:

® |f building is enabled while unit is not, the room number is "14#1001".

® |f building is enabled, and unit is enabled as well, the room number is "1#2#1001".
® [f building is not enabled, and unit is not enabled either, the room number is "1001".

Select a call mode to specify the order of calling VTH and App.

Procedure

v [N
~+ |+
FP
w N

Step 4

Log in to the DSS Client. On the Home page, click EY and then in the App Config
section, select Video Intercom.

Click A,
Enable or disable building and unit as required, and then click OK.

This configuration must be the same as the device configurations. Otherwise, information
of the devices might be incorrect. For example, if only Building is enabled on a VTO, you
must only enable Building on the platform.

Configure the call mode.
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® Simultaneous Call : When a room is being called, all the VTHs and App users in it will
receive the call. If there are only App users in the room, then all App users will receive
the call.

® Group Call : When calling a room, only the VTHs in it will receive the call. If call
forwarding is enabled on the VTHs, then all App users will receive the call.

Step5  Click Save.

4.6.4 Configuring Room

Add a room to include the VTHs and app users in it.

Background Information

When you add a VTH to the platform, the platform will automatically create a room. You can also
create a room and add the VTH later. The VTH will automatically join the corresponding room. The
rooms that are automatically created cannot be deleted. You can only delete those that are
manually created.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Video Intercom > Room Config.

Step2 Click Add.
Step3  Select an organization, enter a name for the room and the room number, and then click
Add.

If the VTH with the same room number has been added to the platform, or the
homeowner with the same room number has registered, the VTH or the app user will join
the room automatically.

Related Operations

Operations on the app users:

L @: Set an app user to be the homeowner after it is linked with a person.

o : Reset the password of an app user. The app user will need to log in to the app with the new
password.

o [ Linkan app user to a person.

o E: Delete an app user. The user can no longer log in to the app. If the user is also a homeowner,
all app accounts in the corresponding room will be deleted, and all people in this room can no
longer log in to the app.

4.6.5 Synchronizing Contacts
Send room information to a VTO and then you can view it on the VTO or its webpage.
Procedure

Log in to the DSS Client. On the Home page, click EY and then in the App Config
section, select Video Intercom.

Step2  Click .

Step3  Send room information.

te

:

® Selecta VTO, and then click of a room.
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® Selecta VTO, and then click Send Contacts to send all or selected rooms.

Now you can view the room information on the VTO or its webpage. If any room cannot
be sent, the reason will be provided.

Related Operations

After sending room information successfully, you can delete it from the VTO, then it will not be
displayed on the VTO or its webpage anymore.

L Clickﬁ delete one room at a time.
® (lick Delete Contacts to delete all or selected rooms.

4.6.6 Setting Private Password

Set room door passwords so that the room door can be opened by entering password on the VTO
(outdoor station).

(L1

Make sure that contacts are sent to the VTO; otherwise you cannot set private password.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config

section, select Video Intercom.

Step2  Click EA.

Step3  Selecta VTO, and then you can see all the VTHs linked to this VTO.

Step4  Selecta VTH and click [@, or select several VTHs and click Change Password.

Step5 Enter password, and then click OK.

You can use the new password to unlock on the VTO.

(1

The format should be room number + private password , and the room number consists
of 6 digits. For example, a person who lives in 1001 with the private password of the VTO
in the building being 123456, can enter 001001123456 to unlock the door.

4.6.7 QR Codes

Configure the information of the QR codes that are used by homeowners to download the App and
register an account.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Video Intercom > QR Codes.

:

Step2  Enter a name and some notes for your community, and then click Save.

Homeowners can scan the QR Code for App Download to download and install the App
on the phone, and then scan the QR Code for App Registration to register. For how to
register, see the user manual of the App.
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4.6.8 App User

You can view information of App users, freeze user, modify login password and delete user.

Prerequisites

App users have registered by scanning the QR code on the platform or the VTH. For details, see the

user manual of the App.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Video Intercom.

Step2  Click E

Table 4-28 Parameter description

Operation

Description

Freeze APP user

The App user cannot log in for 600 s after being frozen.

The account will be frozen when invalid password attempts exceeds 5 by
an App user.

Change APP user login
password

Click @ and enter a new password on the Reset Password page, and
then click OK.

® The password must be 8 to 16 characters and include numbers and
letters.

® (lick © to display password, or ™ to mask password.

Refresh the list of App
users

Click Refresh to display the App users that recently registered.

Delete APP user

Click Eto delete App users one by one, or select multiple App users, click
Delete, and then follow the instructions to delete them. The users can no
longer log in to the App. If a user is a homeowner, all App accounts in the
corresponding room will be deleted, and all people in this room can no
longer log in to the App.

4.7 Visitor Management

After appointment is made on platform, and visitor information is registered, the visitor can have
access permission. Access permission is disabled after the visitor leaves.

4.7.1 Preparations

® Access control devices have been added into the platform.
® Basic configurations of the platform have been finished. To configure, see "3 Basic

Configurations".

129



a/hua

TECHNOLOGY User's Manual

4.7.2 Configuring Visit Settings

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Visitor.

Step2  Configure the parameters.
® Automatic visit

Enable the function, and then select the channels as needed. Visitors with
appointment can verify their identities on the selected channels without registering.

® Automatic leave

¢ Enable the function, and then select the channels as needed. Visitors who are
visiting can verify their identities on the selected channels to end their visits
automatically.
¢ Sign out regularly: Expired visits will be automatically ended at the defined time
point.
¢ Daily sign-out time: For visitors who do not arrive for their appointment before the
daily sign-out time, their appointment will be canceled.
¢ Sign out now: For visitors who missed their appointment when you click this
button, their appointment will be canceled.
® Default visitor permissions: Set the default access permissions for visitors.
® Email template: You can set up an email template and automatically send emails when
visitors make an appointment, arrive for their appointment, and end their visit. You
can customize the email subject and content with the visitor information, such as
visitor's name and ID number.
® Visitor pass remarks: Customize the content of remarks on a visitor pass.

Figure 4-42 Customize visitor pass remarks
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Figure 4-43 Visitor pass remarks

Visitor Pass

o)

John Wilks
Phone MNo.:

Plate Mo.:

1D Mo.:

Remarks: Welcome!

Validity:

2023-1240111:24:51 - 2023-12-01 13:24:51

Step3  Click Save.

4.8 Parking Lot

Control vehicle entrance and exit control with the functions such as ANPR, number of parking
space, alarm, and search. In case the vehicle is not recognized by the ANPR camera, visitors can use
VTO to call the management center, and then the management center can remotely open the
barriers after verifying the identity of the visitor.

4.8.1 Preparations

Make sure that the following preparations have been made:

® Devices, such as ANPR cameras, parking space detectors, VTOs, and displays for available
parking spaces, are added to the platform.

® Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".

¢ When adding an ANPR camera, select Access ANPR Device as the device category.

After you have added ANPR cameras, you can bind video channels to their channels. This is
useful when you have installed other cameras at the entrance to view and record videos of
the entire scene, not just the vehicle. You can view video from the bound camera when
checking the alarm details. For how to bind channels, see "3.1.3 Binding Resources".

¢ When adding an NVR, select Encoder as the device category.

¢ Select Entrance ANPR from Features for the corresponding NVR channels.

¢ When adding VTO, select Video Intercom as the device category.
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Also, you need to add the information of people and assign them permissions so that they
can use the VTO normally. For details, see "4.3 Personnel and Vehicle Management".

Make sure that the configuration of building and unit on the DSS client is the same as the
device. If building and unit are enabled on the platform, they must also be enabled on the
device, and vice versa. Otherwise, the VTO will be offline after being added. For details, see
"4.6.3 Configuring Building/Unit and Call Mode".

Add a screen.

Add a display for available parking space. Select Display Device as the device category.
Dahua screen and Jiuzhou screen are supported as the display for available parking space.
Snapshots taken by ANPR cameras are stored in the Images and Files disks. You must
configure at least one Images and Files disk so that snapshots of vehicles can be normally
displayed. For details, see "3.3 Configuring Storage".

4.8.2 Configuring Parking Lot

A parking lot includes parking spaces, entrances and exits, barrier control rules and other
information. Link an ANPR camera for recognizing license plates, and a VTO for verifying identities.

4.8.2.1 Basic Information

Procedure
Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Parking Lot > Parking Lot Configuration > Parking Lot Basic Config.
Step2  Click the root node, and then click Add.
(11
Up to 16 parking lots can be added.
Step3  Configure the basic information of the parking lot, and then click Next Step.
Table 4-29 Parameter description
Parameter Description
Parking Lot Name To differentiate from other parking lots.
® Count parking spaces by entering and exiting vehicles : Set
up the total and available parking spaces in the parking lot,
. and then the parking spaces will be automatically counted
Er;itr)]lgnParkmg Space based on each vehicle that enters or exits the parking lot.
9 ® Count parking spaces using parking space detectors : After
parking space detectors are added to the platform and
configured, parking spaces will be automatically counted.
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Parameter

Description

Fuzzy Match of Entrance &
Exit Plate No. Snapshot

® First Character Rule

¢ 1 character added to the front of the plate number: It will
still be considered as a match when an additional character
is added to the plate number. For example, AB12345 is
recognized as AAB12345.

< Missing the first character of the plate number: It will still be
considered as a match when the first character is missing
from the plate number. For example, AB12345 is recognized
as B12345.

® | ast Character Rule

¢ 1 character added to the end of the plate number: It will still
be considered as a match when an additional character is
added to the end of the plate number. For example,
AB12345 is recognized as AB123455.

¢ Missing the last character of the plate number: It will still be
considered as a match when the last character is missing
from the plate number. For example, AB12345 is recognized
as AB1234.

® Misread Character Rule: It will still be considered as a match if a

character is recognized incorrectly, but the number of

characters are correct. For example, AB12345 is recognized as

AB12B45.

||

When you enable multiple rules, the platform will check if each
rule is satisfied. Only when one or more rules are satisfied will
platform consider it to be a match. For example, 1 character added
to the front of the plate number, and missing the first character of
the plate number are both enabled. When the plate number
AB12345 is recognized as AAB12345, it satisfied 1 character added
to the front of the plate number, but not missing the first
character of the plate number. This will be considered as a match.
If the plate number AB12345 is recognized as AB112345, it does
not satisfy both rules. This will not be considered as a match.

Auto overwrite when
captured vehicle has not
existed

If a vehicle entered the parking lot but has not exited, a new entry
record will be generated when the vehicle is recognized to have
entered again. The original entry recorded will be changed to a
forced exit record.

Step4  Configure the entrance and exit points, and then click Next Step.

el

The platform supports up to 60 entrances and exits from all parking lots.

. Click [: or Add Entrance and Exit Point.
. Enter a name, and then click OK.

1
2
3. Ifthereis an entrance point, clickn next to Entrance.
4

. Enter a name for the point, select a capture mode, and then add a camera, video
intercom device (optional), or information display (optional).
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If limited by the surroundings, you can install two cameras for this point, and then set
Capture Mode to Dual Camera to improve the successful rate of recognition number

plates.

In Dual Camera mode, the vehicles captured by the two cameras within the defined
Dual Camera Coordination Time will be considered as the same one. You must
configure the time properly according to the installation positions of the cameras and
the distance between them.

Figure 4-44 Entrance point configuration

[* Entrance *

-
Entrance W

Entrance Name

License Plate Snapshot and Recognition

® Online

Information Display

otothec..

5. If thereis an exit point, clickﬂ next to Exit, and then configure the parameters.

The parameters are similar to the ones in Entrance. For details, see the steps above.

Step5 Configure the passing rules, and then click Next Step.
1. Select a vehicle entrance rule, and then configure the parameters.
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Table 4-30 Parameter description

Parameter

Description

Registered Vehicles

Registered Vehicles Access Rule
Click Add, and then select By Parking Lot or By Point.

By parking lot: The vehicle groups will be added to all entrance
and exit points of the parking lot, and the vehicles in these group
can enter and exit through any entrance or exit.

By point: You can add different vehicle groups to different
entrance or exit points. For example, vehicle group is added to
East entrance but not South entrance, then the vehicles in the
group can only enter the parking lot through East entrance.
Allow Passage When Available Space is 0 : After enabled,
vehicles are allowed to enter the parking lot even if there are no
available parking space.

Click I to enable this function for an entrance point.

[

This function is available only when parking space counting is
enabled for the parking lot.

All Vehicles

All vehicles can enter the parking lot.

Allow Unlicensed Vehicles to Enter : Vehicles with no license
plates can also enter the parking lot.

Vehicles on the Blocklist to Enter : Vehicles on the blocklist are
also allowed to enter the parking lot.

Allow Passage When Available Space is 0 : After enabled,
vehicles are allowed to enter the parking lot even if there are no
available parking space.

Click Il to enable this function for an entrance point.
11

This function is available only when parking space counting is
enabled for the parking lot.
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Parameter

Description

Custom

You can customize the passing rule for the entrance.

® For how to configure Registered Vehicles Access Rule and
Allow Passage When Available Space is 0, see the content
above.

® All Vehicles: Select a default time template or create a new one,
and then any vehicle can enter the parking lot within the
specified duration.

For how to create a new time template, see "3.1.6 Adding Time
Template".

® Open Barrier by Verification : After enabled, the access
permission of a vehicle must be verified, and then an
administrator can manually open the barrier for it. If Open
Barrier by Card Swiping After Verification is also enabled, the
driver can swipe a card, and then the barrier will automatically
open if the can verify the driver to be the owner of the vehicle.

® Open Barrier by Card Swiping Without Verification : The
barrier will automatically open if the card has access permission.

[

You can enable Open Barrier by Verification or Open Barrier
by Card Swiping Without Verification at the same time.

® Available Parking Space Counting:
L]

el

You must enable parking space counting and select Count
parking spaces by entering and exiting vehicles.

¢ Count each vehicle as an occupied parking space : The
number of parking spaces decreases after a vehicle enters.

¢ Count each unregistered vehicle as an occupied parking
space : The number of parking spaces decreases only after a
vehicle that is not registered to the platform enters.

¢ Custom : Configure which vehicles in the vehicle groups will
be used to calculate parking spaces.

o=

For how to configure vehicle groups, see "4.8.3 Managing Vehicle Group".
Select a vehicle exit rule, and then configure the parameters.

The parameters are similar to the ones in the entrance. See the previous step.

Enable Send Plate No. to Devices, and then add vehicle groups to the allowlist and
blocklist.

Devices can use this information to determine which vehicles to let in when the
platform is offline.

Step6 (Optional) Configure parking space detectors, and then click Next Step.
[

If you do not need to calculate parking spaces by using parking space detectors, you can
skip this step and click Next Step.

1.

Click Add or Add Parking Space Detector.
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You need to add parking space detectors to the platform first. For how to add parking
space detectors, see "3.1.2 Managing Device".

2. Select the parking space detectors that belong to this parking lot, and then click OK.

Step7 (Optional) Add indoor and outdoor parking space available displays to the parking lot and
configure the content to be displayed, and then click Save and Exit.

For different device protocols and models, the content that can be displayed varies. The
content includes arrows, placeholders (for displaying parking spaces), numbers, letters,
icons, and the color of the display when there are parking spaces available or the parking
lot is full. The sources for the placeholders can be one of the following options:

® Count parking spaces by entering and exiting vehicles : Displays the number of
parking spaces based on the total number and available parking spaces of the parking
lot.

® Selected Parking Spaces : Only displays the number of parking spaces from the
parking space detectors you select.

® Count parking spaces by parking space detectors : Displays the number of parking
spaces from all parking space detectors in this parking lot.

Related Operations

& Edit the passing rules of the parking lot.

e [l Edit the available parking space of the parking lot.
e B tdit the information of the parking lot.

e [ Delete the parking lot.

4.8.2.2 Reserved Parking Space

Link a parking space to one or more plate numbers. Alarms will be triggered if vehicles with other
plate numbers park in this parking space.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Parking Lot > Parking Lot Configuration > Reserved Parking Space
Config.

Step2 Select a parking lot, and then click Add.
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Figure 4-45 Link a parking space to plate numbers

Add Reserved Parking Space

Select Parking SpaceID | 1

Vehicle Group  VIP

Plate No. Owner Name

Total 7 Record(s) 1 20 ¥ per Page

Cancel

Step3  Select a parking space you want to link plate numbers to, a vehicle group, and one or
more plate numbers, and then click OK.

4.8.2.3 Parking Lot Layer

Add a plan view image to the parking lot, and then mark the entrance and exit points, parking
spaces, parking space available displays, and monitoring devices on it, so that you can manage the
parking lot in an intuitive way. If the parking lot has multiple floor, you can add an image for each

floor.
Procedure

Step1 Login tothe DSS Client. On the Home page, click EY and then in the App Config
section, select Parking Lot > Parking Lot Configuration > Parking Lot Layer Config.

Step2  Select a parking lot, and then click Add.

Step3  Enter a name for the layer, upload an image, and then click Save and Configure Layer.

Step4 Drag an entrance or exit point to the image, and then click Next Step.

Step5 Drag a parking space to the image, adjust its size and direction, and then click Next Step.
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Figure 4-46 Mark a parking space

Step6 Drag a parking space available display to the image, and then click Next Step.
Step7 Drag achannel of a monitoring device to the image, and then click Next Step.

Related Operations

° ‘?: Edit the marked information on the layer.

° : Edit the name and image of the layer.

° E: Delete the layer.
4.8.2.4 Event Parameter

Configure events for a parking lot so that you can receive notifications when alarms are triggered.
Procedure

Step1  Configure an event, and you need to select Parking Lot as the type of event source. For
how to configure an event, see "4.1 Configuring Events".

Step2 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Parking Lot > Parking Lot Configuration > Event Parameter Config.

Step3  Select a parking lot, the events that were configured will be displayed on the right.

The following events will not be displayed because there are no additional parameters to
be configured.

® Blocklist alarm: An alarm will be triggered when a vehicle on the blocklist enters the
parking lot.

® Reserved parking space alarm: An alarm will be triggered when a vehicle parks in a
parking space, but its plate number is not linked to the parking space.

® Parking overline: An alarm will be triggered when a vehicle crosses a line after it is
parked.

Step4  Click Eto configure an event.
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Table 4-31 Parameter description

Parameter

Description

Parking Overtime

® Overtime Parking Threshold : The unit is minute. Alarm will

be triggered if a vehicle has parked for longer than the
defined value.

Detection Interval : How long the platform will check which
vehicles have parked overtime. For example, select 5 minutes,
then the platform will check whether there are vehicles that
have parked overtime in the parking lot. If yes, then an alarm
will be triggered.

Vehicles to Trigger Alarms :

¢ All Vehicles : All vehicles will trigger alarms if they park
overtime, but VIP vehicles are not included. If you enable
Include VIP Vehicles, VIP vehicles will also trigger alarms
when they park overtime.

¢ Non-registered Vehicle and Vehicle in the Blocklist :
The vehicles whose information is not registered to the
platform will trigger alarms when they park overtime.

¢ Custom : Enable Non-registered Vehicle, and then the
vehicles whose information is not registered to the
platform will trigger alarms when they park overtime;
enable Registered Vehicle and add vehicle groups, and
then the vehicles in these groups will trigger alarms when

they park overtime.
@

You can enable Non-registered Vehicle and Registered
Vehicle at the same time.

No Entry and Exit Record

No Entrance/Exit Record Duration : The unit is day. If a
vehicle has not entered or exited the parking lot for longer
than the defined duration, then an alarm will be triggered.
Statistical Time Point : The platform will start calculating the
duration of a vehicle that has not entered or exited the
parking lot on the defined time.

Entrance and Exit Vehicle Group of Interest : Only calculate
the duration for the vehicles in the vehicle groups that are
added.

4.8.2.5 Vehicle Finder

Enable vehicle search for parking lots, so that vehicle owners can find where their vehicles are
parked through the vehicle search system.

Prerequisites

Parking space detectors have been configured for the parking lot. They are used to provide exact

locations of vehicles.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Parking Lot > Vehicle Search Config.

140




a/hua

TECHNOLOGY User's Manual

Step2  Click Add, and then configure the parameters.

Table 4-32 Parameter description

Parameter Description
Rule Name Enter a name for the rule.
Enable Status If enabled, the rule will be effective immediately after added.

Parking Lots Allowed to

be Searched for Select the parking lots you want to enable vehicle search for.

Upload Vehicle Search | You can customize the logo on the page of the vehicle search system.
Interface Logo The logo must not exceed 256 KB.

Step3 Click Add.

If the platform is working on 2 network cards, the rule will generate multiple links and QR
codes that match with each other. They are used to access the vehicle search system in

different networks. Hover the mouse on . to view the details of each link.

Related Operations

° Click to copy the link, and then you can use it visit the vehicle search system in a browser.

® CIickEE to view QR codes. Vehicle owners can scan them with their phones to visit the vehicle
search system. You can download the QR codes to your computer, or send them to a defined
email address.

4.8.3 Managing Vehicle Group

Add vehicles to different groups, so that you can quickly apply different parking lot functions to
multiple vehicles at the same time. General, VIP, and blocklist are the default groups. If you need to
use them, you can directly add vehicles to them.

Procedure
Step1 Login to the DSS Client. On the Home page, click , and then in the App Config
section, select Parking Lot > Vehicle Groups.
Step2  Click Add.
Step3  Enter a name and select a color for the group, and then click Add.

Step4  Click @ of a group, or double-click a group and click Select from Vehicle List, select the
vehicles that you want to add to the group, and then click OK.

4.9 Intelligent Analysis

Before using the people counting and scheduled report functions, you must configure them first.

® People counting: Create a people counting group and add multiple people counting rules from
one or more devices to it. Then, you can view the real-time and historical number of people of
the group.

® Scheduled report: Configure the when to send a report with historical people counting data, the
email address to send the report to, and the content of the email.
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4.9.1 People Counting Group

Create a people counting group, and then add multiple people counting rules from one or more
devices. In Intelligent Analysis, you can view the real-time and historical number of people of the

group.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Intelligent Analysis > People Counting Group Config.

Step2 Click Add at the upper-left corner.
Figure 4-47 Add a people counting group

Basic Info

People Counting Group Name:

Main Section
Pass No. —®

Calibrate Number of People Staying Everyday  —®

Calibration Time:

Calibrated Number of People:

0

Limit Number of People —®

After itis disabled, if the people counting group threshold alarm is configured, you will not receive people counting group alarms.

Overlimit Threshold Crowd Threshold

Step3  Configure the parameters, and then click Add.

Table 4-33 Parameter description

Parameter Description

People Counting Group Name of the people counting group.

Name

Pass No. The calibration time can only be configured on the hour. It is the start of
Calibrate Number of a counting cycle.

People Staying ® After Pass No. is enabled, the number of people pass by will be
Everyday displayed. The value will be set to 0 every day on the calibration time
Calibration Time by default.

® The number of people entered but did not exit will be set to the

Calibrated Number of defined value every day on the calibration time.

People
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Parameter Description

Limit Number of People | When enabled, you can configure the crowd and overlimit thresholds of

the people in the group. If an alarm is configured at the same time,
Crowd Threshold alarms will be triggered when the number of people reach the
thresholds. For details, see "4.1 Configuring Events".

® When the number of people in the group reaches the defined crowd
threshold but smaller than the overlimit threshold, the light will turn
yellow.

® When the number of people in the group reaches the defined
overlimit threshold, the light will turn red.

Overlimit Threshold

Select the devices whose people counting rules you want to include in

Rule the group, and then their data will be combined together.

4.9.2 Scheduled Report

Historical data will be sent on a regular basis to one or more email address that you set on the
scheduled time.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Intelligent Analysis > Scheduled Report Config.

Step2  Configure one or more types of report.

® Daily report: Data from yesterday will be sent to your email at a defined time. If set to
03:00:00, the data from the day before (00:00:00-23:59:59) will be sent to your email at
03:00:00 every day.

® \Weekly report: Data from last week will be sent to your email at a defined time. If set to
03:00:00 on Wednesday, the data from Wednesday to Tuesday of each week will be
sent to your email at 03:00:00 every Wednesday.

® Monthly report: Data from last month will be sent to your email at a defined time. If set
to 03:00:00 on 3rd, the data from 3rd of last month to 2nd of the current month will be
sent to your email at 03:00:00 on 3rd of each month.

Step3  Configure one or more email addresses to send the report to, and the content of the
email.
1. Click :] to select the users that have been configured email addresses, or enter an
email address, and then press Enter.

Figure 4-48 Invalid email address, you must press Enter

Email Address

& administrator@gmail.com

Figure 4-49 Valid email address

Email Address

L ] administrator@gmail.com X

2. Configure the content of the email.
Step4 Send the report.

® (lick Send Now to immediately send the report that you configured.
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® (lick Save, and then the report will be sent at the defined time.

4.10 Intelligent Inspection

Configure inspection objects and plans so that the platform can regularly inspect devices, such as
power equipment, or an area, and collect images and data during the process.

Before using this function, you must;

1. Purchase a license with the intelligent inspection function and activate the license. For details,
see "2.1.6 Licensing".

2. Obtain and install the plugin of intelligent inspection. For details, see "2.9 Installing Plugin”.

3. Configure image and file and video disks, to store snapshots and recorded videos during
inspections. For details, see "3.3 Configuring Storage".

4. Add devices used for inspection to the platform, and configure their video retention periods. For
details, see "3.1 Managing Resources".

4.10.1 Configuring Object Template

Configure frequently used object types and inspection points. When you are configuring an actual
inspection point, you can select them to automatically fill in most of the information.

4.10.1.1 Adding an Object Type

Customize the name of an object type, such as "circuit breaker".
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Intelligent Inspection > Object Template.

Step2  Click :]
Step3  Enter a name for the object type, and then click OK.

Related Operations

® (Change the name of an object type

Select an object type, and then click to change its name.
® Delete an object type

Select an object type, and then cIickE to delete it.
4.10.1.2 Adding Inspection Point

Configure the information of the inspection point of an object type. For example, the area on the
circuit breaker to be inspected, items to be inspected, and technologies to be used.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and thenin the App Config
section, select Intelligent Inspection > Object Template.

Step2 Click an object type, and then click Add.
Step3  Configure the parameters, and then click OK.

Or click Save and Continue to add more inspection points.
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Table 4-34 Parameter description

Parameter Description

Click the input box to enter a name manually. If there are
Inspection Area inspection points that have been added, you can select an
inspection area from the drop-down list.

Point Type Enter a name for the point type.

Inspection Item Enter the items to be inspected.

® Visible Snapshot : The platform will only take snapshots.

® Thermal Temperature Monitoring : Use thermal technology
to monitor temperature. You can configure temperature
warning threshold and temperature different warning
threshold, but they are optional parameters.

¢ Temperature Warning Threshold : Configure the
thresholds for low, medium, and high. When the
temperature is greater than either one, an alarm will be

Inspection Technology triggered.

¢ Temperature Difference Warning Threshold : Configure
the thresholds for low, medium, and high. When the
temperature difference is greater than either one, an alarm
will be triggered.

The difference is calculated by 2 inspection points. When
you are configuring an actual inspection point, you must
select another point so that the platform can calculate the
difference.

4.10.1.3 Importing Object Types and Inspection Points
If you need to add a lot of object types and inspection points, you can import them to the platform.
Procedure

tep1 Loginto the DSS Client. On the Home page, click EY and thenin the App Config
section, select Intelligent Inspection > Object Template.

Click .

:

Step 2

Step3 Click Download Template, and then save the template to your computer.

Step4  Fillin the information, and then save the changes.
@
Click EEI to download a template with common object types and inspection points
related to substations for reference.

Step5 Click ImportFile, and then open the template.

The information is imported to the platform.

L1

If there are inspections points that are already on the platform, their information will be
updated.
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4.10.2 Configuring Inspection Object

Add inspection objects to so that the platform can inspect one or more points. Inspection objects
are managed by inspection organizations. Only specified roles and users can access the certain

organizations.

4.10.2.1 Adding Inspection Organization

Inspection organizations are used to manage inspection objects and points. Only administrators
can configure them, and specify which roles and their users can access certain organizations.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Intelligent Inspection > Inspection Object.

Click s

Step 2
Step3  Configure the parameters, and then click OK.
Or click OK and Add Object to add objects to this organization.
Table 4-35 Parameter description
Parameter Description

Parent Organization

This is for permission control. For example, if a user cannot access A,
then the user cannot access all the organizations under A.

Organization Name

Enter a name for the organization.

Roles Allowed Access

Only selected roles and their users can access this organization.

@

Click B to see the users assigned with the roles.

4.10.2.2 Adding Inspection Object

Procedure
Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Intelligent Inspection > Inspection Object.
Step2  Select an organization, and then click Add.
Step3  Configure the basic information, and then click Next.
Table 4-36 Parameter description
Parameter Description

Inspection Object Name

Enter a name for the inspection object.

Organization

Displays the name of the organization you selected from the
previous step. You can select another one.

Type of Object to be Sent

Select an object type that has been added. This is optional.

Step4 Click Add Point.
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If you select and object type from the previous step, all inspection points in that object
type will be automatically added.

Step5  Configure the information of the point, and then click OK.

Table 4-37 Parameter description

Parameter

Description

Point Name

Enter a name for the point.

Inspection Area

Click the input box to enter a name manually. If there are
inspection points that have been added, you can select an
inspection area from the drop-down list.

Point Type

Enter a name for the point type.

Inspection Iltem

Enter the items to be inspected.

Inspection Technology

® Visible Snapshot : The platform will only take snapshots.

® Thermal Temperature Monitoring : Use thermal technology
to monitor temperature. You can configure temperature
warning threshold and temperature different warning
threshold, but they are optional parameters.

¢ Temperature Warning Threshold : Configure the
thresholds for low, medium, and high. When the
temperature is greater than either one, an alarm will be
triggered.

¢ Temperature Difference Warning Threshold : Configure
the thresholds for low, medium, and high. When the
temperature difference is greater than either one, an alarm
will be triggered.

The difference is calculated by 2 inspection points. When
you are configuring an actual inspection point, you must
select another point so that the platform can calculate the
difference.

Step6  Click Bound Camera.

Step7 Configure the parameters, and then click OK to bind the point to a channel.

Table 4-38 Parameter description

Parameter

Description

Select Channel

Double-click a channel to be bound. Its live video and information
will be displayed on the right.

PTZ

If you are binding a PTZ channel, you can operate it by using the
PTZ control panel. Also, you must bind to a preset of the PTZ

channel. Click lESE, and then click [: of a preset to bind it to the
point. For how to configure presets, see "5.1.2.4.1 Configuring
Preset".
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Parameter

Description

Temperature monitoring
parameters

® After you bind a thermal channel, you must add a temperature
monitoring rule on the live video. The rules include point, line,
rectangle, and polygon. The device will take highest
temperature in the area included by the rule you set. For
example, if you add a rectangle on the live video, then the
device will take the highest temperature in that rectangle.

® Temperature Warning Threshold : Configure the thresholds
for low, medium, and high. When the temperature is greater
than either one, an alarm will be triggered.

® Temperature Difference Warning Threshold : Configure the
thresholds for low, medium, and high. When the temperature
difference is greater than either one, an alarm will be triggered.

The difference is calculated by 2 inspection points. When you
are configuring an actual inspection point, you must select
another point so that the platform can calculate the difference.

Step8 Click Save and Exit.

4.10.3 Configuring Inspection Plan

During the set periods, the platform will inspect the objects and points you selected, and save

related data to the platform.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the App Config
section, select Intelligent Inspection > Inspection Plan.

Step2  Select aninspection organization, and then click Add.
Step3  Configure the basic information, and then click Next.
Table 4-39 Parameter description
Parameter Description
Plan Name Enter a name for the plan.
Plan ID This is automatically generated. You can edit it as needed.

Inspection Organization

Displays the name of the organization you selected from the
previous step. You can select another one.

Inspection Type

Select a type for the plan. It is used for searching for certain
inspection plans.

Processing Time

The processing time works in the following 2 ways:

® For the reviewers' reference when they review inspection
results.

® When there are 5 minutes remaining and the inspection plan is
still unprocessed, all users that are allowed to access the
organization that this plan belongs to are notified.

Enable

After enabled, this plan is effective after added.

Step4  Configure the inspection objects and points.

1. Click Add.
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Only the organization you selected, its sub organizations, and their objects and points
are displayed.

2. Select one or more objects, and then click OK.

3. Click the up and down arrows to adjust the order of objects and points.

4. Click Next.

Step5 Configure the time of execution, and then click OK.

Table 4-40 Parameter description

Parameter Description

Execution Mode ® By Period : The plan is automatically executed within the
specified periods.

¢ Once A Day : The plan will be executed at defined time every
day.
o

You can use [==]to configure multiple days at the same time.
Execution Strategy ¢ Looping : Configure the looping interval, and then the plan
will be executed within the effective periods at every interval
you configure. For how to create a time template, see "3.1.6
Adding Time Template”.
® Only Once: The plan will only be executed once after added or
at defined time.

Select whether to turn on the light on devices during inspection.
Because it might take time for devices to turn on their light, you can
configure a warm-up period to make sure that light can be normally
turned on before inspection starts.

Light Mode

4.10.4 Configuring Temperature Monitoring Event

If you have configured warning thresholds in inspections, you can configure events to perform
linkage actions when thresholds are reached. For example, an inspection point monitored a
temperature that is greater than the threshold, a camera will record a video of the area it is
monitoring. For details, see "4.1 Configuring Events".

4.11 Maintenance Center

Configure alert rules to monitor servers and devices so that you can handle them timely to ensure
that the system is working properly. You can also configure video storage detection. You will be
prompted if the duration or integrity of recording is abnormal.

4.11.1 Configuring Alert Rule

Configure alert rules to monitor servers and devices so that you can handle them timely.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the App Config
section, select Maintenance Center > Alert Rule Config.

Step2 Click Add Rule.
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Step3  Configure the parameters, and then click OK.

Table 4-41 Parameter description

Parameter Description

Rule Name Enter a name for the rule. It can be up to 50 characters.

Select a level for the alert. This is used to quickly know the urgency of

Alert Level the alert when it is triggered.

Rule Execution Time The alert will only be triggered within the defined period.

Targets include servers and devices. You can select different alert

Monitoring Targets sources for each of them.

Set the threshold for each condition. When the value is greater than

Rule Conditions or equal to the threshold, the alert will be triggered.

After enabled, you can select the users who will receive notifications

Push Notification when the alert is triggered.

After enabled, you can customize the content to be sent to specified
email addresses. You can configure the email addresses in the

following ways:
Email Notification

° CIick to select the email addresses of users.
® Manually enter an email address, and then press the Enter key.

4.11.2 Configuring Video Storage Detection

The platform will continue to check the duration and integrity of the videos. You will be prompted
if the one of them is abnormal. For example, 30 days of duration and video integrity have been
configured for channel A. If there are only 24 days of video, or the video does not last for 24 hours
on any day, the platform will give corresponding prompts.

Prerequisites

Recording plans have been configured for channels and videos have been recorded.

Procedure
Step1 Login tothe DSS Client. On the Home page, click EY and then in the App Config
section, select Maintenance Center > Video Integrity Config.
Step2 Click Add.
Step3  Configure consecutive storage days, and then select the channels for detection.
Step4 Click OK.

Related Operations

You can view the detection results when viewing the detailed information of a device in
Maintenance Center. If the duration of video is not enough, the number of days will be displayed
in red. If the duration of video for a day is less than 24 hours, the integrity status will be abnormal
and displayed in red.

150




@Z@ya User's Manual

Figure 4-50 Video duration and integrity status

Channel Name Channel Type ~  Channel Onlinef.. ~ Chanel.. ¥ Recording..  Videolnteg..  Storage.. <~ LatestStatusChange

Video Channel ® Online © Normal

48-onvif_2 Video Channel ® Online @ Normal

48-onvif 3 Video Channel # Online © Normal - C CentreStorage  2022-11-15 14:59:19

4.12 Synthesis

Use a bridge to import events to the platform from third-party systems, and then use these events
to create alarms schemes and perform certain linkage actions. You can also share access control
with third-party databases, which can be used by third-party personnel to formulate their own
reports. Also, devices and person information can be synchronized to the platform to be used in
various functions.

4,12.1 Synchronizing Events

Background Information

A bridge serves as a connector between the platform and third-party systems, and is responsible for
importing events from a third-party system to the platform. It must comply with the connection
protocol between the third-party system and the platform. For different systems, the protocol
might vary and you might need to develop a new bridge. Before using this function, make sure the
bridge has been deployed and is running.

Procedure

Step1 Login tothe DSS Client. On the Home page, click EY and then in the System Config
section, select Synthesis > Event Sync.

Step2 Click Add.

L1

You can add up to 5 bridges for synchronizing events.
Step3  Configure the parameters, and then click OK.

Table 4-42 Parameter description

Parameter Description
Project Name Enter a name for this project.
Identity Automatically generated. Copy them to the configuration of the bridge.
Certificate
® (lick kel to verify your password, and then generate a new secret key.
Secret Key ® (lick ksall to verify your password, and then you can click k=d to copy the
secret key.
Remarks Customize the content. When an event is triggered and sent to the platform,
this information will be displayed in the event details.
Bridge IP/
Domain Name | Enter the IP address or domain name, and port number of the bridge.
Bridge Port

Step4  Click Edit of the bridge to configure the incoming trigger events and event sources.
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Figure 4-51 Synchronize events

Incoming Triggered Event Type
+ Add & Import

Incoming Triggered Event Type Code Incoming Triggered Event Type Name

Total of 0 Record(s) . 20 v PerPage

Incoming Event Source
+ Add & Import

Incoming Event Source Code Incoming Event Source Name

Step5  Synchronize incoming trigger events.
® One by one

1. Click Add.
2. Enter the code and name of the incoming trigger event.
3. Click OK.

Figure 4-52 Enter the code and name of the incoming trigger event
Add Incoming Trigger Event
vent Code;

vent Mame:

| Trl'pwird

® |n batches

1. Click Import.
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Figure 4-53 Download template

Import

Supportec

2. Click Download Template, save the template to your PC, and then enter the
information in it.

3. Click Import File, select the file, and then click Open.

Figure 4-54 Synchronize events in batches

Import

* Incoming Trigger Events Import Templatexlsx

Step6  Synchronize incoming event sources.
® One byone

1. Click Add.
2. Enter the number and name of the incoming event source.
3. Click OK.
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Figure 4-55 Enter the code and name of the incoming event source

Add Incoming Event Source

Incoming Event Source No.:

1

Incoming Event Source Name:

‘ IPCO01|

- CE”-I € El

® |n batches

1. Click Import.
Figure 4-56 Download template

Import

Supported file &

2. Click Download Template, save the template to your PC, and then enter the
information in it.

3. Click ImportFile, select the file, and then click Open.
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Figure 4-57 Synchronize incoming event sources in batches

Import

Event Source Import Templatexlsx
y imported

Step7 Click Close at the lower-left corner.
Related Operations
Configure an event scheme.

1. Go to the Home page, click EY and thenin the Applications Configuration section, select
Event.

2. Click Add.
3. Inthe Event Source section, select the one you import from the third-party system.

Figure 4-58 Add a third-party event

 AddEvent

Event Source

Event Source Type i Event Source

Device

Video Channel L
¥ Third Part 2y B sciect All

Alarm Input Channel _
® Tripwire

B Third Party IPC001

Access control Channel
Radar

Parking Lot

14

lishu_test

pyf

4. For other parameters, see "4.1 Configuring Events".
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4,12.2 Synchronizing Data

You can manually or regularly synchronize data in the platform to third-party databases.

Procedure

Step 1

Step 2

Step 3

Step 4

Step 5

Log in to the DSS Client. On the Home page, click EY and then in the System Config
section, select Synthesis > Data Sync.

Click Add.
[L]

You can only add one database.

Configure the basic parameters of the database, and then click Test.

If the connection can be established, the system will prompt that it connects to the
database successfully.

Click B8, and then configure when the platform will automatically synchronize the data
every day.

You can only configure 4:00-23:00.
Configure the data to be synchronized.
1. Click Add in the Synchronization Data section.

Figure 4-59 Configure parameters

Add Data Table

Business Module Third-party System Data Table

Access Control AccessControlData

Table Field Data Type Data Length Description Third-party System Data Table Field

ID varchar 20 Primary Key ID ID

CHANNEL_ID varchar Device Channel ID ChannellD

CHANNEL_NAME  varchar Device Channel ... ChannelName

OWNER_CODE varchar Person Group Co...

CARD_NUMBER varchar Card Number

SWIPE_TIME_UTC  varchar Swipe Time(ms)

SWIPE_ID varchar The person IDwh...

2. Set Business Module to Access Control, and then enter the name of the data table in
the third-party system.

LL]

You can only add the access control module once.

3. Enable the type of data to be synchronized. You must disable the data you do not
want to synchronize.

4. Enter the corresponding names in the table in the third-party table for the data to be
synchronized.

5. Click OK.
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Related Operations

Edit : Edit the information of the database or the data that is being synchronized. You can view
each synchronization result in the log. See "8.1.3 System Log".
Manually Sync Now : Synchronize the data immediately. All the data will be synchronized on

the first attempt, including after you delete and then add the database again. Only new data will

be updated on subsequent synchronizations.

4.12.3 System Integration

Background Information

Devices and person and vehicle information can be synchronized from a third-party platform to the
DSS platform to be used in various functions.

Procedure

Device management: View the parameters of devices.

Person and vehicle information: View the information of organizations, persons, and vehicles.
Event: Configure event schemes, and receive and process alarms.

Monitoring center: View linked real-time videos, recorded videos, map information, and more.
Zone management: Access points will be created for each access control channel.

Access control: View linked real-time videos, and open and close doors.

Access control records: Display real-time and historical records, extract access records from
devices, and view entering and exiting statistics of people.

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config

section, select Synthesis > System Integration.

Step2 Click Add.

L1

You can add up to 5 bridges for system integration.

Step3  Configure the parameters, and then click OK.

Table 4-43 Parameter description

Parameter Description

Enter a name for this project. This name
will be used in different resources, such

Project Name -
as organization name and event source

Basic Info type.

Select the type of the third-party
Integrated Platform Type | platform. Currently, only access control
platform is supported.
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Parameter Description

Identity Certificate Automatically generated. Copy them to
the configuration of the bridge. The
bridge will use this information to verify
its identity to the DSS platform.

® (lick ksl to verify your password, and
Secret Key then generate a new secret key.

® (lick kasll to verify your password, and

then you can cIick to copy the
secret key.

Customize the content. When an event is
triggered and sent to the platform, this
information will be displayed in the
event details.

Remarks

Bridge IP Address/Domain | Enter the IP address or domain name,

Bridge Port and port number of the bridge.
Bridge Connection Info Identity Certificate Enter the identity certificate and secret
key of the bridge. The DSS platform will
Secret Key use this information to verify its identity
to the bridge.
Collection Frequency Configure the frequency and time for the
Auto Collect Data _ _ DSS platform to automatically acquire
Collection Time data from the third-party platform.

Step4  Import events from the third-party platform to the DSS platform.
® Onebyone

1. Click Add.
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Figure 4-60 Add an event

Add Event

Event Type Code

234

Event Type Name

Normal Access

Event Source Type

Channel

Event Type

Normal

2. Configure the parameters, and then click OK.

1.

Event Type Code : Enter the code of the event in the third-party platform.
Event Type Name : Enter the name of the event in the third-party platform.
Event Source Type : Select the type of source that will trigger the event.

Event Type : When the type of event source is channel, you need to configure the
event type. They correspond to the types of access control events of the DSS
platform, including normal, abnormal, and alarm.

In batches

Click Import.

159



@Z@ya User's Manual

Figure 4-61 Download template

Import

Supportec

2. Click Download Template, save the template to your PC, and then enter the
information in it.

3. Click Import File, select the file, and then click Open.

Figure 4-62 Synchronize events in batches

Import

ncoming Trigger Events Import Templatexlsx

y imported

Related Operations
® (Configure an event scheme.

1. Go to the Home page, click EY and thenin the Applications Configuration section, select
Event.

2. Click Add.
3. Inthe Event Source section, select the one you import from the third-party system.
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Figure 4-63 Add a third-party event

O Add Event

Event Source

Device
Video Channel e
¥ Third Part
Alarm Input Channel .
® Tripwire ~ T
_ rty IPCO0 T
Access control Channel y I

ELE]
Parking Lot
14
lishu_test

pyf

4. For other parameters, see "4.1 Configuring Events".
® Manually Collect : Synchronize data immediately.
® View List of Failures : View the person or device that the platform failed to synchronize.
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5 Businesses Operation

5.1 Monitoring Center

5.1.1

The monitoring center provides integrated real-time monitoring applications for scenarios such as
CCTV center. The platform supports live video, license plate recognition, target detection, access
control, emap, snapshots, events, video playback, video wall, and more.

Main Page

Provides frequently used functions such as video, event and alarm.

Log in to the DSS Client. On the Home page, click E, and then select Monitoring Center.

Figure 5-1 Monitoring center

Resources

2
(o}
()
=
=
=
o
=
e

13
14
Table 5-1 Page description
No. Parameter Description

® |ist of resources including devices, browser, and maps.
® You can search for a device or channel in the search field.
. . Fuzzy search is supported so that you can simply enter part
1 f:ae\;orltes and device ofth)é name and tlere)n select the e>)(/act one frorFr)l)’ihe P
provided name list.
® Add, delete or rename the favorites. You can also tour the
channels in favorites.

2 Real-time videos Drag a channel to the windows and view its real-time video.
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No.

Parameter

Description

Live view and
playback

® Live view: View real-time videos.
® Playback: View recorded videos. For details, see Playback.

Push videos to a
video wall

Real-time videos that are currently opened can be quickly
displayed on a video wall. You must configure a video wall
before using this function. For details, see "5.1.5 Video Wall".

Set alarm windows in
batches

Set all windows as alarm windows.

After selecting "Open alarm linkage video in live view" in Local
Settings > Alarm, then the alarm videos will be displayed on
the alarm windows. If the number of alarm windows is less than
that of linkage videos, the video linked to the earliest-triggered
alarm will be opened.

Save view

Save all the channels or websites that are opened in to a view
so that you can quickly open all of them later. For details, see
View.

Close all windows

Close all windows in live view.

Search for targets in
the video

The platform supports manually selecting targets and
automatically recognizing targets in the video, and then
quickly searching for them in DeepXplore. For details, see
Selecting and Searching for Target Manually and AcuPick.

Window split mode
and full screen

® Seta window split mode. Supports 1,4, 6, 8,9, 13, 16, 20, 25,
36 or 64 splits, or click to set a customized split mode.

If the live-view channel number is more than the number of
current windows, then you can turn page(s) by clicking at
the bottom of the page.

® Switch the video window to Full Screen mode. To exit Full
Screen, you can press the Esc key or right-click on the video
and select Exit Full Screen.

10

Control doors

For a door channel, you can configure its mode, including
normally open and closed modes, and restoring it to the
normal status. After restoring it to the normal status, people
must verify their identifications to pass within defined periods.

11

Event panel button

Display or hide the event panel.

12

Events

Displays events from channels that you are viewing live videos
from. You can:

® (lick different tabs to display only that type of events.
® Click B clear all the events.

e ClickEBto go to the top of the list to view the latest events.
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No. Parameter Description

® Save the current view of window split and video channels in
the live view section, and name the view. You can directly
select the view from the View tab to display it quickly next
time.

® Channels under a view or view group can be displayed by
tour (in turn). You can set the tour interval to be 105,30 s, 1
min, 2 min, 5 min or 10 min. Maximum 100 views can be
created.

13 View

If the channel you are viewing live video from is of a PTZ
14 PTZ camera, you can control it through the control panel. For
details, see PTZ.

5.1.2 Video Monitoring

View live videos. For ANPR and face cameras, you can view information of ANPR, face detection and
face recognition. For video metadata cameras, you can view metadata information.

5.1.2.1 Viewing Live Video

View the live video of connected devices.

el

This section only introduces viewing live video. For POS live view, see "6.4 POS". For map live view,
see "4.2 Configuring Map".

Procedure

Step1 Login to the DSS Client. On the Home page, click HH, and then click Monitoring
Center > Monitoring.

Step2 Click Live View tab.
Step3  View real-time video.

You can view live video in the following ways:

® Double-click a channel or drag the channel from the device list on the left to one
window on the right.
® Double-click a device to view all channels under the device.

® Right-click a node, select Tour, and then set tour interval. The channels under this
node will play in turn according to the defined interval.

¢ If the number of splits in the window is more than the number of online channels,
video of all channels will be displayed in the window. Otherwise, click on the
top of the page to turn pages.

¢ Close the on-going tour before starting live view.
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Figure 5-2 Live view

Resources P

g B8

Favortte 2021-04-12 16:58:32 201.0021

Blackbody error

3

He
3 ‘Fj;:wrma\

Step4  You can perform the following operations during live view.
® Display intelligent snapshots.

When viewing live video of face detection cameras, face recognition cameras, ANPR
cameras, or target detection cameras, right-click the monitoring image, and then
select Start Picture Overlay. The snapshot will be displayed on the upper-right corner
of the live window. If no more images are captured, a snapshot will be displayed up to
5 s by default, and it will disappear after 5 s.

Point to the live window, and then select type of images to be displayed.

Point to the video window, and then you can see the shortcut menu on the upper-
right corner.

Figure 5-3 Live window
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Table 5-2 Parameter description

Icon

Name

Description

o

Instant playback

Open/close instant playback.

Audio

Open/close audio.

Audio
communication

Start two-way audio with the device the channel belongs to. If
the channel is bound to a IP speaker, then you will talk to the
device the channel belongs to through the IP speaker.

Local record

Click it, and then the system begins to record local file and you
can view the record time on the upper left. Click again, and
then system stops recording and saves the file to your PC. The
recorded video is saved to ..\DSS\DSS Client\Record by default.
To change the storage path, see "8.3.5 Configure File Storage
Settings".

Take a snapshot. The snapshots are saved to ..\DSS\DSS Client

E Snapshot \Picture by default. To change the snapshot storage path, see
"8.3.5 Configure File Storage Settings".
E Close Close the video.

Sleep function is supported for IPCs that use 4G mobile network to communicate and

are solar-powered.

¢ When the device is asleep, you can click to wake it up.

Figure 5-4 Wake up the device

©

The device is asleep. Click the icon to wake it

up.

¢ The device will regularly request to sleep to save battery. When you are viewing its
live video, the device will request to sleep every 2 minutes. When you are not
viewing its live video, the device will request to sleep every 1 minute. You can
accept or reject so that you can continue to watch live video. When rejecting the
request, you can choose whether to delay the next request from the device.
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Figure 5-5 Request to sleep from the device

The'device will-g@'to sleep in 8
séconds. Would you like to
continue watching the video?

»| Remind Me Later

10min

® Right-click the live video, and then the shortcut menu is displayed.
[L]

The menu varies depending on the functions supported by the device you are
operating on.

Table 5-3 Description

Parameters Description

If the camera has more than one audio input channels, you can select
Audio Input Selection one or select the mixed audio. This configuration is effective with both
live view and playback.

Record the audio and video in the current window.

If a channel already has a center recording plan, you cannot start
Start Remote Recording | remote recording.

If a video storage disk is configured on the platform, the videos will be
saved to the platform server.

Take snapshots of the current image (three snapshots each time by
default). The snapshots are saved to ..\DSS\DSS Client\Picture by
default. To change the snapshot storage path, see "8.3.5 Configure
File Storage Settings".

Continuous Snapshot

Select stream type as required. Generally, main stream requires the
Stream Type most bandwidth, and sub stream 2 the least. The smaller the
bandwidth is required by the stream, the smoother the video image.

< Real-Time Priority: The video is in real-time, but video quality might
be reduced.

< Fluency Priority: The video is fluent, but video lagging might occur.

Play Mode < Balance Priority: Real-time priority or fluency priority, depending
on actual conditions.

¢ Custom: Configure the video buffer time from Local Settings >
Video. The larger the value, the more stable the video quality.
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Parameters

Description

Video Adjustment

Adjust the brightness, contrast, saturation, and chroma of the video
for video enhancement.

Digital Zoom

Click it, and then click and hold the video image to zoom in on the
image. Right-click the image, and then select Digital Zoom again to
exit zooming in.

Window Mode

Divide one window into 2 (1+1 mode), 4 (1+3 mode), and 6 (1+5
mode). One window will play the real-time video, and the others play
different defined areas of the real-time video.

If a device supports target tracking, you can enable this function in
any window mode, the windows that play defined areas of the real-
time video will follow the target when detected, until it disappears.

Al Overlay

Displays rule lines, bounding box on targets, and detection area for
intelligent rules, except for motion detection. After enabled, the
configuration will be saved, and only works on the current channel in
the live view and playback.

[

Al overlay information is not displayed by default.

SMD Overlay

Displays the bounding box on targets. After enabled, the
configuration will be saved, and only works on the current channel in
the live view and playback.

Disable Privacy Masking

For a camera that supports privacy masking of human face, you can
disable the masking here to view the face image.

Alarm Output Control

Turn on or turn off alarm output channels.

Audio and Light Control

You can turn on or off the audio and light channels one by one or at
the same time.

Device Intercom

For channels added through NVR, XVR/DVR, IVSS or EVS, you can
select this option to talk to the NVR, XVR/DVR, IVSS or EVS.

Add to Favorite

You can add the active channel or all channels into Favorite.

Set as Alarm Window

When selecting open alarm linkage video In Preview (in live window)
from Local Settings > Alarm, then the video will be displayed on the
window which is set to alarm window. If multiple alarms are triggered,
the video linked to the latest alarm will be opened. If the number of
alarm windows is fewer than the number of linkage videos, the video
linked to the earliest-triggered alarm will be opened. After enabling
Set as Alarm Window, the window frame is displayed in red.
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Parameters Description

[

This function is available on fisheye cameras only. When changing the
video stream, the fisheye view mode will maintain the current
configuration.

Fisheye View According to different installation methods, the fisheye view can be
varied.

¢ In-ceiling mount: 1P+1, 2P, 1+2, 1+3, 1+4, 1P+6, 1+8.
¢ Wall mount: 1P, 1P+3, 1P+4, 1P+8.
¢ Ground mount: 1P+1, 2P, 1+3, 1+4, 1P+6, 1+8.

® To view real-time temperature of a point on the thermal camera view, hover over that
point.

Figure 5-6 View temperature

® dx & W @A

PR S E B B RS A

®31.7000°C

® |f a channel supports electronic focus, you can enable electronic focus for it on the
platform to adjust video definition and size.

The page might vary according to the lens types of cameras. Lens types include
embedded zoom lens and external CS electronic lens. The following figure is for
reference only.
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Figure 5-7 Live view

Table 5-4 Description

Parameters

Description

Zoom +/- (for
embedded zoom lens)

Zoom in/out.

Click or click and hold E or @ or drag the slider - to the left or right
to zoom in/out.

Focus +/-

Adjust camera focus to achieve the best video definition.

Click or click and hold E or ﬁ, or drag the slider - to the left or right
to adjust focus.

Auto Focusing (for
embedded zoom lens)

ABF (auto back
focusing, for external CS
electronic lens)

Adjust image definition automatically.

L1

Other focusing operations are unavailable during auto focusing.

Reset

When image definition is imperfect, or after many times of zooming or
focusing operations, you can click Reset to reset the lens, so as to
eliminate lens deviation.

® Tour

On the live view page, right-click a device or node, select Tour, and then select an
interval. The channels under this device or node will be played in turn at the pre-
defined interval. You can also customize the interval.
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Figure 5-8 Start tour

Tour >

Drevice Config

1min
2min
Smin
10min

Customize

¢ To view remaining time of a channel during tour, check & cocz |
¢ To pause, click .
¢ To exit tour play, click .

® Region of interest (Rol)

A window can be divided into 4 or 6 regions during live view. One area is used to play
live video and other regions are used to zoom in regional image.

On the live view page, right-click the window, select Window Mode, and then select a
mode. For example, select a 1+3 mode.

L1

To exit the Window Mode, right-click the window and then select .
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Figure 5-9 Split mode

elect Audio Input
Start Remote Recording
Continuous Snapshot
Stream Type

Play Mode

Video Adjustment

Digital Zoom
Window Mode
Stop Image Owerlay
Al Overlay

SMD Owverlay

Add to Favorites

Set as Alarm Window

Figure 5-10 1+3 mode

® \/iew real-time events.

Click Elto open the event panel, which displays the real-time alarm events of opened
channels.

<
<&

Click the event type on the top of the event panel to view the corresponding event.
Click event record to view the snapshot. Video playback is also supported.
Operations related to different events might be different.

[@: Refreshes events in real time. [ Stops refreshing.
Click Eto clear the events in the event panel.

Click & to quickly view the latest events.
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© : View the recorded video of the event.
© E: Go to DeepXplore to search for the target.

o &L This function is only available when a license plate is recognized. Click this icon
to add the vehicle to an arming group. After you send the group to devices and
configure an event, devices can trigger alarms when the vehicle is recognized.

© : Add the vehicle to the platform.
© : Add the person to the platform.

© E; Add the face to an arming group. After you send the group to devices and
configure an event, devices can trigger alarms when the face is recognized.

® Remotely unlock the door.

When viewing the access control channel, you can remotely control the status of the
door on the upper-right corner: Normally open (1) normally closed (), or normal

status (B). You need to enter the login password of the current user before operation.
Restore the door to normal status first, and then the door can be opened and closed
according to defined period or through face recognition.

In the video window of the access control channel, you can remotely lock or unlock
the door.

Figure 5-11 Lock/unlock the door

® \/ideo intercom.

When viewing the video intercom channel, you can answer or hang up the call.
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Figure 5-12 Video intercom

5.1.2.1.1 Selecting and Searching for Target Manually

Manually select a target in the video and quickly search for it in DeepXplore.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EH, and then select Monitoring
Center > Monitoring.

Step2  Double-click or drag a channel to a window on the right.

Step3  Click 528 on the upper-right corner.

Step4 Dragon the video to select a target.

o=
Right-click to exit this function.
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Figure 5-13 Select a target

Step5 (Optional) Adjust the area of selection.

® Drag @to move the area to any location.

® Drag & to resize the area.

-
Step6  Click @ and select a type for the target, and then you are directed to DeepXplore to
search for it. For details, see "5.3 DeepXplore".

5.1.2.1.2 AcuPick

The platform can automatically recognize different types of targets in the video. You can select a
target and then quickly search for it in DeepXplore.

Prerequisites

1. Purchase a license with the AcuPick function, and then activate the license. For details, see "2.1.6
Licensing".

2. Configure the parameters of AcuPick. For details, see "7.4.4 AcuPick".

3. Configure the identity certificate and secret key in the AcuPick service in the management tool.
For details, see "2.1.4 Management Tool".

Procedure
Step1 Login to the DSS Client. On the Home page, click 8, and then select Monitoring
Center > Monitoring.
Step2  Double-click or drag a channel to a window on the right.
Step3  Click B4 on the bottom of the page to automatically recognize targets in the video,

including faces, human bodies, and vehicles.
©=a

Click to exit this function.
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Figure 5-14 Automatically recognize targets

r
Step4  Click L.] of a target to search for it in DeepXplore. For details, see "5.3 DeepXplore".
[1]

If certain targets are not recognized, you can click 223 to manually select one. For details,
see "5.1.2.1.1 Selecting and Searching for Target Manually".

5.1.2.2 View

The current layout and resources can be saved as a view to be quickly played next time.

Views can be categorized as public views and private views. Only administrators are allowed to
configure public views, and the users specified by them can access certain public views. Private
views are configured and owned by users themselves. They can share private views with other
users.

Views are categorized into different groups, which include three levels: First-level root node,
second-level grouping and third-level view. Tour is supported for first-level root node and second-
level grouping. The tour time can be 10 seconds, 30 seconds, 1 minutes, 2 minutes, 5 minutes, 10
minutes, or customized (5 seconds-120 minutes). You can create up to 1000 views.

5.1.2.2.1 Creating a Public View Group

Public view groups are used to organize public views. There is the default root group of the Public
View. You can only create one level of sub groups. Only administrators are allowed to create public
view groups.

Background Information

By default, all users are allowed to access Public View and its views. If you want to control access,
create groups that can be accessed by specified roles and their users, and save views to the groups.
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Procedure

Step1 Login to the DSS Client. On the Home page, click HH, and then click Monitoring
Center > Monitoring.

Step2  Click View.

Step3  Right-click Public View, and then select Create View Group.

Step4  Enter a name for the group, and then select the roles that are allowed to access this
group.
Click @3 to view the users of a selected role.

Step5 Click OK.

5.1.2.2.2 Creating a Private View Group

Private view groups are used to organize private views. There is the default group of the Private
View. You can only create one level of sub groups. Private views are configured and owned by users
themselves. They can share private views with other users.

Procedure
Step1 Login tothe DSS Client. On the Home page, click 8, and then click Monitoring
Center > Monitoring.
Step2  Click View.
Step3  Right-click Private View , and then select Create View Group.
Step4  Enter a name for the group, and then click OK.

5.1.2.2.3 Creating a View

Views are categorized into public or private view groups. They are used to quickly apply different
resources and settings. For example, a view can contain the configurations of multiple live video,
split mode, alarm windows, and more. When you open the view, these configurations will be
applied at the same time, and you do not need to configure them again.

Procedure

tep1 Loginto the DSS Client. On the Home page, click B, and then click Monitoring
Center > Monitoring.

:

Step2 Configure the split mode, and then drag channels, maps, and the browser to the
windows.
Step3  Click E on the upper-right corner to save the current layout.
Step4  Configure the parameters, and then click OK.
Table 5-5 Parameter description
Parameter Description

Select a type for the view. Only administrators can create a public view.
View Type [
If the view is saved to Public View, all users can access it.

View Name Enter a name for the view. It can be the same as other groups or views.

View Group Select a group for the view based on its type.
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5.1.2.2.4 Updating a View

When you need to change the resources or settings in a view, you can update them directly
without creating a view.

Procedure

Step1 Login to the DSS Client. On the Home page, click HH, and then click Monitoring
Center > Monitoring.

Step2  Click View.

Step3  Double-click or drag a view to a window to open it.

Step4  Change the resources or settings, such as the split mode, number of channels and alarm
windows, and the locations of the channels.

Step5  Click E on the upper-right corner to update the view.

5.1.2.2.5 Viewing a View

® |ijveview

Double-click or drag a view to a window to view its resources.
® Tour

Right-click a view group, select Tour and set the tour period.

¢ To view remaining time for a view, check =3
¢ To pause, click (o}

o To exit tour, click &,
5.1.2.2.6 Sharing a Private View

Privates views can be shared with other users.

Procedure
Step1 Login tothe DSS Client. On the Home page, click B, and then click Monitoring
Center > Monitoring.
Step2 Click View.
Step3  Right-click a view, and then select Share View.
Step4  Select a user and enter a message in remarks, and then click OK.

The view will be saved to Private View of the user.
1]

It will fail to share if the user's view groups or views reach the limit. You can share again
after the user deletes a group or view.

5.1.2.2.7 Related Operations

® Change the group a view belongs to

Drag a view to other groups. You can only do so for private views. You cannot drag a private
view to a public view group, or a public view to a private view group.
® \iew the details of a public view group or a view
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Right-click a public view group, and then select View Details to check the roles and users that
are allowed to access it.

Right-click a public view group, and then select Resources Details to check the information of
the channels, including the name, type, and organization.
® Edit the information of a public view group

Right-click a public view group, and then select Edit to change its name and the roles and users
that are allowed to access it.

® Rename aview

Right-click a view, and then select Rename to change its name.
® Delete a group or view

Right-click a group or view, and then select Delete to delete it. If there are multiple views in the
group, they will also be deleted.

5.1.2.3 Favorites

Add frequently used channels to favorites so that you can quickly locate and use them. You can also
share your favorites with other users.

5.1.2.3.1 Creating Favorites Folder

Each user can create up to 999 favorites folders. The number of channels in all favorites folders can

be up to 2,000.
Procedure
Step1 Login to the DSS Client. On the Home page, click HH, and then select Monitoring.
Step2  Click Favorites.
Step3  Click afolder and click [:, or right-click a folder and select Add a Favorites.
Step4 Select a parent node, enter a name for the folder, select the channels to be added to the

folder, and then click OK.

The favorites folder is added as a sub folder under the parent node you selected. The
maximum level of a favorites folder can be up to 10.

5.1.2.3.2 Editing or Deleting Favorites Folder

Log in to the DSS Client. On the Home page, click HH, and then select Monitoring > Favorites.

® Edit a folder: Click a folder and click , or right-click a folder and select Edit, and then you can
edit the name and channels of the folder.

® Delete afolder: Click a folder and click E, or right-click a folder and select Delete, and then you
can delete the folder, its sub folders and all channels.

You can also right-click a channel and select Delete to remove it from a folder.
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5.1.2.3.3 Sharing Favorites Folder

You can share a folder and its channels with other users. For permission control, if users have
permission to access certain channels, or do not have any permission to access the channels, they
will receive a folder with only the channels they have permission to, or an empty folder.

Procedure

Step1 Login tothe DSS Client. On the Home page, click HH, and then select Monitoring.
Step2 Click Favorites.

Step3  Right-click a folder, and then select Share the Favorites.

Step4  Select one or more users, and then click OK.

The folder, its sub folders, and all the channels will be shared with the users you selected.
But if any of the follow situation occurs with the users you are sharing with, this operation
will fail:

® They have more than 999 folders.
® They have 2,000 channels in all folders.
® The levels of their folders have reached 10.

5.1.2.3.4 Viewing Favorites Folder

® |iveview

On the Monitoring page, and then click Favorites to open list of favorites folders. Double-click
or drag a folder or channel to the window on the right to view live videos.
® Tour

On the Monitoring page, and then click Favorites to open list of favorites folders. Right-click a
folder and select Tour, and then select a duration. The platform plays live videos of all the
channels in the folder and its sub folders in a loop.

¢ To view remaining time of a channel during tour, click {000 |
o To pause, click B,
o To exit tour play, click &,

5.1.2.4 PTZ

Operate PTZ cameras during live view on the DSS Client.
5.1.2.4.1 Configuring Preset

A preset is a set of parameters involving PTZ direction and focus. By calling a preset, you can quickly
rotate the camera to the pre-defined position.

Procedure

Step1  Onthe Monitoring Center page, open the video of a PTZ camera.
step2  Click INESH
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Figure 5-15 Go to PTZ control panel

« ® E\? 00:01

Step3  Click[s.
Step4 Add a preset.
1. Rotate the PTZ camera to a specific point.
2. Click E enter the preset name, and then click v

Related Operations

Call a preset: Click[H of a specific preset, and then camera will rotate to the related position.
5.1.2.4.2 Configuring Tour

Set the tour parameters so that a camera can go back and forth among different presets. Set tour to
enable camera to automatically go back and forth between different presets.

Prerequisites
You have added at least 2 presets.
Procedure

Step1  Onthe Monitoring Center page, open the video of a PTZ camera.
Step2  Click INESN.
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Figure 5-16 Go to PTZ control panel

« ® E\? 00:01

Step3  Click &

Step4  Click .
Step5 Add tours.

1. Enter tour name, and click -+

2. Select a preset from the drop-down list on the left.
3. Repeat the previous 2 steps to add more presets.
4. Click OK.

Related Operations

To start tour, click B, then camera goes back and forth among the presets.

5.1.2.4.3 Configuring Pattern

A pattern is a record of a consecutive series of PTZ operations. You can select a pattern to repeat

the corresponding operations quickly. See pattern configuration instructions as follows.
Procedure

Step1  Onthe Monitoring Center page, open the video of a PTZ camera.

Step2  Click IHESM.
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Figure 5-17 Go to PTZ control panel

« ® E\? 00:01

Step3  Click .
Step4  Click B and then operate the 8 PTZ buttons of PTZ to set pattern.
Step5 Click B
Related Operations
Call pattern: Click [ and then the camera will automatically repeat the pattern that you have
configured.

5.1.2.4.4 Configuring Scan

The camera automatically scans horizontally at a certain speed.
Procedure

Step1  Onthe Monitoring Center page, open the video of a PTZ camera.
step2  Click IES.
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Figure 5-18 Go to PTZ control panel

« ® E\? 00:01

Step3  Click B

Step4  Click PTZ button, and rotate PTZ to the left to a position, and then click & to set the left
boundary.

Step5 Continue to rotate PTZ to the right to a position, and then click B to set the right
boundary.

Step6  Click [ to start scanning, then PTZ will rotate back and forth automatically within the
two boundaries.

5.1.2.4.5 Enabling/Disabling Pan

On the Monitoring Center page, open the video of a PTZ camera. Click BE and then click B, PTZ
rotates 360° at a specified speed. Click Bto stop camera rotation.

5.1.2.4.6 Enabling/Disabling Wiper

Enable/disable the PTZ camera wiper. Make sure that the camera supports wiper function.
On the Monitoring Center page, open the video of a PTZ camera. Click BX and then click & to
turn on wiper. Click E to turn off wiper.

5.1.2.4.7 Enabling/Disabling Light

Turn on/off camera light. Make sure that the camera supports light.

On the Monitoring Center page, open the video of a PTZ camera. Click BB and then click & to
turn on light. After enabling light, clickE to turn off light.
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5.1.2.4.8 Configuring Custom Command

Procedure
Step1  Onthe Monitoring Center page, open the video of a PTZ camera.
Step2  Click —1

Figure 5-19 Go to PTZ control panel

d ® 4&yoonm
Step3  Enter your command in the Command box.

Figure 5-20 Custom command

Command

Step4  Click B to show the command functions.

5.1.2.4.9 PTZ Menu

Procedure
Step1  Onthe Monitoring Center page, open the video of a PTZ camera.
Step2  Click INESH.
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Figure 5-21 Go to PTZ control panel

€« ® 4&yooon

Step3  Click B

Step4  Click I,
Step5  Use the panel to go to the menu configuration page.
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Figure 5-22 Go to PTZ menu configuration page

AP KA
FE UK R

| R

Command

PTZMenu

Table 5-6 PTZ menu description

Parameters Description

LA Up/down.

(<1} Left/right. Point to set parameters.

B Click Il to enable PTZ menu function. System displays main menu on the
monitor window.

o] Click B8 to close PTZ menu function.

It is the confirm button. It has the following functions.

® |f the main menu has the sub-menu, click OK to enter the sub-menu.
® Point to Back and then click OK to go to go back to the previous menu.
® Point to Exit and then click OK to exit the menu.

o
=

Point to Camera and then click OK to enter camera settings sub-menu page.
Camera Set camera parameters. It includes picture, exposure, backlight, day/night
mode, focus and zoom, defog, and default.

Point to PTZ and then click OK to go to PTZ sub-menu page. Set PTZ functions.

PTZ It includes preset, tour, scan, pattern, rotation, PTZ restart, and more.
Point to System and then click OK to go to system sub-menu page. Set PTZ
System simulator, restore camera default settings, video camera software version and
PTZ version.
Return Point to the Return and then click OK to go back to the previous menu.
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Parameters Description

Exit Point to the Exit and then click OK to exit PTZ menu.

5.1.2.5 Fisheye-PTZ Smart Track

Link a PTZ camera to a fisheye camera so that when the fisheye camera detects a target, the PTZ
camera automatically rotates to it and track.

5.1.2.5.1 Preparations

Make sure the following preparations have been completed:

® Fisheye camera and PTZ camera are well deployed. For details, see corresponding user's
manuals.
® Basic configurations of the platform have been finished. For details, see "3 Basic Configurations".

¢ When adding cameras, select Encoder from Device Category.

¢ Features of fisheye camera is set to Fisheye. For details, see "3.1.2.5.2 Modifying Device
Information"”.

Figure 5-23 Set fisheye camera features

9 All Device

- . . Channel Number:
:= Basic Info
1

Channel Name Camera Type Features KeyBoard Code

& Alarm Input Channel = Fixed Camera Fisheye

N - ~
& Alarm Output Channel

-
H POSChannel

5.1.2.5.2 Configuring Fisheye-PTZ Smart Track

Procedure
Step1 Login tothe DSS Client. On the Home page, click 8, and then click Monitoring Center.
Step2  Click =
Step3 Inthe device tree on the left, right-click a fisheye camera, and then select Modify Smart
Track.
Step4  Click K next to Please select a PTZ camera to link, and then select a PTZ camera.
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Figure 5-24 Set smart track rules (1)

Fisheye-PTZ Config

Fisheye ecta PTZ camerato link

Cancel

Step5  Click and then move the B of the fisheye on the left to select a position. Click @ of
the PTZ camera to find the position. Adjust the PTZ camera to find the position and move
the PTZ to the center position (The green cross on the image).
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Figure 5-25 Set smart track rules (2)

Fisheye-PTZ Config

Fisheye Please select a PTZ camera to link PPTZCamera

PAZz37 a1

Fisheye point 5D point SDzoomrati... Operation
[]
[]

-
]

Cancel

® Select 3-8 mark points on fisheye camera.

® When you find mark point on the right side of the PTZ camera, click & to zoom out
PTZ.

® (Click B4 to 3D position, and when you click a certain point on the left side of PTZ
camera, it will automatically move to the center.

Step6  Click K4 to save the calibration point.

See above steps to add at least three calibration points. These three points shall not be on
the same straight line.

Step7  Click Save.

5.1.2.5.3 Applying Fisheye-PTZ Smart Track

Procedure

Step1  Login to the DSS Client. On the Monitoring Center page, select the fisheye camera on
the device tree and then right-click to select Smart Track.
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Figure 5-26 Select a smart track channel

o
:
B
2 89 e
-

CH |pC
CH 95 177

M

9 Add to Favorite
LM camera2 Smart Track

S IP PTZ Camer Modify Smart Track

Step2 Click any point on the left of fisheye, PTZ camera on the right will automatically rotate to
corresponding position.

5.1.3 Playback

Play back recorded videos.

5.1.3.1 Page Description

Log in to the DSS Client. On the Home page, click E, and then click Monitoring. Click the
Playback tab.

Figure 5-27 Playback page

Table 5-7 Function description

Icon Description

Filter video according to record type.
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Icon Description

Lock the video stored to the server within some period of designated
channel. Locked video will not be overwritten when disk is full.

D

<

Select and download a duration of video on the progress bar.

[-]
o

Download the video.

Make dynamic detection analysis over some area of the record image,
and it only plays back the video with dynamic image in the detection
area.

Manually select a target in the video and quickly search for it in
DeepXplore.

Automatically recognize different types of targets in the video. You can
select a target and then quickly search for it in DeepXplore.

Play multiple recorded videos from the same time. For example, you are
playing recorded videos from 3 channels at the same time. Select
channels, configure when you want to play the recorded video from,
and then click this icon. All 3 channels will play recorded videos from the
same time.

Play the video backwards or forwards.

Stop/pause the video.

Play back or forward frame by frame. Click and hold to play
continuously.

Eigﬂﬂﬂlﬂ

Fast forward or slow down the video to up to 64 times. When playing a
a4 Ix » video backwards or forwards alternately, the play speed will not be
changed.

During playback, you can drag time progress bar to play back record at
the specific time.

Select the storage location of the video to be searched. Supports
searching for the video on the platform server or storage device.

m Tag records.

- o Lock records.

5.1.3.2 Playing Back Video

Procedure
Step1 Loginto the DSS Client. On the Home page, click E, and then select Monitoring
Center.
Step2  Click the Playback tab.
Step3  Double-click or drag a channel to a window on the right.
Step4  Select the storage path of recorded video from km——— , and then click [ to

select the date.
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o=

® Dates with blue dots means there are videos.

® After selecting a date, the platform will search for videos on that date from other
channels. If you switch to the Live View page, or close the page or the PC client, the
date will be reset.

Step5 Click o play the video.
Step6 Hover over the video, and then the icons appear. You can perform the following actions.

Figure 5-28 Video playback

Table 5-8 Function description

Icon Name Description
T Take a recording on | Click this icon to start recording. The recorded video is stored
the device locally. The saving path is C\DSS\DSS Client\Record\ by default.
Take a snapshot on | Take a snapshot of the current image and save it locally. The
the device saving path is C:ADSS\DSS Client\Picture\by default.
E Close Close the window.
If the device has been marked on the map, click the icon to
Map location open the map in a new window to display map location of the
device.

Capture the target in the playback window. Click & to select
the search method, and then the system goes to the page with
search results. More operations:

5

Search by snapshot
L] EE: Move the selection area.

L] ﬁ: Adjust the size of the selection area.
® Right-click to exit search by snapshot.

Tag Tag the videos of interest for easy search in the future.

Right-click the video, and then you can perform the following actions.
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Figure 5-29 Shortcut menu

¥ Continuous Snapshot

\djustment

Table 5-9 Description

Parameters

Description

Select Audio Input

If the camera has more than one audio input channels, you can select
one or select the mixed audio. This configuration is effective with both
live view and playback.

Continuous Snapshot

Take snapshots of the current image (three snapshots each time by
default). The snapshots are saved to ..\DSS\DSS Client\Picture by
default. To change the snapshot saving path, see "8.3.5 Configure File
Storage Settings".

Video Adjustment

Adjust the brightness, contrast, saturation, and chroma of the video
for video enhancement.

Digital Zoom

Click it, and then double-click the video image to zoom in the image.
Double-click the image again to exit zooming in.

Al Overlay

The client does not show rule lines over live video by default. When
needed, you can click Al Overlay and enable Rule Overlay and
Bounding Box Overlay, and then the live video shows rule lines if the
Al detection rules are enabled on the device. This configuration is
effective with the current selected channel both in live view and
playback.

SMD Overlay

Enable SMD Overlay to show target bounding box over live video.
When SMD is enabled on the device, you can enable SMD Overlay for
the device channel, and then the live video will display dynamic target
bounding boxes. This configuration is effective with the current
selected channel both in live view and playback.

Disable Privacy Masking

For a camera that supports privacy masking of human face, you can
disable the masking here to view the face image.

Playback on Video Wall

Play the video of the current channel on video wall. Make sure that
video wall is configured (see "5.1.5 Video Wall").
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Parameters

Description

Set as Alarm Window

When selecting open alarm linkage video In Preview (in live window)
from Local Settings > Alarm, then the video will be displayed on the
window which is set to alarm window. If multiple alarms are triggered,
the video linked to the latest alarm will be opened. If the number of
alarm windows is fewer than the number of linkage videos, the video
linked to the earliest-triggered alarm will be opened. After enabling
Set as Alarm Window, the window frame is displayed in red.

5.1.3.3 Locking Videos

Lock the video stored on the server within a period of a specific channel. The locked video will not
be overwritten when disk is full.

Procedure

w
Pg
D

—_

Center.

wn n
~+ |+
F%
w IN

wn
~
N

The search results are displayed.

L1

Dates with blue dot means there are video recordings.

te

:

Click the Playback tab.
Select a channel from the device tree, and then double-click it, or drag it to the window.

, and then cIick to

Select the storage path of recorded video from
select the date.

Log in to the DSS Client. On the Home page, click EE| and then select Monitoring

Select a window that has recorded video, and then cIickE on the bottom of the page,

and then click on the timeline to mark the start point and end point of the video clip you

need.
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Figure 5-30 Lock record

Lock Video

Start Time: 2

End Time: 2023-

04:00

Stored on Device iz 4 B Il M 4«

Step6  Confirm the start and end time, and then click OK.
Related Operations

Click"1 on the lower-right corner, and then all the recordings locked by the user currently logged
in to the client are displayed. Double-click one to quickly play the recording.

5.1.3.4 Tagging Videos

You can tag records of interest for quick search.

Procedure
Step1 Login to the DSS Client. On the Home page, click E, and then select Monitoring
Center.
Step2  Click the Playback tab.
Step3  Double-click or drag a channel to a window.
Step4  Select the storage path from . where the recorded videos are stored,

and then click to select the date.

The search results are displayed.

L1

Dates with blue dot means there are video recordings.
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Figure 5-31 Playback page

Step5  Point to the window, and then click .
Step6  Enter a name for the tag, and then click OK.

Related Operations

Click m on the lower-right corner to view all the tags in the current recorded video. Double-click a
tag to play the recorded video from the time of the tag. You can search for tags by their names.

5.1.3.5 Filtering Recording Type

Filter video according to record type, record type includes scheduled recording, alarm video,
motion detection video, and videos recorded in main or sub stream.

Procedure
Step1 Loginto the DSS Client. On the Home page, click EE| and then select Monitoring
Center.
Step2 Click the Playback tab.
Step3  Select a channel from the device tree, and then double-click it, or drag it to the window.
Step4  Click , select one or more types, and then click OK.

The platform only displays videos of the selected types in different colors on the timeline.
[L]

Filtering videos by video stream is only supported when you are viewing a video stored
on a device, and the search type of device video stream is set to main and sub streams.
For details, see "8.3.2 Configuring Video Settings".

5.1.3.6 Searching for Targets

When playing back a video, you can manually select a target, or select one automatically
recognized by AcuPick, and then search for it in DeepXplore.
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5.1.3.6.1 Selecting Target Manually

Manually select a target in the video and quickly search for it in DeepXplore.

Procedure

Log in to the DSS Client. On the Home page, click EH, and then select Monitoring
Center > Monitoring.

Double-click or drag a channel to a window on the right.

Select the storage path of recorded video from , and then click = to

select the date.
an)

Dates with blue dot means there are recordings.

Click (528 on the bottom of the page.
Drag on the video to select a target.
o=

Right-click to exit this function.
Figure 5-32 Select a target

Step 7

(Optional) Adjust the area of selection.

® Drag @to move the area to any location.

/,\1
® Drag =¥ to resize the area.

=
Click @ and select a type for the target, and then you are directed to DeepXplore to
search for it. For details, see "5.3 DeepXplore".
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5.1.3.6.2 AcuPick

The platform can automatically recognize different types of targets in the video. You can select a
target and then quickly search for it in DeepXplore.

Prerequisites

1. Purchase a license with the AcuPick function, and then activate the license. For details, see "2.1.6
Licensing".
2. Configure the parameters of AcuPick. For details, see "7.4.4 AcuPick".

Configure the identity certificate and secret key in the DSS Server. For details, see "2.1.4
Management Tool".

w

Procedure

Step1 Loginto the DSS Client. On the Home page, click B, and then select Monitoring
Center > Monitoring.

Step2  Double-click or drag a channel to a window on the right.
Step3  Select the storage path of recorded video from _, and then click ==l to

select the date.
1]

Dates with blue dot means there are recordings.

Step4  Click Bdon the bottom of the page to automatically recognize targets in the video,
including faces, human bodies, and vehicles.

w

Click "'] to exit this function.

Figure 5-33 Automatically recognize targets

%
A

r
Step5  Click L.] of a target to search for it in DeepXplore. For details, see "5.3 DeepXplore".
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If certain targets are not recognized, you can cIick@ to manually select one. For details,
see "5.1.2.1.1 Selecting and Searching for Target Manually".

5.1.3.7 Clipping Videos

Download a video by selecting a period on the timeline.

Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select Monitoring
Center.

Step2  Click the Playback tab.

Step3  Select a channel from the device tree, and then double-click it, or drag it to the window.

Step4  Select the storage path of videos from [ikm——. , and then click ] to select the
date.
The search results are displayed.
L]
Dates with blue dot means there are videos.

Step5  Select a date with video recordings, and then click .

Step6  On the timeline, click the point with green shade to start clipping, drag your mouse, and

then click again to stop.

Figure 5-34 Select a period

Stored on Device >~ YT A % & &

Step7  Enter the password and encryption password, and then click OK.

200



@/hua

User's Manual

L1

You need to verify your password by default before download. You can configure
whether to verify the password. For details, see "7.4.1 Configuring Security Parameters".

Step8 Configure the parameters of the video, and then click OK to start the download.

The video will be downloaded to the default path configured in the local settings. For
details, see "8.3.5 Configure File Storage Settings".

Table 5-10 Parameter description

Parameter Description
Start Time The start and end time represents the length of video you selected. You
End Time can adjust it more specifically here.
Transcode

The default format is .dav. You can select another format for the video.
File Format

Select Stream

Select a stream for the video. For the same period, the main stream
provides clearer image, but uses more disk space, while it is the opposite
for the sub stream.

Privacy Masking

If disabled, faces in the video will not be blurred.

5.1.3.8 Smart Search

With the smart search function, you can select a zone of interest on the video image to view motion
records within this section. The relevant camera is required to support Smart Search; otherwise the
search result will be empty.

Procedure

wn
Peg
D

—_

w0 [n
~ |~
D [
w IN

wn
—~+
B

Log in to the DSS Client. On the Home page, click EE| and then select Monitoring
Center.

Click the Playback tab.
Select a channel from the device tree, and then double-click it, or drag it to the window.

Select the storage path of recorded video from I , and then click [&] to
select the date.

The search results are displayed.

(1

Dates with blue dot means there are video recordings.
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Figure 5-35 Playback page

03100 04:00

2021-04-1

Store on Device

Step5  Select a window that has videos, click ., and then select a type.

The smart search page is displayed, with 22 x 18 squares in the window.
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Figure 5-36 Smart search

Step6 Click the squares and select detection areas.
[1]

® Select a detection area: Point to image, click and drag to select a square.
® For the selected area, click again or select square to cancel it.

Step7  Click @ to start smart search analysis.

® [f there are search results, the time progress bar will become purple and display
dynamic frame.

® |t will prompt that the device does not support smart search if the device you selected
does not support the function.

[

Click E to select the detection area again.
Step8  Click the play button on the image or control bar.

The system plays search results, which are marked purple on the timeline.

Step9  Click @ to exit smart search.

5.1.4 Map Applications

On the map, you can view real-time videos of devices, locations of channels that trigger alarms,
cancel alarms, and more.

Prerequisites

Make sure that you have configured a map. For details, see "4.2 Configuring Map".
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Procedure
Step1 Loginto the DSS Client, and on the Home page, select E > Monitoring Center > Map.
Step2 Inthelist of maps, click a map.
Step3  View video, cancel alarms, and more.

L1

The functions vary with the types of maps and devices. Slight differences might be found
in the actual page.
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Table 5-11 Function description

Function

Description

Group talk

You can engage in a group talk with MPT users. Only administrators are
allowed to use the group talk function.

1. Click =] next to the list of maps.

The default group includes all MPT users.

2. Click Add Group Talk.

3. Enter a name for the group, select MPT users, and then click OK.
w

Only MPT users are displayed. For how to configure an MPT user, see
"3.2.2 Adding User".

Selected (2)

Q  User Name User Type Operation

MPT user 1

4. Click the new group, and then click on the upper-right corner to
join the group. D indicates the group that you are in.

Group Talk

4 Add Group Talk B Emergency Response Team

@ Default Group(0/2 , MPTusera

B Emergency Response T.

5. (Optional) CIick and you can edit the users in the group.

The users removed from the group will return to Default Group.

6. Press the F2 key to talk to the users in the group, and then release the
key to stop talking.
[T

You can only talk to and hear the MPT users in the current group. If you

want to talk to and hear other users, you must clickm on the upper-
right corner to join that group.

Hide Device Name

Only displays the icons of devices or channels.
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Function Description

Rotate the wheel or click Il and = to zoom in and out on the map.
When zooming out on the map, the same type of devices or channels will
be merged together if they are near each other.

Zoom in and out on d
the map 5104 [y
:II'. N . KAMN
|
SANDUNZHEN = GONGSHI
Satellite Map If you are using an online map, you can view its satellite map.

T Click Pane, select devices on the map, and then click to view videos in
View live video

batches; or click B2l on the map, and then select to view videos.

Click Pane, select devices on the map, and then click ksl to view videos in
Playback

batches; or click B8l on the map, and then select to view videos.

View alarms CIickIto view all alarms that are triggered. Click an alarm and the map
will zoom in to the location of the device that triggered the alarm.

Alarms will be automatically canceled after 30 s.

Click a device on the map, and then select E
Cancel alarms

The alarm will also be automatically canceled after 30 s.

® The alarm area and detection area are displayed on the map by default.
If a target is detected, its real-time location will be displayed in these
areas.

® (lick a radar channel, you can view its information and use the
following functions:

© : View the raster map on the radar. You can use this function to
check if the maps on the radar and the platform are consistent.

Monitor a radar < : View the real-time videos of the linked PTZ cameras.

© @: Search for and view recordings of the linked PTZ cameras.

< : View the real-time videos of the channels bound to the radar.
You can use this function to monitor the area around the radar.

o : If the alarm area and detection area of the radar are keeping
you from operating other channels, you can click this icon to hide
these areas.
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Function

Description

Show devices

Select the types of devices and channels you want to display on the map.
@

You can click an alarm output channel to control whether it will output
alarm signals.

If a device supports visual area, click Visual Area and double-click a device
on the map to show its monitoring area.

Visual area 1]
This function is only available on GIS maps.
If a device supports initial angle, click Initial Angle and double-click a
device on the map to show the initial angle.

Initial angle [RA

This function is only available on GIS maps.

Measure distance

Select Box > Length, connect two points with a line on the map (double-
click to finish drawing), and then the distance between the points is
shown.

[

This function is only available on GIS maps.

Measure area

Select Box > Area, select a region on the map (double-click to finish
drawing), and then the area is measured.

This function is only available on GIS maps.

Clear To clear all markings on the map, click Clear.
Add marks Select Box > Add Mark, and then mark information on the map.
Reset Select Box > Reset to restore the map to its initial position and zoom
level.
Click 4o to view the information of the sub map.
Sub maps

Double-click [-'Eﬁ', and then the platform will go to the sub map, where you
can view the resources on it.

5.1.5 Video Wall

A video wall, which consists of multiple video screens, is used for displaying videos on the wall,
instead of small PC displays.

Complete video wall settings before you can view videos on the wall.
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5.1.5.1 Configuring Video Wall

5.1.5.1.1 Page Description

Before using the video wall function, you should get familiar with what you can do on the video
wall page.

0 000

Figure 5-37 Video wall

Video source has not been bound

Table 5-12 Page description

No.

Function Description

If you have selected Device and Channel in Local Settings >
General, the device tree will display all devices and their channels.
Otherwise, it will only display all channels.

Device tree Click Rl to view channels that you have saved to favorites.

You can enter keywords in _ to search

for the channels you want.

Live view View live videos from channels.
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No. Function Description
View the channel information in a screen of the video wall.
® (lick K% and view the live video of the channel in Live View on
the lower-left corner. This can be helpful when you need to make
sure whether it is the channel you want.
Detailed ® (lick m to adjust the order of channels.
3 information E
® (lick k=l to delete the channel from the screen.
® (lick Stay Duration (sec) or E to define the for how long the
live video of the channel will be displayed during each tour.
® (lick Stream or il to change the video stream of the channel.
4 Window split Select how you want the window to split.
5 Clear screen Clear all the screens.
6 Stop'pmg o Stop or start all tours.
starting all tours
If multiple screens in a video wall are configured to be a combined
7 Lock window screen, then you can perform video roaming on the window that has
been locked.
Display the real-time video, or a snapshot of the real-time video every
10 minutes of the bound channel in the screen.
8 Display mode
If nothing happens after operation, you can just click another screen,
then click the screen you want, and then it should work properly.
9 Turning on or off | Turn on or off the screens configured for the currently selected video
screens wall.
Decoding to wall
immediately When a task has been configured, the platform will immediately
10 .
after decode channels to the video wall.
configuration
11 Decoding to wall | Manually decode channels to the video wall.
12 Video wall Click to view the layout of the current video wall.
layout
13 V!deo wall The display area for video walls.
display area
14 Screen Includes stopping tour for the screen, muting, pasting, maximizing or
operations restoring the screen, and closing the screen.
15 Video wall plan | Configure a timed or tour plan for the video wall.
16 Vldeo'wall Select the video wall you want to configure.
selection
17 Display task Add, save, and delete tasks.
management
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5.1.5.1.2 Preparations

To display video on the wall, make sure that:

® Cameras, decoders and video wall are well deployed. For details, see the corresponding user's
manuals.

® Basic configurations of the platform have been finished. For details, see "3 Basic Configurations".
During configuration, make sure that:

¢ When adding a camera, select Encoder from Device Category.

¢ When adding a decoder, select Video Wall Control from Device Category.
5.1.5.1.3 Adding Video Wall

Add a video wall layout on the platform.
Procedure

Step1 Loginto the DSS Client, and on the Home page, select Monitoring Center > .
Step2 From the Video Wall drop-down list, select Add New Video Wall.
Step3  Enter Video Wall Name, and then select a window splicing mode.

Figure 5-38 Add a video wall

Add Video Wall

1. Select layout 1. Select layou2. Bind channel

Basic Info

Video Wall Plan Name:

123

Remarks:

0

- CIEHCEI

® Select a splicing mode fromamong 1 x 1,2 x 2,3 X 3,4 x 4 or set a custom mode by
clicking (1
® A multi-screen splicing mode is a combined screen by default. You can perform video

roaming on it. For example, with a 2x2 combined screen, if you close 3 of them, the
other one will be spread out on the combined screen. To cancel combination, click the

combined screen, and then click E
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® To create a combined screen, press and hold Ctrl, select multiple screens, and then
click .

® To clear the created screen, click .

Step4  Click Next Step.
Step5  Select the encoders which need to be bound in the device tree, and drag it to the
corresponding screen.

L1

® You can set whether to show ID in the screen, E22= means that the screen ID is
disabled; click the icon and it becomes EEESEE8, which means that screen ID is
enabled.

® Each screen in a combined screen must be bound with a decoding channel.

Step6  Click Finish.
5.1.5.1.4 Configuring Video Wall Display Tasks

Display videos on the wall manually or in accordance with the pre-defined configuration.
Procedure

Step1 Login tothe DSS Client, and on the Home page, select Monitoring Center > .
Step2 Inthe Task drop-down list, select Add.
Figure 5-39 Add a video wall task

2 video sources have been bound

View details in the list below

= S8 B R O & a Apply Now E=E]

Step3  From the device tree, select a camera, and then drag it to a screen, or select a window,
drag the camera to the Detail section.

If you do not close video wall display in advance, this action will delete the bound camera
and play the selected camera on the wall.

Step4  Click E
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If you have selected an existing task in the Task drop-down list, after dragging the video

channel to the window, click L4 to save it as a new task, which will be played on the wall
immediately.

Step5 Name the task, and then click OK.

® During video wall display of a task, if you have rebound the video channel, click @ to
start video wall display manual.

® During video wall display, click or@to stop or start tour display.

Step6 Click ﬂ to start video wall display.

5.1.5.1.5 Configuring Timed Plans

Procedure

Step1 Login tothe DSS Client, and on the Home page, select Monitoring Center > .
Step2  Click = on the upper-right corner.
Step3  Hoverover . and then select .
Figure 5-40 Set timed plan
Timed Plan-jhhjhh

Plan Name:

Start Time: End Time:
00:00:00 23:59:59 - -

Task Name Start Time End Time Operation

=

25 ) (]

Enable this Timed Plan in Remaining... - Cancel

Step4  Enter the plan name.
Step5 Select a video task, set start time and end time, and then click Add.

Repeat this step to add more tasks. The start time and the end time of tasks cannot be
repeated.
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Select the Enable This Timed Plan in Remaining Time check box, and then set the task.
The video wall displays the selected task during the remaining period.

Step6  Click Save.

Step7 Click - to start the plan.
(L1

You cannot display multiple plans on the wall at the same time. When a plan is enabled,
the previous plan on the wall is automatically terminated.

Figure 5-41 Enable timed plan

Video Wall Plan-51

® Modify plan: E’]

® Delete plan: ﬁ

5.1.5.1.6 Configuring Tour Plans

After setting video wall tasks, you can configure the sequence and interval of tasks so that they can
automatically play in turn on the wall.

Procedure

Step1 Loginto the DSS Client, and on the Home page, select Monitoring Center > .

Step2  Click &2 on the upper-right corner.

Step3  Hoverover ., and then select .
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Figure 5-42 Tour plan

Tour Plan-51

Plan Name:

Plan 2

Stay Time:

20 Minute

Task Name Stay Time(min) Operation

Task 1 O + 3+ 8

Task 2 0 + 4+ B

- Cancel
Step4  Enter task name, select a video task and then set stay time. Click Add.

Repeat this step to add more tasks.

L1

Click I to adjust task sequence; click E to delete a task.

Figure 5-43 Tour information

Step5 Click Save.

Step6  Click - to start the tour plan.
11

You cannot display multiple plans on the wall at the same time. When a plan is enabled,
the previous plan on the wall is automatically terminated.

Figure 5-44 Enable tour plan

Video Wall Plan -51

® Modify plan: Click E’]
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® Delete plan: Click a

5.1.5.2 Video Wall Applications

B

Make sure that decoder video ports are connected to the video wall screens.
5.1.5.2.1 Instant Display

Drag a camera to the video wall screen for instant display on the wall.

The video wall display task is configured. For details, see "5.1.5.1.4 Configuring Video Wall Display

Tasks".
Procedure
Step1 Loginto the DSS Client, and on the Home page, select Monitoring Center > 1.
Step2 Inthe Video Wall drop-down list, select a video wall.
Step3  Click ESHESEM to start video wall display.
Step4 Drag a camera from the device tree to a screen, or select a window and drag the camera

to the Detail section.

® A window can be bound to multiple video channels.
® The binding mode, which includes Tour, Tile, and Inquiry, can be set in Local
Settings > Video Wall. For details, see "8.3.3 Configuring Video Wall Settings".

® For afisheye camera, right-click it to select the installation mode for fisheye
dewarping.
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Figure 5-45 Bind video channel

3 video sources have been

bound Video channel not bound
View details in the list below

Video channel not bound Video channel not bound

EEH L o (=) &
Window Channel Stay Time(s) 4 Stream
ChannelQasfdfdas... 15 Main Stream
IP PTZ Camera 15 Main Stream

10001 15 Main Stream

Step5  Select ascreen, and then click Detail to view detailed information about the screen and
channel, including stream type, preset and display sequence.

® (lick E to view live video of the current channel on the lower left.

® (lick m to adjust sequence.
® (lick E to delete the video channel on the current window.

5.1.5.2.2 Video Wall Task Display

Display a pre-defined task on video wall.
Procedure

Step1 Login tothe DSS Client, and on the Home page, select Tools > Video Wall.
Step In the Task drop-down list, select a task.
Step Operations available.

w N

® After changing the video channel that is being displayed, cIick@ at the lower-right
corner before you can see the effect on video wall.

® (lick to pause or stop.

® Select a screen, and then click Detail to view detailed information about the screen
and channel, including stream type, preset and display sequence.
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5.1.5.2.3 Video Wall Plan Display

Display a pre-defined plan on video wall.
L]
Make sure that there are pre-defined plans.

The video wall automatically works as the plans have been configured. To stop the current plan,

click Il on the upper-right corner of the Video Wall page, and then it changes to B click B to start
displaying video on wall again.

Figure 5-46 Display video wall plan

Task:  Task1 \ Vall Plan: | Tour:Plan 1

4 video sources have been

bound Video channel not bound
View details in the list below

? Desil e [/ a & Apply Now
MNo.

Window Channel Stay Time(s) ’ Stream s Preset Point Operation

5.1.6 UVSS

The results for scans of the underside of vehicles can be viewed after the scan is processed by the
Under Vehicle Scanning System (UVSS). The results of scans from UVSS devices can also be
searched for.

Before using this function, complete the following configurations.

® Add UVSS devices to the platform. For details, see "3.1.2.4 Adding Devices".
11

el

You can only add UVSS devices to the platform by using their IPv4 addresses.

® (Configure an Images and Files disk so that the platform can store and display scanning images.
For details, see "3.3 Configuring Storage".

® |f you need to view live videos related to UVSS devices, bind UVSS channels to video channels
first. For details, see "3.1.3 Binding Resources".
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5.1.6.1 Monitoring Real-time Information

View the results of scans from UVSS devices in real time, and live videos from bound video
channels.

Procedure

Step1 Login to the DSS Client, and then on the Home page, select E > Monitoring Center >
UVSS > UVSS Monitoring.

Step2 View real-time information.
® |mages from real-time scans.

Double-click or drag a UVSS channel to a window. After the channel takes a snapshot,
the platform will automatically obtain and display it in the window.
® View live videos from bound video channels.

1. Double-click or drag a UVSS channel to a window.

After the channel takes a snapshot, the platform will automatically obtain and
display it in the window.

2. Click the list on the lower-right corner of the window, and then select a video
channel.

The live video from the video channel is displayed in the window.

Figure 5-47 Bound channels

Step3 Click B of the result of a scan to view its details.

If ITC cameras have been linked to the UVSS channel in the UVSS system, the platform will
automatically obtain and display snapshots of the vehicle.

5.1.6.2 Information Search

Search for results of scans.
Procedure

Step1 Login to the DSS Client, and then on the Home page, select E > Monitoring Center >
UVSS > Information Search.

Step2 Select one or more UVSS channels, configure the search conditions, and then click
Search.

® Plate No.: Search for the results of scans related to plate numbers.
® Time: Search for the results of scans within a period.
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Step3 Click B or double-click the result of a scan to view its details.

If ITC cameras have been linked to the UVSS channel in the UVSS system, the platform will
automatically obtain and display snapshots of the vehicle.

5.2 Event Center

When alarms are triggered, you will receive notifications on real-time alarms. You can view their
details, such as snapshots and recordings, and process them. If you miss alarms occurred during a
certain period, or want to check certain alarms, such as high priority alarms occurred in the past day
or all alarms that have not been processed in the past week, you can set the search conditions
accordingly and search for these alarms. Based on all the alarms that were triggered, the platform
will generate statistics ready for your review. This can be helpful for how you can optimize your
security measures.

Make sure that you have configured and enabled alarm events. To configure, see "4.1 Configuring
Events".

5.2.1 Real-time Alarms

View and process real-time alarms.
Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select Event Center.
step2  Click P\,
L]

The alarm list is refreshed in real time. To stop refreshing, click Pause Refresh . To
continue receiving alarms, click Start Refresh.

Figure 5-48 Real-time alarms

Step3 Click M to claim an alarm.

After an alarm has been claimed, the username of your account will be displayed under
the Processed by column.

Step4  Process alarms.
1]

You can use the up and down arrow keys on the keyboard to quickly select other alarms.

1. Click [ or double-click the alarm.
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Figure 5-49 Alarm details

Soft Trigger-222

© 2 O Soft Trigger-222

Soft Trigger-222
2029-10-12 02:15:30

Soft Trigger-222

Forward

m

Processing Comments:

111

2. The middle area displays the time when the alarm was triggered, name and location of
the alarm source, alarm type, and the live video images of linked channels, alarm
videos, and alarm snapshots.

Double-click a window to view them in larger size. Click H to go back.

Figure 5-50 Alarm linkage media

3. On theright side, select how to process the alarm, enter some comments, and then
click OK.

Forward allows you to forward the alarm to another user who will process it.

4. (Optional) CIick@ to disarm the alarm. This alarm will not be triggered within the
defined period.
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5. (Optional) CIick@ to send the alarm information to other users as an email. Events
that are processed or forwarded can also be sent as emails.

Figure 5-51 Send email

Send Email

Select All Addr

Subject:

Body:

Event Time Ewvent Type Ewvent Source

Cancel

6. Click E] and configure the parameters related to the processing comments, and then
click OK.

® Require Processing Remarks to be Entered : After enabled, users must enter
some content in the processing comments to successfully process alarms.

® Pre-processing Remarks : Configure the predefined comments for each
processing status. The content will be automatically filled in when users select
different status for alarms.

Related Operations

® The platform also supports processing alarms in batches. Click Batch Process, select multiple
alarms, and then you can process them in batches.

® When viewing the recorded videos, you can select a target manually or select one automatically
recognized by AcuPick, and then search for it in DeepXplore.

5.2.2 History Alarms

Search for and process history alarms.
Procedure

Step1 Loginto the DSS Client. On the Home page, click E, and then select Event Center.

Step2  Click G,
Step3  Set search conditions, and then click Search.
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Figure 5-52 History alarms

Batch Process

AlarmTime  +  Alarm Category  Alarm Type Alarm Source Remarks Processed by Alarm Status Operation T

04-07 1 Soft Trigger Pending

Priority
. Low
[low
[Low |
[
[low |
Clow
[low
[Low |
[ow
[low |
Clow
[low
[Low |
[
[low |
Clow
[l
[Low |
[
.
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Step4  Claim and process alarms. For details, see "5.2.1 Real-time Alarms".

L]
You can use the up and down arrow keys on the keyboard to quickly select other alarms.

Related Operations

When viewing the recorded videos and snapshots, you can select a target manually or select one
automatically recognized by AcuPick, and then search for it in DeepXplore.

5.2.3 Event Statistics

With alarms being triggered and processed, statistics are generated to give you a clear picture of
what is happening in your area, such as the number of alarms that were processed, and the type of
alarms that are triggered most frequently.

Log in to the DSS Client. On the Home page, click B, and then select Event Center.

® To view event overview, click (m)
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Figure 5-53 Alarm overview

Daily

Weekly ~ Monthly

=
N

v Org CurrentSite

Processing g I

1

v Refresh Frequency

Not Processed

Top 10 Alarm Sources and Alarm Types

B Only Count

1PC1

Table 5-13 Alarm overview description

No.

Parameter

Description

Search
conditions

¢ To view real-time alarm overview, click Real Time, select a
site (if any), an organization, and refresh frequency.

¢ To view daily alarm overview, click Daily, configure the time,
select a site, an organization, and then click Search.

¢ To view weekly alarm overview, click Weekly , configure the
time, select a site, an organization, and then click Search.

¢ To view monthly alarm overview, click Monthly, configure
the time, select a site, an organization, and then click Search.

If the time zone of the server is not the same as the DSS
client, statistics will be generated based on the time zone of
the server. For example, daily statistics will be generated
from 00:00 to 24:00 based on the time zone of the server.

Alarm Overview

Statistics is generated based on the alarms that the current user
has access to. The number and proportion of alarm events that
are pending, processed, or not processed are displayed.

The data will only refresh in real-time when you are viewing
daily statistics.

Alarm Trend

Displays trend of alarms of all priorities.
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No. Parameter Description

Top 10 alarm sources and alarm types that the current user has
access to are sorted by the number of alarms.

The data will only refresh in real-time when you are viewing

Top T0Alarm | aily statistics.
4 Sources and
(@zus

Alarm Types

You can click high, medium, or low to not include the number of
certain alarms. For example, if you click High, the number of the
alarms in this priority will not be counted.

® To view and process alarms, click ﬂ

3\
® To view and process alarms, click .

5.2.4 Alarm Controller

You can monitor and manage alarm controllers.
Prerequisites
Alarm controllers are added to the platform. See "3.1.2 Managing Device".

Procedure

Step1 Loginto the DSS Client. On the Home page, click B, and then select Event Center.
duua

Step2  Click .

Step3 Inthe device tree, click an organization.

All alarm controllers under this organization will be displayed on the right. You can select
one or more alarm controllers, and then click Away Arm or Disarm to arm or disarm the
alarm controllers you selected.

[

If arming failed, you can click Force Arm on the prompt window to arm again.

Figure 5-54 Alarm controller organization

Alarm Controller ahost
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Step 4

In the device tree, click an alarm controller.
All subsystems under this alarm controller will be displayed on the right.

You can right-click an alarm controller, and then click Update Alarm Controller to
update its information.

Figure 5-55 Subsystems

Alarm Controller ARC9016C-zhu

Step 5

Step 6

S Refresh

Subsystem Name Arming Status Alarm Status ~  Operation

AREA1 Away Arm Normal e e
Normal [ ]
Normal [ ]
Normal )
Normal ]
Nermal .

Normal L]

 a 2 a2 a2 2 2 0

Normal [ ]

Arm or disarm subsystems.

Operate on multiple subsystems.

L ¢ e\ : Operate on one system.
[L]

® See the user manual of the alarm controller for detailed description on each function.
® |f arming failed, you can click Force Arm on the prompt window to arm again.
In the device tree, click a subsystem of the alarm controller.

All zones under this subsystem will be displayed on the right.

Figure 5-56 Zone

Alarm Controller Subsystem_1

Step7

Zone Name Partition Name Bypass Status ~  Realtime Status Fault Status Operation

Normal Close Normal nmo

Ini o
Normal N Inno
I o]

Normal N
Normal Close Normal

Bypass, isolate, or unbypass zones.

: Operate on multiple zones.

o HuBUURS : Operate on one zone.
11

® See the user manual of the alarm controller for detailed description on each function.
® [f arming failed, you can click Force Arm on the prompt window to arm again.
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5.3 DeepXplore

You can set multiple search conditions to view records of people, vehicle snapshots, access, POS,
and MPT.

5.3.1 Searching for Records

In this section, you can view integrated records of people, vehicle, access control, POS transactions,
and MPT devices.

Procedure

Step1 Loginto the DSS Client. On the Home page, click E and then select DeepXplore.

Step2 Click ., and then select Record.
Figure 5-57 Record search

Records

@ Selected Channels (47) Today

Face Capture rR-I Body Capture rﬁ‘l
= L N Al

Vehicle Capture Non-Motor Vehicle Captule- .-I

N N ik

Person Access Records MPT Records
N N =

Vehicle

POS Transaction

Step3  Set the search object, channel and time, and then click Search.
L]

MPT records can only be searched for after MPT devices have uploaded records, or the
platform has obtained records from MPT or EEC devices by retrieval plans. For how to
configure a retrieval plan, see "3.1.5.3 Adding Retrieval Plan for MPT Devices".

For the search result, you can perform the following operations.
® View details on records

Select a record, and then its details are displayed on the right, including snapshots
(hover the mouse to zoom in on a portion of the snapshot), recorded videos (can be
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downloaded to your computer), and targets that can be further searched for (manually
select a target or use AcuPick to automatically recognize targets).

You can hover the mouse over the small image on the right, and then cIickE to
search for images similar to this one. The platform will compare the image you upload
to the records on the selected devices, and then return results based on the defined
similarity.

You can also cIickE to add it to a face arming group. After you send the group to
devices and configure an event, devices can trigger alarms when the face is
recognized.

When viewing recorded videos and snapshots, you can select a target manually or
select one automatically recognized by AcuPick, and then search for it in DeepXplore.

If the channel is bound to other video channels, hover the mouse on the video to view
the recorded video from the bound video channels.

Figure 5-58 View recorded videos from bound video channels

Snapshot

H.265,1920~108

CM camera2

D -
| M camera?

0 '11:’237|].l:l
2023-11-28 10:37:12 B Ipc-162
C¥ BsC1

4 B |

If a license plate is recognized, click ] to add the vehicle to an arming group. After
you send the group to devices and configure an event, devices can trigger alarms
when the vehicle is recognized.

Click E to delete it one by one.
(L1

Access records and POS records cannot be deleted.
Add a record to a case

Click B to add a record to the temporary records, and then click Bl at the upper-
right corner to view all records in the temporary records. You can add them to a case.
Generate tracks

Click B21 to add a record to the temporary records, and then click BEll at the upper-
right corner to view all records in the temporary records. Select multiple records, and

then cIick. to generate a track.
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5.3.2 Searching for People

Based on the defined search conditions, you can view capture records of faces, bodies and other

information.

Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select DeepXplore.

Step2 Click ., and then select Person.

Records

Vehicle

Figure 5-59 Person search

Face Capture Body Capture Person Archive

‘A | =

Search by Image

@ Selected Channels (0) Yesterday This Week

Gender:

POS Transaction

® Search object

¢ Face Capture : Search for records in the face capture database.
¢ Body Capture : Search for records in the body capture database.
¢ Person Archive : Search for records in the person information database.

® Search type

¢ Attribute Search : Search for records by the defined features such as age, gender,

color of clothes, ID and more.
1]

When selecting whether to search for identification records, the difference is that,
besides the age and gender, identification records will also show the similarity
between the captured face and those in the arming lists.

Search by Image : The platform compares the image you upload to capture
records on the selected devices. If the similarity between a captured image on the
platform and the one you upload equals to or higher than the defined value, the
platform will display the result.

[

Only new versions of IVSS devices support displaying similarity.
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¢ Search channel: Select device channels of the records by clicking Selected
Channel.

¢ Search time: Select time period of the records from Today, Yesterday and This
Week.
L]

Only available for face and body capture records.

® Search conditions: Set search conditions such as age, gender, top color, ID, name and
more to search for specific records.

Step3  Set the search object, type and conditions, and then click Search.
Figure 5-60 Search results

% FaceCapture 2

K - 3 Face Capture Details

Tme 1l | EEIE | ©OrC

Time In Database (Yes/No) Operation

% ®

Information

ge

#Young

Step4  Go back to Searching for People, and then click Person Archive.

Step5  Enter the ID, name or card number of the person you want to search for.
Step6  Double-click the record.

You can see the face capture, vehicle capture, access records and other information of the
corresponding person.

Figure 5-61 Person information

Vehicle Capture Access Records ‘
[ o |

Plate No. ime Channel Name

Channel Name Operation

For the search result, you can perform the following operations.
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® View details on records

Select a record, and then its details are displayed on the right, including snapshots
(hover the mouse to zoom in on a portion of the snapshot), recorded videos (can be
downloaded to your computer), and targets that can be further searched for (manually
select a target or use AcuPick to automatically recognize targets).

® You can hover the mouse over the small image on the right, and then cIickE to
search for images similar to this one. The platform will compare the image you upload
to the records on the selected devices, and then return results based on the defined
similarity.

You can also cIickE to add it to a face arming group. After you send the group to
devices and configure an event, devices can trigger alarms when the face is
recognized.

® When viewing recorded videos and snapshots, you can select a target manually or
select one automatically recognized by AcuPick, and then search for it in DeepXplore.

® [f the channel is bound to other video channels, hover the mouse on the video to view
the recorded video from the bound video channels.

Figure 5-62 View recorded videos from bound video channels

Snapshot

H.265, 1921

CM camera2

CH camera2

2023-11-28 10:37:12 B IpC-162
L BsC1

4 B Il » 4«

® (lick E to delete it one by one.
® Add arecord to a case

Click B€1 to add a record to the temporary records, and then click BEll at the upper-
right corner to view all records in the temporary records. You can add them to a case.

® Generate tracks

Click to add a record to the temporary records, and then click at the upper-
right corner to view all records in the temporary records. Select multiple records, and

then cIick. to generate a track.
5.3.3 Searching for Vehicles

Procedure

Step1 Loginto the DSS Client. On the Home page, click EE] and then select DeepXplore.
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Step2  Click , and then select Vehicle.
Figure 5-63 Vehicle search

Records

Vehicle Capture Vehicle Archive

Person
Search by Image
Vehicle @ Selected Channels (0) Today Yesterday ThisWeek

Plate No.: Vehicle Brand:

All

. Complete Plate No.

Vehicle Color: Vehicle Category:
W Al All

Vehicle in Database (Yes/Na):

All

POS Transaction

® Search object

¢ Vehicle Capture : Search for records in vehicle capture database.
¢ Vehicle Archive : Search for records in vehicle information database.
® Search type

¢ Attribute Search : Search for records by the defined attributes such as vehicle
color and brand.

¢ Search by Image : The platform compares the image you upload to all capture
images. If the similarity between a captured image on the platform and the one
you upload equals to or higher than the defined value, the platform will display the
result.

¢ Search channel: Select device channels of the records by clicking Selected
Channel.

¢ Search time: Select time period of the records from Today, Yesterday and This
Week.
[

Only available for vehicle capture records.
® Search conditions: Set search conditions such as plate number (full plate number
optional), vehicle brands, owner name and more to search for specific records.

Step3  Set the search conditions, and then click Search.
For the search result, you can perform following operations.

® View details on records

Select a record, and then its details are displayed on the right, including snapshots
(hover the mouse to zoom in on a portion of the snapshot), recorded videos (can be
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downloaded to your computer), and targets that can be further searched for (manually
select a target or use AcuPick to automatically recognize targets).

® |f alicense plate is recognized, click &l to add the vehicle to an arming group. After
you send the group to devices and configure an event, devices can trigger alarms
when the vehicle is recognized.

® |f the license plate is incorrectly or cannot be recognized, you can correct it manually.
Then, it can be added to an arming group.

® |f the channel is bound to other video channels, hover the mouse on the video to view
the recorded video from the bound video channels.

Figure 5-64 View recorded videos from bound video channels

Snapshot

H.265,192

CM camera2

e CH camera2
370 30

2023-11-28 10:37:12 S IPC-162

<« m I L BsC1

® (Click E to delete it one by one.
[L]

Access records and POS records cannot be deleted.
® Add arecord to a case

Click B21 to add a record to the temporary records, and then click BEl at the upper-
right corner to view all records in the temporary records. You can add them to a case.
® Generate tracks

Click B&] to add a record to the temporary records, and then click Bl at the upper-
right corner to view all records in the temporary records. Select multiple records, and

then cIick. to generate a track.

® For vehicle archives, double-click a record to view recognition records of a license
plate.

5.3.4 Searching for POS Transaction

You can search for POS transactions by keywords and POS fields.
Procedure

Step1 Login to the DSS Client. On the Home page, select E > DeepXplore > DeepXplore >
POS Transaction.

Step2  Configure POS field.
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1. Click POS Field Config.

2. Configure a POS field for its receipt field, and then cIick- to enable it.
3. Click OK.
Step3  Configure the search conditions.

1. Configure the information you want to search for.

® POS Info : Keywords in the transaction information. This can be used with one or
more POS fields at the same time.

® POS fields: The POS fields you have configured in step 2 will be used to search for
certain information in the transactions. For example, the POS field for total price is
TTL, then the platform will obtain the number for TTL and return the results.

2. Select POS channels, configure the period, and then click Search.

Figure 5-65 Search results

- POS Record Details

]
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Step4  Manage the search results.
® \iew details.

Select a transaction, and then you can view the detailed information and video at that
time on the right. The video can be directly downloaded to your computer. Also, you
can also search for targets in the video by selecting one manually or automatically
recognized by AcuPick.

If you need video at the time of transaction, you must bind POS channels with video
channels, and configure recording plans for the video channels. For details, see "3.1.3
Binding Resources" and "3.1.4 Adding Recording Plan".

® Addtoacase.

1. Click B& of a transaction to add it to the temporary library.

Click BEH on the upper-right corner.
Select one or more transactions, and then click Add to Case.
Select a case, and then click OK.

H>wnN
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©=n

In the temporary library, select one or more transactions, and then click H to
remove them. This operation will only remove them from the temporary library,
but not delete them.

® View track.

1. Click B& of a transaction to add it to the temporary library.
2. Click Bl on the upper-right corner.

3. Select transactions, and then click . The platform will open a page and display
the track based on the transactions you select.

[

If you need to view tracks, you must mark POS channels on the map first. For
details, see "4.2.3 Marking Devices".

5.3.5 Adding Case Bank

Inside the case bank, you can integrate the records of face, plate, access and more into one
complete case, and configure its details for future investigation. The platform supports storing up
to 10,000 cases.

Prerequisites

The case files can only be stored in Incident File disk. Make sure that you have configured such
disk type in advance.

Users with access to Case Bank :

® Super administrator: View, edit and delete incident files.
® Administrator:

¢ View incident files created by themselves and common users. No access to incident files of
other administrators.

¢ Edit and delete files opened.
¢ Cannot edit or delete files closed.
® Common user:

¢ Can only view files created by themselves.
¢ Edit and delete files opened.
¢ Cannot edit or delete files closed.

Procedure
Step1 Login to the DSS Client. On the Home page, click E, and then select DeepXplore.
Step2  click B
Step3 Click Add to add a new case.
Step4 Inthe Case lcon section, click one of the 5 small squares, drag the image file to the big

square on the left, or hover the mouse over the big square, click . and then upload
the image file.

The image you select will be displayed on the upper-left corner of the case you export.

234



@Z@ya User's Manual

Figure 5-66 Select an image for the case

.

Case Icon

Step5 Select an image from the right side of the Case Icon section, which will be located at the
upper-left corner of the case file generated. You can change the icon by dragging the
small image from the right to the large image area on the left.

Only one icon can be added onto the case file.
Step6  Enter the basic information of the case.

® (Case Type : Used for categorize cases. You can click the drop-down list to select type
or create new ones.

® Status: Select the case status from Open and Close. The Platform integrates cases
under each status category.

Step7  Add records, including face capture, body capture, license plate recognition records,
access records, POS records, and MPT records.

Records of other categories are added in the same way. In this section, we take Face
Capture as an example.

1. Click Add under Face Capture.

2. Select channels and time, and then click Search. You can click the record to view its
details.
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Figure 5-67 Add face capture record

9 Face Capture

Q@ sel

lec Channel(13) oday Yesterday ThisWeek - Face Capture Details

Image Time Channel Name Operation @ rc

2021-04-12 3 5 %

Detailed Information

o)

#Female

3. Click next to the record to add it to the case.

4. Click 2 to go back to the case adding page, you can add other type of records related
to the case.

Step8  Scroll down and click Add under Attachment to upload images and videos related to the

case.

® The platform supports uploading up to 20 videos, and each video cannot exceed 300
MB. Format includes dav, mp4, avi, flv and asf.

® Up to 20 images can be uploaded. Image format includes png, jpg and jpeg.
[L]

The number of all video files and images cannot be more than 20.

Step9  Click OK.
Related Operations

Delete or replace anicon

Hover the mouse over a small square, and then cIickH to delete it; click a small square, and
then drag an image file to the big square on the left, or hover the mouse over the big square,

click ., and then upload the image file to replace it.

Enter case name in the search box at the upper-right corner, and then press Enter or click®to
search for cases.

Click i under a temporary case to view the case details. If you need to edit the details, click Edit
and change the information as needed.

Click Bl under a temporary case to download it, or you can click Download in the case details
page. Click Download Progress at the lower-left corner to check the download progress.

Click B under a case to delete it one by one, or you can select cases, and then click Delete to
delete them in batches.
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5.3.6 Viewing Track of MPT Devices

Search for and view the track of an MPT device on the map within the defined period.

Prerequisites

® (Configure the vector map. For details, see "4.2.2.1 Adding Vector Map".
® Add MPT devices to the platform. For details, see "3.1.2.4 Adding Devices".
® MPT devices upload their GPS information to the platform. For details, see their user's manuals.

Procedure

Step1 Loginto the DSS Client. On the Home page, click E, and then select DeepXplore >
MPT Track.

Step2 Select an MPT device, configure the time, and then click Search.
The track of the MPT device will be displayed on the map.

[

You can only search for up to 24 hours of track in the same day. For example, 00:00 to
23:59:59, or 3:00 to 23:59:59.

5.4 Access Management

On the Access Management page, you can perform operations on access control, lift control,
video intercom, and visitor.

5.4.1 Access Control

5.4.1.1 Viewing Access Point

Log in to the DSS Client. On the Home page, select EE| > Access Management > Access
Control > Access Control Panel.

This page displays by default all the access points in the root zone and all its sub zones in card view.

Change the display mode

ClickHH or [I]] on the upper-right corner to display access points in card view or on the map. Click
the icon of an access point to view live videos from bound channels, unlock or lock the door, or
make a call to it.
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Figure 5-68 Access points on a map

& Authentication Mode 8 LockMode

% Hide AccessPointName  © Resef

View certain access points

On the top on the page, select a zone or access point type to display only door or lift control
channels, or the access points in a zone and its sub zones.

View access point information

In card view, double-click an access point to view its information, including basic information, live
videos from bound channels, and events. For a door channel, you can also lock or unlock the door
and make a call to it.

5.4.1.2 Viewing Live Video from Bound Channel

Log in to the DSS Client. On the Home page, select EE| > Access Management > Access
Control > Access Control Panel. You can view live videos from bound channels in the following
ways.

View live videos in card view

Click EE to display access points in card view. Click ﬂ to view live videos. Each access point will
only use one window. If more than 1 video channel is bound to the access point, you can click the
drop-down list on the lower-right corner to switch between video channels.
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Figure 5-69 Switch between video channels

OM itc-128 1

View live videos in the detailed information of an access point

In card view, double-click an access point, and then live videos will be displayed in the Related
Info section.

View live videos on the map

Click[m on the upper-right corner to display access points on the map. Click the icon of an access

point, and then click B= to view live videos.

5.4.1.3 Unlocking and Locking Door

Log in to the DSS Client. On the Home page, select EE| > Access Management > Access
Control > Access Control Panel. You can unlock or lock doors in the following ways.

Unlock or lock doors in card view

Click HH to display access points in card view. Click E]] or IEI to unlock or lock a door channel.

Unlock or lock doors in the detailed information of an access point

In card view, double-click an access point, and then click Open Door or Close Door.
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Unlock or lock doors on the map

5.4.1.4

5.4.1.5

Click[m on the upper-right corner to display access points on the map. CIick or E] to unlock or
lock a door channel.

Controlling Door Channels Globally

Set all door channels in a zone to normally closed, normally open modes, or restore them to the
normal status in one click. Only administrators can control door channels globally.

Log in to the DSS Client. On the Home page, select E > Access Management > Access
Control > Access Control Panel. Select a zone, and then click Normally Open, Restore, or
Normally Closed to control all the door channels at the same time.

® Normally Open : All people can pass without verifying their identifications.

® Restore : Restore door channels to the normal status from normally open or normally closed
mode. People must verify their identifications to pass

® Normally Closed : No person is allowed to pass.

If you perform this operation to a zone, it will also be applied to all the sub zones. When the status
of the parent zone and sub zone is in conflict, the platform will resolve it in the following ways:

® When a sub zone has been set to the normally open or closed mode, operating the parent zone
will override the status of the sub zone.

® When the parent zone has been set to the normally open or closed mode, and you want to set a
sub zone to a mode opposite to the parent zone, the platform will prevent you from doing so,
and prompt that you must restore the parent zone to the normal status before setting the sub
zone.

Controlling Lift Channels Globally

Set all lift channels in a zone to no authentication, authentication, and lock modes. Only
administrators can control lift channels globally.

Log in to the DSS Client. On the Home page, select EE| > Access Management > Access
Control > Access Control Panel. Select a zone, and then click No Authentication Mode,
Authentication Mode, or Lock Mode to control all the lift channels at the same time.

® No Authentication Mode : All people can go to any floor without verifying their identifications.
® Authentication Mode : People must verify their identifications to go to specified floors.
® Lock Mode : No person is allowed to use lifts.

If you perform this operation to a zone, it will also be applied to all the sub zones. When the status
of the parent zone and sub zone is in conflict, the platform will resolve it in the following ways:

® When a sub zone has been set to the no authentication or authentication mode, operating the
parent zone will override the status of the sub zone.

® When the parent zone has been set to the no authentication or authentication mode, and you
want to set a sub zone to a mode opposite to the parent zone, the platform will prevent you
from doing so, and prompt that you must set the parent zone to the authentication mode
before setting the sub zone.
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5.4.1.6 Viewing Real-time Event

When a person passes through an access point, an event will be reported to the platform. You can
view the detailed information of that event.

Prerequisites

If you want to view recorded videos and live videos of an event, you must configure the following
parameters first:

® |ive video: Bind video channels to access points. For details, see "3.1.3 Binding Resources".

® Recorded videos: First, bind video channels to access points ("3.1.3 Binding Resources"). Then,
select either of the 2 options: Configure recording plans for the bound video channels ("3.1.4
Adding Recording Plan"), or configure an event to link the bound video channels to record
videos when a person passes ("4.1 Configuring Events").

Procedure

Step1 Loginto the DSS Client. On the Home page, select Eﬂ > Access Management > Access
Control > Access Control Panel.

Events from all zones are displayed in the Event section at the bottom of the page.

Step2  Select a zone and type of access points, and then the platform will display access points
and real-time events of that zone and its sub zones.

Step3  Click [ and then you can view the snapshot, recorded video, and live video of the
event.

Step4 Locate the access point for an event.

® (lick HH on the upper-right corner to display access points in card view. Click an
event, and then its access point will be highlighted.

Figure 5-70 Highlighted access point

Kl Normally Open estore Normally Closed 7 No Authentication Mode & Authentication Mode

v Event ime Zone int  Access Point Type Person D P ntered/Exited St...

Valid Swipe 2023-11-06 .. Building A 23 oor 05113851  All Persons... In

Marry
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® (lick [[H on the upper-right corner to display access points on the map. Click an event,
and then its information is displayed on the map.
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Figure 5-71 Highlighted on the map
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Related Operations
L m: Stop receiving new events. Click it again to start receiving events.

® H: Clear the events on the page, but they will not be deleted.
° : Go to the Access Records page.

5.4.1.7 Viewing and Exporting Specified Events

View and export events in a specified zone, person group, and period.
Procedure

Step1 Login to the DSS Client. On the Home page, select Eﬂ > Access Management > Access
Control > Access Records > Event Records.

On top of the page, the numbers of different types of events are displayed for all zones by
default.

Step2  Configure the search conditions, and then click Search.

Table 5-14 Parameter description

Parameter Description

Search for events in the selected zone. You can select multiple zones
Zone )

at the same time.
Time Search for events that occurred in the defined period. You can search

for event within up to 1 month.
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Parameter Description

Person Group

Search for events of people that belong to the selected group.

The selected person group is empty by default. In this case, the
search results will include events with no related person information,
such as access by a person whose information is not on the platform,
access by strangers, and alarms triggered by devices. If you want to

clear the selection of a person group, click E, and then no person
group is selected.

Person/Person ID/Access | select an option and enter keywords to search for certain events. For

Point example, select Access Point and enter Front Gate to search for
Key words events of access points that have Front Gate in their names.
Step3  Click Export.
Step4  Enter the login password, encryption password, and select whether to export images and

the export range, and then click OK.
L]

You can configure whether to verify the password. For details, see "7.4.1 Configuring
Security Parameters".

® The encryption password is used to protect the export file. It consists of 6 uppercase or
lower case letters, numbers, or their combinations. You need to enter it when using
the export file.

® The export range can be all or specified events that are displayed.
® Select Export Image to export snapshots of the events at the same time.

5.4.1.8 Acquiring Records

The platform offers 2 methods for acquiring access records, manually or automatically. For the
automatic method, only records within the past 24 hours will be acquired. But, the manual method
can be used to acquire records from specified period and device.

Procedure
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Log in to the DSS Client. On the Home page, select E > Access Management > Access
Control > Access Records > Event Records.

Click Acquire Records.
Enter the login password, and then click OK.
Acquire records.

® Auto Extraction : The platform will acquire records within the past 24 hours at the
defined time every day. How records are synchronized:

¢ If records on a device was automatically synchronized to the platform, then the
platform will synchronize all records from the time of the latest record from the last
automatic synchronization to the time you set. For example, the latest record from
the last automatic synchronization was on 2022-10-18 16:00, time of automatic
synchronization is set to 04:00 every day. The device was offline on 2022-10-18
18:00, and then reconnected on 2022-10-20 16:00, then the platform, on
2022-10-21 04:00, will synchronize the records generated on the device from
2022-10-18 16:00 to 2022-10-21 04:00.
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¢ If records on a device has not been automatically synchronized to the platform,
and the device went offline and online multiple times, the platform will
synchronize all the records from the time of the latest record uploaded before the
first offline, to the time you set. For example, time of synchronization is set to 04:00
every day. The device first goes offline on 2022-10-18 16:00 with the latest record
uploaded on 2022-10-18 15:00. Before the time of synchronization, the device goes
offline and online multiple times. Then on 2022-10-19 04:00, the platform will
synchronize the records generated on the device from 2022-10-18 15:00 to
2022-10-19 04:00.

¢ If records on a device has not been automatically synchronized to the platform,
and records were not generated on the device and uploaded to the platform when
the device is online, then on the time of synchronization, the platform will
synchronize the records on the device within the past 24 hours.

® Manual Extraction:

¢ Select Extract Now, and then the platform will acquire records ranging from the
last time that an extraction was performed which were not extracted.

¢ Select Extract by Range, and then you can specify the time range, record type, and
device.

5.4.1.9 Viewing Access Route

View the access route of a person on a map based on events.
Procedure

Step1 Login to the DSS Client. On the Home page, select Eﬂ > Access Management > Access
Control > Access Records > Event Records.

The number of events in the root zone is displayed on the top of the page by default.
Step2 Select a zone, person group, and period, and then click Search.

You can search for event within up to 1 month.

1]

The selected person group is empty by default. In this case, the search results will include
events with no related person information, such as access by a person whose information
is not on the platform, access by strangers, and alarms triggered by devices.

Click .é‘) to add multiple events to the temporary records.

Step 3
pa i
Step4  Click k&l to go to the temporary records.
Step5  Select the events, and then click =2 to generate the route.

The platform will play the route based on the time of events.

[

If events happened in multiple zones, and the maps of zones do not relate to each other
as main and sub maps, the platform might not play the route normally.
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Figure 5-72 Route
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5.4.1.10 Viewing and Exporting Analysis of People Entering and Exiting

When people pass through boundaries, the platform will count the number of people entering and
exiting zones. You can view the number of each zone and export it to your computer.

Prerequisites

Set access points as boundaries. The platform will only count the number of people pass through
boundaries. For details, see "4.5.2.5.2 Setting Boundary".

Procedure

Step1 Loginto the DSS Client. On the Home page, select Eﬂ > Access Management > Access
Control > Access Records > Analysis of People Entering and Exiting.

Step2  Select one or more zones, boundaries, and the start time, and then click Search.

The platform will display the statistics of people entering and exiting the selected zone,
and related events ranging from the start time to the current time. For example, the
platform will display the statistics and events ranging from the defined start time 5-16
08:00:00 to the current time 5-17 10:00:00.

Step3  Click Export.

Step4  Enter the login password, encryption password, and select whether to export images and
the export range, and then click OK.

You can configure whether to verify the password. For details, see "7.4.1 Configuring
Security Parameters".

® The encryption password is used to protect the export file. It consists of 6 uppercase or
lower case letters, numbers, or their combinations. You need to enter it when using
the export file.

® The export range can be all or specified events that are displayed.

® Select Export Image to export snapshots of the events at the same time.
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Related Operations
Manually mark the enter or exit status for people:
® On the list of person entered, exited or entered but did not exit, click [ to see all access records

of a person. CIickE to mark a record as invalid. The invalid records can also be restored to be
valid. The statistics and status of the person will change accordingly.

® On the list of person who did not exit after entering, click ™4 to mark a person as "exited". The
statistics and status of the person will change accordingly.

5.4.2 Video Intercom Application

® You can call, answer, release information and view video intercom records.

® Make sure that you have configured the video intercom configuration before application. For
details, see "4.6 Video Intercom". You can also click Ex=memmm to go to the video intercom
configuration page.

5.4.2.1 Call Center

The platform, VTOs, VTHs, second-generation door station access controllers, and second-
generation fence station access controllers can call each other.

Procedure

A
Step1 Login to the DSS Client. On the Home page, click E > Access Management > >
Call Center.

Figure 5-73 Call center
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Step2 You can call different devices.
® (all from the platform to VTO

Select VTO in the device list; click u corresponding of VTO or dial a number on the
dial pad to call the VTO. The system pops out call page. The following operations are
supported during call.

o E: If VTO is connected to lock, click this icon to unlock.

o [} Click this icon to capture picture, the snapshot is saved into the default
directory. To change the path, see "8.3.5 Configure File Storage Settings".
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o 8. Click this icon to start record, click again to stop record. The video is saved in
default path. To change the path, see "8.3.5 Configure File Storage Settings".

o B Click this icon to hang up.
Figure 5-74 Call

Calling building 1

If the device supports two locks, two lock icons will appear on the page, and you can
click either one to unlock corresponding door.

® (Call from the platform to VTH

Select VTH from the device list, click Bl on the VTH or dial corresponding VTH on the
right (such as 1#1#101). The system pops up the dialog box of Calling now, please
wait .... There are two modes for answering the call.

<> Answer by VTH, bidirectional talk between client and VTH. Press [~ I hang up
when you answer the call.

< If VTH fails to answer in 30 s, hangs up or is busy, then it means the call is busy.
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Figure 5-75 Calling

Calling room

00:01

room

Being called ...

® (all from the platform to an access control device that supports video intercom

Select a device from the device list, click on it or dial its number on the right (such
as 1#1#101). The system pops up the dialog box of Calling now, please wait .... There
are two modes for answering the call.

¢ Answer by the device, bidirectional talk between client and the device. Press [~ |
to hang up when you answer the call.

¢ If the device fails to answer over 30 s, busy or hang up directly, then it means the
callis busy.

Figure 5-76 Calling

Calling

A A O @

® (Call from VTO to the platform
When a VTO calls, a window pops up.
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o E: Unlock the door if the VTO is connected to a door.
o [ Answer the call.
o IR Hang up.

Figure 5-77 VTO Call

2nd is calling you

JII R -

® \When VTH is calling the platform
The client pops out the dialog box of VTH calling. Click to talk with VTH.

< Click to answer VTO, realize mutual call after connected.
o Click HEM to hang up.

® When an access control device that supports video intercom is calling the platform
The client pops out the dialog box. Click to talk with the device.
Click HESH to hang up.
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Figure 5-78 Call from an access control device that supports video intercom

ASC101is calling you

® (all through call records

All the call records are displayed in the Call Record at the lower-right corner of the
page of Video Intercom. Click the record to call back.

Figure 5-79 Call records
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5.4.2.2 Releasing Messages

Send message to VTHs.

Procedure
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Log in to the DSS Client. On the Home page, click EE| > Access Management > Video
Intercom > Information Release.

Click Add New Message, select one or more VTHs, and then configure the information
you want to send.

(Optional) Enable Schedule Release, and then configure the time.
Send the message.

® |f no scheduled release time is configured, click Instant Release, or click Save, and

then cIick to send the message immediately.

® |f a scheduled release time is configured, click Save, and then the message will be sent
on the defined time.

5.4.2.3 Video Intercom Records

Search for and view call records.

Procedure
Step 1

Step 2

Step 3

Y
Log in to the DSS Client. On the Home page, cIickE > Access Management > >
Video Intercom Record.

Set conditions, and then click Search.

The platform displays all the records according to the configured conditions.

(Optional) Click Export, and then follow the prompts to export all or partial records to
your computer.

5.4.3 Visitor Application

After appointment is made on platform, and visitor information is registered, the visitor can have
access permission. Access permission is disabled after the visitor leaves.

5.4.3.1 Preparations

® You have configured the deployment of the video intercom devices, access control devices and
entrance and exit device. For details, see the corresponding user's manual.

® You have configured the basic configuration of the platform. For details, see "3 Basic
Configurations".

® Make sure that you have configured the visitor configuration before application. For details, see
"4.7 Visitor Management". You can also click EX22E8 to go to the video intercom configuration

page.
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5.4.3.2 Visitor Appointment

Register the information of visitors on the platform before they arrive for their visits. This will greatly
reduce the time that visitors have to wait for their information to be recorded.

Procedure

Step1 Login to the DSS Client. On the Home page, cIickE > Access Management > @ >
Visitor Management.

Step2  Click Visitor Registration.
Step3  Click the Visitor Details tab, enter the information of the visitor and the one to be
visited.

Figure 5-80 Visitor details

L1

Click k=l in the appointment list to enter the Visitor Details tab.

Step4  (Optional) Click the Authentication tab, select the room number to be visited, and then
click Generate to generate the QR code of the pass.

You can click B to download the QR code, and click &l to send it to the visitor by email.
Step5 Click OK.

5.4.3.3 CheckingIn

When a visitor with an appointment arrives, you need to confirm their information and give them
access permission. On-site registration is supported when there is a walk-in visitor. Visitors can get
access by card swipe or face recognition.

Procedure

Step1 Login to the DSS Client. On the Home page, select EH > Access Management > @ >
Visitor Management.

Step2  Enter the information of the visitor.
1. Go to the visit registration information page.
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® |[f a visitor has an appointment, find their visitor information, and then click =
® |f a visitor does not have an appointment, click Visit Registration.
2. Confirm or enter the information of the visitor.

The arrival time will be automatically changed to the current time and cannot be
changed again.

Figure 5-81 Visitor information

Step3  (Optional) Click the Authentication tab, and then set authorization information.
1. Select the room number.
2. lssue cards.

You can issue cards by entering card number manually or by using a card reader. A
card number is 8-16 numbers. Only second-generation access control devices support
16-digit card numbers. When a card number is less than 8 numbers, the system will
automatically add zeros prior to the number to make it 8 digits. For example, if the
provided number is 8004, it will become 00008004. If there are 9-16 numbers, the
system will not add zero to it.

® |ssue cards by entering card numbers manually
Click Add next to Card, enter the card number, and then click OK.

Figure 5-82 Issue card
Card ¢

ssue Card

Card Number:
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® |ssue card by using a card reader

Click ﬂ, select a card reader or device, and then click OK. Swipe card through the
reader or device, and then a new card will be issued.

Figure 5-83 Reader manager

Card add IE

Reader Manager

Card Reader:

Device

3. Set face picture. Position your face in the snapshot area, and click Upload Picture to
select a picture or click Snapshot to take a photo.

Figure 5-84 Take a face photo

3

Upload Picture

Snaphot

I.:" "':.
_

4. Click Generate to generate a QR code for the pass.
You can click B to download the QR code, and click &l to send it to the visitor by
email.
Step4  Click the Authorize tab, and then select access permissions for the visitor.

[

If you want to set video intercom devices and entrance and exit permissions, you must set
host room number and number plate for the visitor.
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Figure 5-85 Authorize

r Details Authentication

o Intercom Entrance and Exit

Step5 Click OK.

Related Operations
® End the visit.

Click E to end a visit.
® \iew card swiping records.

Click the Card-swiping Record tab, or click k=l in visitor record to view visitor card swiping
records.

® Cancel the appointment.

Click E], and cancel the appointment as the screen instructs.

5.4.3.4 Checking Out

When visitors are leaving, remove their access permissions.

Procedure
Step1 Login to the DSS Client. On the Home page, click HH > Access Management > LIPS
Visitor Management.
Step2  Find the appointment record of the visitor, and then click E
Step3  Click OK to remove access permission.

If you have issued a card to a visitor, make sure the visitor returns the card before leaving.

5.4.3.5 Visit Records

Search for visit records, and view visitor details and card swiping records.
Procedure

Step1 Login to the DSS Client. On the Home page, cIickE > Access Management > @ >
Visitor Record.

Step2  Set search conditions, and then click Search.
The results are displayed.
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In addition to entering the card number, you can also click H select a card reader and
then get the card number by swiping card.

Step3  Click B8 t6 view visitor details and card swiping records.

5.5 Parking Lot

You can monitor vehicles that enter and exit in real time, view vehicle information, and search for
on-site vehicle, exit vehicle and snapshot records, and manage parking lots intuitively through their
different layers.

5.5.1 Statistics Dashboard

The platform automatically generates data on parking lots, including real-time data on the current
day, number of vehicles entering and leaving parking lots, parking turnover rate, and rate of
parking space usage.

Log in to the DSS Client. On the Home page, click EE| > Parking Lot > Statistics Dashboard. The
data covers only the parking lots the current user has access to. Administrators can access all
parking lots by default.

Figure 5-86 Statistics dashboard

Parking Lot | All - @5 5 5 [Co

of Current Day
4110

- 08 463% Y 46.3%

a- Entered Vehicle  —#- Exited Vehicle

Table 5-15 Parameter description

Parameter Description

Select the parking lots you want to view data on, and then the

Parking lots numbers of parking lots, ANPR channels, entrances, and exits.
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Parameter

Description

Real-time data of the
current day

Displays the real-time data on the parking lots you selected.

Counting period

Configure a period you want to view data on. The graphs will adapt
accordingly.

The platform only displays the number of vehicles in parking lots for
each day.

Different types of data
presented in graphs

Displays different types of data within the counting period you
configured.

® Vehicles that Entered and Exited : Vehicles that have entered and
exited the parking lots.

® Vehicle in Parking Lot : Vehicles that were inside the parking lots.

® Parking Turnover Rate : Parking turnover rate = The number of
vehicles that parked during the counting period/the number of
parking spaces. The higher the parking turnover rate, the higher the
number of vehicles parked in the parking lot.

® Rate of Parking Space Usage : Rate of Parking Space Usage = The
total parking duration of all the vehicles/The number of parking
spaces in the parking lot x The counting period. The higher the rate
of parking space usage, the better the parking lot is being used.

Auto-Refresh Interval

Select how often the data will be updated.

Export a report

Export the current page as a PDF file to your computer.

5.5.2 Entrance and Exit Monitoring

Procedure

Step1 Login to the DSS Client. On the Home page, cIickEﬂ > Parking Lot > Entrance and

Exit Monitoring.

Select the number of windows you want from = = = 5 of

Click Please click to select the entrance and exit., select an entrance or exit point, and
then click OK.

v [N
~+ |+
FF
w N

The real-time video of that point will be opened in the window.
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Figure 5-87 Monitor entrances and exits

Table 5-16 Page description

No. Description

Select the number of windows you want. Each window can display the real-time
video of one entrance or exit point.

The real-time video of an entrance or exit point.

® (lick & to open the real-time video of another entrance or exit point in the
window.

L CIick to open the barrier for vehicles.

¢ Open without Recording Plate Info : Open the barrier for vehicles without

2 recording their plate numbers. If you select Count Parking Spaces at the
same time, the number available parking spaces in the parking lot will
decrease or increase depending on whether the vehicles are entering or
leaving. This operation will not generate an enter or leave record.

¢ Open and Record Plate Info : This is applicable to when the ANPR cameras
cannot recognize the number plates. You can manually enter the number
plate, and a snapshot will be taken, and then the platform will generate an
entrance or exit record.

Displays records of barriers not opened.

3 ® (lick u to open the barrier for the vehicle.
® |f the plate number is incorrect, you can cIick to manually edit it.

® (lick B3 to view the recorded video from the corresponding channel.
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No.

Description

All entrance and exit records.

L u/@ Pause or resume refreshing the entrance and exit records.

o : View the details and recorded video of a record.

5.5.3 Searching for Records

Search for entry and exit records, forced exit records, parking records, and snapshot records.

5.5.3.1 Searching for Entrance Records

Procedure

wv [\ |\
—~+ | |
w N =

Step 4

Log in to the DSS Client. On the Home page, click H > Parking Lot > Info Search.
Click the Entrance Records tab.
Configure the search conditions, and then click Search.

Click Show More and you can search by vehicle owner, company, person group, and
more.

Manage the records.

® (lick the image, and then a bigger one will be displayed.
® Double-click a record or click , and the detailed information is displayed on the

right. Click the play icon to play the recorded video, and then cIickg to download it.

Click 88 to modify the information of the vehicle, such as the plate number, brand
and color.

For the dual camera mode, click each channel to view the information it captured.

® (lick Layer Info to view the location of the channel that captured the vehicle on the
layer.

® Forced exit.

If a vehicle has exited but it is displayed as inside the parking lot, click A to record it

as exited the parking lot. When parking space counting by entering and exiting

vehicles is enabled for the parking lot, and the vehicle will be counted for available

parking space, this operation will add an available parking space to the parking lot.
® Export records.

Select the records to be exported, click Export, and then export them according to
the on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

® (lick Il and then select the items to be displayed.
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5.5.3.2 Searching for Exit Records

Procedure
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Step 4

Log in to the DSS Client. On the Home page, click H > Parking Lot > Info Search.
Click the Exit Records tab.
Configure the search conditions, and then click Search.

Click Show More and you can search by vehicle owner, company, person group, and
more.

Manage the records.

® (lick the image, and then a bigger one will be displayed.
® Double-click a record or click , and the detailed information is displayed on the

right. Click the play icon to play the recorded video, and then cIickg to download it.

Click 88 to modify the information of the vehicle, such as the plate number, brand
and color.

For the dual camera mode, click each channel to view the information it captured.

® (lick Layer Info to view the location of the channel that captured the vehicle on the
layer.

® Export records.

Select the records to be exported, click Export, and then export them according to
the on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

® (lick Il and then select the items to be displayed.

5.5.3.3 Searching for Forced Exit Records

Procedure

wn [\ [\
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Log in to the DSS Client. On the Home page, click EH > Parking Lot > Info Search.
Click the Forced Exit Records tab.
Configure the search conditions, and then click Search.

(1

Click Show More and you can search by vehicle owner, company, person group, and
more.

Manage the records.
® (lick the image, and then a bigger one will be displayed.
® Double-click a record or click , and the detailed information is displayed on the

right. Click the play icon to play the recorded video, and then cIickg to download it.

Click &8 to modify the information of the vehicle, such as the plate number, brand
and color.

For the dual camera mode, click each channel to view the information it captured.

® (lick Layer Info to view the location of the channel that captured the vehicle on the
layer.
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® |f a vehicle is inside the parking lot but it is displayed as exited, cIickE to record it as
inside the parking lot. When parking space counting by entering and exiting vehicles
is enabled for the parking lot, and the vehicle will be counted for available parking
space, this operation will subtract an available parking space for the parking lot.

® Export records.

Select the records to be exported, click Export, and then export them according to
the on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

® (lick Il and then select the items to be displayed.

5.5.3.4 Searching for Parking Records

Procedure
Step1 Login to the DSS Client. On the Home page, click H > Parking Lot > Info Search.
Step2  Click the Parking Records tab.
Step3  Configure the search conditions, and then click Search.

el

Click Show More and you can search by vehicle owner, company, person group, and
more.

Step4 Manage the records.
® (lick the image, and then a bigger one will be displayed.

® Double-click a record or click , and the detailed information is displayed on the
right, including entry and exit records. Click the play icon to play the recorded video,

and then clickg to download it.

For the dual camera mode, click each channel to view the information it captured.

® (lick Layer Info to view the location of the channel that captured the vehicle on the
layer.

® Export records.

Select the records to be exported, click Export, and then export them according to
the on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

® (lick M and then select the items to be displayed.

5.5.3.5 Searching for Capture Records

Procedure

Step1 Login to the DSS Client. On the Home page, click EH > Parking Lot > Info Search.

Step2  Click the Capture Records tab.
Step3  Configure the search conditions, and then click Search.

1]

Click Show More and you can search by vehicle owner, company, person group, and
more.

Step4  Mange records.
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® (lick the image, and then a bigger one will be displayed.

® Double-click a record or click , and the detailed information is displayed on the

right. Click the play icon to play the recorded video, and then cIickg to download it.

Click 88 to modify the information of the vehicle, such as the plate number, brand
and color.

For the dual camera mode, click each channel to view the information it captured.

® Restore entry.

If Yes is displayed under Exited when the vehicle is still in the parking lot, cIickE to
change the status to No.

® Export records.

Select the records to be exported, click Export, and then export them according to
the on-screen instructions. You can also click Export, and the then export all records
according to the on-screen instructions.

® (lick Il and then select the items to be displayed.

5.5.4 Visualized Parking Lot

Quickly understand your parking lot by viewing the information on the layers.
Procedure

Log in to the DSS Client. On the Home page, cIickEa > Parking Lot > Visualized

Step 1
Parking Lot.
Step2  Select a parking lot, and then double-click a layer.
Step3  View the information on the layer.
Table 5-17 Operation description

Icon/Parameter Description

E View the total and available parking spaces on the layer.

5ol View all the resources on the layer.

Zoom in and out on the layer.

Display Selected Layers | Select which resources you want to display on the layer.
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Icon/Parameter

Description

Pane

Click and hold on the layer to select multiple devices. After you select
multiple devices, you can perform the following operations:

° E: View the capture records from the selected devices.

: View the entrance records from the selected devices.

[i!: View the exit records from the selected devices.

E: View the parking records from the selected devices.

@: Open a video player and you can view the real-time video of
each device you selected. If you are viewing the real-time video

from an entrance or exit point, you can click ﬁ to open the barrier.

: Open a video player and you can search for and view the
recorded videos from the devices you selected.

Reset

Reset the layer to its default size and position.

Hide Plate No.

If reserved parking spaces have been configured on the layer, you can
hide partial information of the number plates displayed on the parking
spaces.

5.5.5 Vehicle Location

If vehicle search is configured for parking lots, vehicle owners can find where their vehicles are
parked through the vehicle search system. Operations on a computer or phone are similar. This
section uses a computer as an example.

Procedure

Step1  Go to the link of the vehicle search system in the browser.

@

For the links and QR codes used to access the vehicle search system, see "4.8.2.5 Vehicle

Finder".

Step2  Search for vehicles.

® Search for vehicles with license plates.

Enter a license plate, and then click Search to view the location of the vehicle,
including the name of the parking lot, floor number, parking space number, and layer
information. If there are multiple results, click one to view its details.

L1

To view layer information of vehicles, you must configure the layer first. For details, see
"4.8.2.3 Parking Lot Layer".

® Search for vehicles without license plates.

Click Unlicensed Vehicle Search to view all vehicles without licenses. If there is only
one result, the system will directly display its details. If there are multiple results, click
one to view its details.
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5.6 Intelligent Analysis

View real-time and history people counting data, heat maps, and number of people in an area.

5.6.1 People Counting
View the real-time and historical people count from all the devices in a people counting group.

5.6.1.1 Real-time Count

Procedure

Step1 Loginto the DSS Client. On the Home page, cIickEﬂ > Intelligent Analysis > >
Real-time Count.

Step2  Double-click a group or drag it to a window on the right to display its real-time data.
w

Use the buttons ISEEIESESE on the upper-right corner to set the number of windows
and to display in full screen.

® Occupancy : The number of people currently inside this group, which will be reset to
the defined value at the defined calibration time.

® Entered : The number of people entered this group, which will be reset to zero at the
defined calibration time.

® Exited : The number of people who left this group, which will be reset to zero at the
defined calibration time.

® (olor of the light:

¢ Red light: Occupancy = overlimit threshold.
¢ Yellow light: Crowded threshold < occupancy < overlimit threshold.
¢ Green light: Occupancy < normal threshold.

Figure 5-88 Real-time count

Occupancy 3

Entered O Exited

o Welcome.
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Step3  Hover you mouse on the window displaying real-time data, and then click .

Step4  You can enter a number of people to overwrite the current data, and customize the
content to be displayed for green, yellow and red light.

Figure 5-89 Edit the content and data
Edit

People Counting Group Name: Number of People Inside:

Prompt:
Overlimit Crowded
A B I U = =

Wel come.|

Step5 Click OK.

5.6.1.2 Historical Count

Procedure

Step1 Login to the DSS Client. On the Home page, click EE| > Intelligent Analysis > People
Counting > Historical Count.

Step2  Select the groups you want in Groups , or select the channels in Resources.
Step3  Configure the search settings, and then click Search.

® Groups : Groups are people counting groups, which allow you to combine and
calculate the people flow data from multiple rules across different devices and
channels. You can search for historical people flow data from one or more people
counting groups.

® Resources : Search for historical people flow data from one or more channels. The
data from all the rules of a channel will be included.

If a device is offline, it will upload all the data to the platform when it is online again.
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5.6.2

Figure 5-90 Historical people counting data
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Related Operations

] : Change the display format of the data.

Only daily reports displaying the number of retention.
® Export: Export the data into a .zip file to your computer.

Heat Maps

View heat maps generated by devices. A heat map shows the distribution of people flow by
different colors, such as red for many people have visited an area and blue for only a few people
have visited an area. The platform supports generating general heat maps and advanced heat
maps. Only fisheye cameras support advanced heat maps.

Prerequisites

Configure the channel feature for either type of heat maps. For details, see "3.1.2.5.2 Modifying
Device Information".

® General heat map: Select the General Heat Map from the channel features.
® Advanced heat map: Select the Advanced Heat Map from the channel features.

Procedure

Step1 Login to the DSS Client. On the Home page, cIickE > Intelligent Analysis > @
Step2  Select a channel, and then generate a heat map.

You can generate a heat map with data from up to one week.
® Generate a general heat map.

Configure the time, and then click Search.
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® Generate an advanced heat map.

1. Select how you want to generate the heat map, Number of People or Time.
2. Configure the threshold.

® When you select Number of People, the area with the closest number of people to
the threshold will be in red.

® When you select Time, the area where people stay for a duration closest to the
threshold will be in red.

3. Set the time, and then click Search.

Step3  Click Export on the upper-right corner to export the heat map to your PC.

5.6.3 In-area People Counting

View statistics on the number of in-area people.
Procedure

Step1 Login to the DSS Client. On the Home page, cIickEﬂ > Intelligent Analysis > In Area
No. Analysis.

Step2  Select a channel and configure the search settings, and then click Search.
L]

If a device is offline, it will upload data within the past 24 hours to the platform when it is
online again.

Figure 5-91 In-area people number statistics

Resources Daily Report 2021-07-13
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Related Operations

,.r-’
° -: Change the display format of the data.

® Export: Export the data to your PC.
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5.7 Intelligent Inspection

The platform supports regularly inspect devices, such as electrical equipment, or areas, and collect
snapshots and data. This can greatly improve inspection efficiency and reduce cost of labor.

Prerequisites

Install the plugin for intelligent inspection. For details, see "2.9 Installing Plugin”.

5.7.1 Monitoring Point

View the live videos, basic information, and inspection results of points.

Procedure
Step1 Loginto the DSS Client. On the Home page, cIickE > Intelligent Inspection > Point
Monitoring.
Step2  Double-click or drag a point to a window on the right to open its live video.

The basic information and results from the last inspection are displayed on the right.

5.7.2 Reviewing Inspection Result

Check and review inspection results.

Procedure

Step1 Login to the DSS Client. On the Home page, click E > Intelligent Inspection > Point
Monitoring.

Step2 Double-click or drag a point to a window on the right to open its live video.
The basic information and results from the last inspection are displayed on the right.

Step3  Click the snapshot on the right, and then the inspection results are displayed, including a
snapshot, the live video, and the data collected during inspection.

Step4  Review the information, and then click OK.

® Review Result : Select the results to be normal or abnormal.

® Reviewed By : The name of the current user is displayed. You can change it to another
name.

® Contact Details and Remarks: Enter any content you need. These are optional
parameters.

Related Operations

Click Send Email to send the results to specified email addresses. You can select the email
addresses of users on the platform, or manually enter them (you must press Enter after entering an
email address). If you want to select the email address of a user, that user must be configured with
one. Also, the email server must be configured on the platform to successfully send emails. For
details, see "3.2.2 Adding User" and "7.4.5 Configuring Email Server",
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5.7.3 Viewing Real-time Inspection

View the status of inspection plans, and the real-time videos of points in inspection plans. You can
also manually execute inspection plans.

Procedure

Step1 Login to the DSS Client. On the Home page, cIickE > Intelligent Inspection > Real-
time Inspection.
Step2 Select an organization, and then all inspection plans under it are displayed on the right.

You can enter keywords in the search box on the upper-right corner to search for certain
inspection plans.

Step3  Click [S3 to view the information of an inspection plan.

The information includes the basic information, names of points, and live videos. If the
inspection is in progress, the progress will also be displayed.

Figure 5-92 Inspection progress
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Step4  Click the name of a point to open its live video.
©=

After the inspection completes, click S to review the results.

Related Operations

CIickE] to execute an inspection plan immediately.

5.7.4 Searching for Inspection History

Search for and view all execution records of inspections.
Procedure

Step1 Login to the DSS Client. On the Home page, click EE| > Intelligent Inspection >
Inspection History.

Step2  Configure the search conditions, and then click Search.
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Table 5-18 Parameter description

Parameter Description

Select an organization, and then only the ones in that organization

Inspection Organization are displayed.

Inspection Type Only the selected type of inspections will be searched for.

Inspection name Enter keywords in the names to search for certain inspection plans.

Only inspections executed within the defined period will be

Time searched for.

Step3  Click (&3 0 view inspection results of the points in an inspection plan.

Step4  Click (Slofa point to view its information, including a snapshot, live video, and
inspection results.
Related Operations

® Review a point

CIickB to review a point at a time.
® Review multiple points

Select multiple points, and then click Review in Batches to review them at the same time.
® Send an email

Click Send Email to send the results of a point to specified email addresses. You can select the
email addresses of users on the platform, or manually enter them (you must press Enter after
entering an email address). If you want to select the email address of a user, that user must be
configured with one. Also, the email server must be configured on the platform to successfully
send emails. For details, see "3.2.2 Adding User" and "7.4.5 Configuring Email Server",

5.7.5 Searching for Data Analysis

You can view the analysis of temperature data, including temperature and temperature difference.
Procedure

Step1 Login to the DSS Client. On the Home page, cIickE > Intelligent Inspection > Data
Analysis History.

Step2  Configure the search conditions, and then click Search.

Table 5-19 Parameter description

Parameter Description

Select one or more points. When 3 points or less are selected, the
Resources platform can generate a line chart. If more than 3 points are selected, the
data can only be displayed in a list.

Data Type Select temperature or temperature difference.

Time Select a period.
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Temperature Report 00 - 2023-0...

Temperature Analysis
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Figure 5-93 Line chart
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Hover your mouse on the chart to view the data at different time; scroll the wheel button
to adjust the interval between each data.

Figure 5-94 List of data
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Related Operations
® Export data

Inspection Obje... Inspection Orga...
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. Thermal-15

i... Thermal-15

2023-05-25 14:...
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Thermal-15

Thermal-15
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Click Export to export the current data to your computer.
® Present the data in different ways

Click Bl and = to display the data in a line chart or list. A line chart can only be generated
when you search for 3 points or less.

Data Analysis Type
Temperature Data
Temperature Data
Temperature Data
Temperature Data

Temperature Data

2 Bxport

Inspection Analysis Result
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5.8 Maintenance Center

You can view the overall running status of the platform, including server, channel, and device. Clear
view of alert information allows you to locate the alert source and type, and then fix it in time. You
can also update the programs of devices.

5.8.1 Viewing System Status

Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select Maintenance
Center.
Step2  View the status of the system.

o=

Click Generate Report or Export to export the information on the page to your
computer.

® (lick Workstation to view the overall running status of the platform, including the
status of devices on main and sub servers, alert statistics, storage and status of servers.
The data is refreshed every 5 minutes.

® Select Resource Monitoring > Server Status, and then click a server or service to
view its running status and history information, including alerts occurred in the last 7
days and logs generated on the current day. Click View All to jump to corresponding
pages for more information.

® Select Resource Monitoring > Device Status. Click a device type, and then the status
of all the devices are displayed on the right. Click [& to view detailed information.

¢ Channel Status Info : Information such as the channel name, online or offline,
recording days, and video integrity status.

¢ Hard Disk Status Info : If it is a storage device, you can view the information of its

hard disks in this section. CIick to view the RAID information of the hard disks.

¢ History Info : Displays alerts occurred in the past 7 days and logs of the current
day. Click View All to view all information.

5.8.2 Monitoring Network Status

This page displays the network topology of switches, and the devices added to them. Also, you can
configure the parameters of the switches directly on the platform.

Prerequisites

Add managed switches to the platform. Currently, only managed switches manufactured by Dahua
dare supported. For details, see "3.1.2.4 Adding Devices".

5.8.2.1 Viewing Network Topology

View the network topology of switches and the devices added to them.
Procedure

Step1 Loginto the DSS Client. On the Home page, click E and then select Maintenance
Center > Resource Monitoring > Network Status.
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Step2 Click Display Settings.

Step3  Select the display layer and a switch, and then click OK.

The select switch and its devices are displayed in a network topology. Click Device Icon
on the upper-right corner to view the icons for different types of devices in the network
topology.

Related Operations
® Drag

Click and hold to drag the network topology.
® Zoom in and out

Click + and - on the lower-right corner, or rotate the wheel button to zoom in and out on the
network topology.
® Hide devices

Click D below a device to hide the devices added to it.

5.8.2.2 Viewing Device Details

Log in to the DSS Client. On the Home page, click EE] and then select Maintenance Center >
Resource Monitoring > Network Status. Click a device to view its details.

® Devices: You can view its basic information, the switch it is added to, and the alerts from the last
7 days.
® Switches: You can view their information shown below.

Table 5-20 Parameter description

Parameter Description

Displays the basic information, such as the

Device Details .
model, name, and serial number.

Displays the CPU and memory usage. The

Device Usage information is refreshed every 10 s.

Device Details

Displays the alerts occurred in the past 7
Alert Info from Last 7 Days days. For how to configure alerts, see
"4.11.1 Configuring Alert Rule".

Displays total PoE power at the moment,
and the peak PoE power from the last 7
days. The information is refreshed every 10
s.

PoE Power Info

PortInfo Click a port to view its details. The

Port Details information is refreshed every 10's.

Displays the information of devices added

Neighbor Info to the selected port.
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5.8.2.3 Configuring Switch

You can configure the parameters of switches directly on the platform, such as IP addresses, alarms,
and port functions.

Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select Maintenance
Center > Resource Monitoring > Network Status.

Step2 Click a switch, and then click E’] on the upper-right corner.
Step3  Configure the parameters you need, and then click Apply.

Table 5-21 Parameter description

Parameter Description

IP Address This information is configured manually by default.
Subnet Mask You can click B8 to enable the DHCP function so that
the switch can obtain the information automatically.

Gateway
Basic
Preferred DNS This information is configured manually by default.
You can enable the switch to automatically obtain
Alternate DNS this information after you enable it to obtain an IP
address automatically.
When the devices added to the switch are notina
Loopback Alarm o
loop, an alarm is triggered.
IP Conflict When the IP addresses of the switch and the devices
added to it are in conflict, an alarm is triggered.
When the RX port utilization or TX Port utilization is
Alarm Config Port Congested larger than the defined threshold, an alarm is

triggered.

The threshold ranges from 0-100, and the unit is

Port Congested Alert percentage. For example, the threshold is set to 50. If
Threshold the RX port utilization or TX Port utilization is larger
than 50%, an alarm is triggered.
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Parameter Description

® Port Status : Enable or disable the port. If
disabled, the port will not work.

® Network Flow Control : When the network flow
received by the port is faster than the port speed,
the switch will send a message to the sender. The
sender will then adjust its network flow to be
slower than the port speed. For example, when
the sender is sending data at 90 Mbps toa 10
Mbps port, the sender will then send data slower
than 10 Mbps.

® Port Speed : Configure the speed for the port to
receive and send data.

® Duplex Mode:

< Full Duplex : The port can send and receive
data at the same time.
Port Config ¢ Half Duplex : The port can only send or
receive data at the same time.
¢ Auto Negotiation : Automatically enable full
duplex or half duplex based on available
resources.
® PoE Status : After enabled, the port can power
devices that support PoE.
® PD Alive : When the port cannot communicate
with the devices, it will automatically check and
restart the devices to ensure that they work
normally. This is useful to reduce maintenance
workload.
® Long-distance Transmission : The port can
transmit data to devices from up to 100 m. After
enabling this function, the distance is increased to
250 m, but the speed is lowered to 10 Mbps.

Related Operations
On the Device Details page, you can restart switch or restore its parameters.
L : Restart the switch.

L E: Restore all parameters to their default settings, except for IP address, subnet mask, DNS
servers, and default gateway.

° : Restore all parameters to their default settings, including IP address, subnet mask, DNS
servers, and default gateway.

5.8.2.4 Exporting Network Information

Export the current network topology and device list to your computer.
Procedure

Step1 Login to the DSS Client. On the Home page, click EE] and then select Maintenance
Center > Resource Monitoring > Network Status.

Step2 Click Export, and then select Export Network Topology Image or Export Device List.
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5.8.3

5.8.3.1

Step3  Enter the login password and configure an encryption password, and then click OK.

Maintenance Management

You can view and process alerts, view analysis reports of the system running situation, and update
the programs of devices.

Viewing and Processing Alert

When alerts are triggered, you can view their information and process them. Also, notifications will
be provided to inform you and quickly direct you to this page when they are triggered.

Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select Maintenance
Center > Maintenance Management > Alerts.

N

Step Click an alert, and then its information is displayed on the right.

w

Step Process the alert.

1. Click Accept on the bottom of the page.

2. Enter a name for the person who processed the alert, and the troubleshooting log, and
then click Save.

Related Operations

5.8.3.2

® Export the details of an alert

On the bottom of the information of the alert, click Download Report. Enter the login password
and encryption password to export the information to your computer.
® Export alert list

Click Export on the upper-left corner of the page, enter the login password, encryption
password, and then select the export range and format to export them to your computer.

® Add an alert to favorites

Click |:| of an alert to add it to favorites.
® Filter the alerts

Click Filter, and then you can filter the alerts by time, resource type, alert type, priority, and alert
status.

® Sort the alerts

Rearrange the alerts by time in the descending or ascending order.

Viewing, Downloading and Sending Analysis Report

The system will generate analysis report when it is running. You can download it to your computer,
or send it immediately or at the defined time to specified email addresses

Log in to the DSS Client. On the Home page, click EE] and then select Maintenance Center >
Maintenance Management > Analysis Report. The analysis report within the past 7 days is
displayed by default.

® View analysis reports with specified content

Click Search by Tag on the upper-right corner of the page to generate a report by time,
resource type, alert type, and alert priority. An analysis report of up to 30 days can be generated.
® Download an analysis report
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Click Download Report, enter the login password and encryption password, and then select the
content to be exported to download it to your computer.
® Send an analysis report to one or more email addresses

Click Send Report to send it to one or more specified email addresses immediately or at the
defined time.

¢ Send Now : Send the information in Body and selected information to the specified email
addresses immediately.

¢ Auto Send : Send the information in Body and selected information to the specified email
addresses daily, weekly, or monthly.

Daily report: Data from yesterday will be sent to your email at a defined time. If set to
03:00:00, the data from the day before (00:00:00-23:59:59) will be sent to your email at
03:00:00 every day.

Weekly report: Data from last week will be sent to your email at a defined time. If set to
03:00:00 on Wednesday, the data from Wednesday to Tuesday of each week will be sent to
your email at 03:00:00 every Wednesday.

Monthly report: Data from last month will be sent to your email at a defined time. If set to
03:00:00 on 3rd, the data from 3rd of last month to 2nd of the current month will be sent to
your email at 03:00:00 on 3rd of each month.

5.8.3.3 Updating Device Program

Add a plan to update the programs of selected devices in batches.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EE] and then select Maintenance
Center > Maintenance Management > Device Update.

Step2  Click Add.
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Figure 5-95 Add an update plan

9 Add Update Plan

Basic Info

Plan Name:

Update Plan

Select Device

L
m

Device Model Program Version Operation

yuntai

o 0 0 0 0 0 0 O

Step3  Enter a name for the plan, and then select the device category, type, model, and program
version.
The platform will only display corresponding devices.

Step4  Select the devices you want to update.
@

Click E to cancel selecting all devices.
Step5 Configure when to update the devices.

® Now : Update the devices immediately after the plan is added.
® Custom : Update the devices at the defined time.

Step6 Click Upload File to upload the update program.

A\

® Make sure that the uploaded program matches the models and current program
versions of selected devices.

® Make sure that the network is stable and the power properly connected for all devices.
Otherwise, they might not work properly.

Step7 Click OK.
Related Operations

In the list of update plans, you can view the information of each plan, including name, update
program, update start time, and update status.

L] CIickE to delete a plan one by one; select multiple plans, and then click Delete to delete them
in batches.
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® (lick to view the update status of the devices in a plan.
¢ Click E to remove a device from the plan; select multiple devices, click Delete to remove
them in batches.

¢ If one or more devices failed to update, click E] to update a device again one by one, or
select multiple devices, and then click Update Again to update them in batches.
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6 General Application

6.1 Target Detection

View and search for the metadata of people, vehicle, and non-motor vehicle.

Target detection can be done by video metadata cameras + a platform, or IPCs + IVSSs + platform.
6.1.1 Typical Topology
Figure 6-1 Typical topology
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® General cameras record videos.

® Video metadata cameras such as panoramic + PTZ camera record videos and analyze people,
and motor and non-motor vehicles.

® |VSS manages cameras and analyzes people, and motor and non-motor vehicles.

® The platform centrally manages IVSS and cameras, receives analysis results from cameras and
displays the reports.

6.1.2 Preparations

Make sure the following preparations have been completed:

® Cameras and IVSS are correctly deployed, and video metadata is enabled on them. For details,
see corresponding user’s manuals.

® Basic configurations of the platform have been finished. To configure the parameters, see "3
Basic Configurations".

¢ When adding a camera or IVSS, select Encoder for device category.

¢ After adding the camera or IVSS to the platform, select Target Detection from Features of
the device.
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6.1.3 Live Target Detection

Procedure

Step1 Login to the DSS Client. On the Home page, click E, and then select Monitoring
Center > Monitor.

Step2  Select a window, double-click the channel or drag the channel to the window.

Figure 6-2 Live view
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Step3  Click E] and then cIickE to view live metadata events.
Step4  View live video, and human body, vehicle, and non-motor vehicle information.

® (lick an event record to view the event snapshot. You can play back the video of the
event. Different events support different operations.

® When playing back video, click =5 to download the video to a designated path.
® (lick K54 to play back the video before and after the snapshot.

® (Click E to delete event information.

® (lick E to view the most recent events.

6.1.4 Searching for Metadata Snapshots

Search for metadata snapshots by setting search criteria or uploading images.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EE| and then select DeepXplore.

Step2 Click .
Step3  Set search criteria.
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You can search for metadata snapshots in the Record , Person or Vehicle section. For
details, see "5.3 DeepXplore".

6.2 ANPR

View automatic number plate recognition in real time or search for records. You can view the
moving track of a vehicle. This is useful for road monitoring.

® Automatic number plate recognition

The platform displays vehicle snapshots and ANPR results in real time.
® Vehicle records

Search for vehicle records according to the filtering conditions you have set.
® Vehicle track

According to the ANPR camera locations that a vehicle has passed through, the platform
displays the driving track of the vehicle on the map.

6.2.1 Typical Topology

Figure 6-3 Typical topology
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® ANPR cameras (ITC camera) capture and recognize vehicles.

® DSS centrally manages ANPR cameras, receives and displays vehicle snapshots and information
uploaded from the cameras.

6.2.2 Preparations

Make sure that the following preparations have been made:

® ANPR cameras are added to the platform, and the ANPR function is configured. For details, see
corresponding user’s manuals.

® Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".

¢ When adding an ITC camera, select ANPR for device category, and then select ANPR Device
for Device Type.
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¢ ANPR snapshots are only stored on ANPR Picture disks. On the Storage page, configure at
least one ANPR Picture disk. Otherwise vehicle pictures cannot be viewed.

6.2.3 Live ANPR

View ANPR live video and plate snapshots.
Procedure

Step1 Loginto the DSS Client. On the Home page, click 8, and then select Monitor Center >
Monitor.

Step2  Select a window, double-click the channel or drag the channel to the window.

Figure 6-4 Live view

Resources

-

Step3 Click E] and then click Bl
Step4  View live ANPR events.

® (lick an event record to view event snapshots. You can also play back the video of the
event. Different events support different operations.

® [&] This function is only available when a license plate is recognized. Click this icon to
add the vehicle to an arming group. After you send the group to devices and
configure an event, devices can trigger alarms when the vehicle is recognized.

o : Add the vehicle to the platform.

® When playing back a video, click &£l to download the video to a designated path.
® (lick K54 to play back the video before and after the snapshot.

® (lick E to delete event information.

® (lick E to view the most recent events.
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6.2.4 Searching for Vehicle Snapshot Records

If there are recorded videos on devices, you can view recorded videos linked to the capture records
by searching for them. Each video will be 20 s long, with 10 s before and after the time of capture.
When playing a video, it will start at 10 s before the time of capture.

Procedure

Step1 Login to the DSS Client. On the Home page, click EE| and then select DeepXplore.

Step Click .
Step Configure the search conditions.

w N

You can search for vehicle snapshots in the Record or Vehicle section. For details, see
"5.3 DeepXplore".

6.3 Face Recognition

Configure face recognition settings on the device and the platform before you can view face
recognition results on the platform.

6.3.1 Typical Topology

The face recognition feature is available on select models of NVR, IVSS and FR cameras.

® Face recognition by NVR/IVSS
Figure 6-5 Typical topology (NVR/IVSS)

Network Cable

DSS NVR/IVSS

\] Switch
‘5 ‘_5 o °
IPC IPC Speed Speed
Dome Dome

¢ Cameras record videos.
© NVR/IVSS is used for face recognition and storage.
¢ DSS centrally manages cameras, NVRs, and the face database, and provides live view and
face search.
® Face recognition by camera
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Figure 6-6 Typical topology (camera)

Network
[, - — [ Cable
DSS
‘ Switch ‘

IPC IPC IPC IPC

¢ Cameras record face videos, and detect and recognize faces.

¢ DSS centrally manages cameras, NVRs, and the face database, and provides live view and
face search.

6.3.2 Preparations

Make sure that the following preparations have been made:

® Face recognition devices are correctly configured. For details, see corresponding user’s manuals.

® Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".

¢ When adding face recognition devices, select Encoder for device category.

¢ After adding a face recognition NVR or IVSS, select Face Recognition for Features of the
corresponding channels.

¢ After adding face recognition cameras or face detection cameras, select Face Recognition
or Face Detection for Features.

¢ Face snapshots are stored in the Face/Alarm and Other Pictures disk. Configure at least
one local disk for picture storage. Otherwise, the platform cannot display snapshots.

6.3.3 Arming Faces

Before arming faces, you need to add the persons to face recognition group. For details, see "4.4.1
Face Arming List".

6.3.4 Live Face Recognition

Procedure

Step1 Loginto the DSS Client. On the Home page, click B, and then select Monitor Center >
Monitor.

Step2  Select a window, double-click the channel or drag the channel to the window.
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Figure 6-7 Live view

Resources

—
cesfloapu et

IPC18:

Step3 Click E] and then click E to view live face recognition information.
Step4  View live video, and human body, vehicle, and non-motor vehicle information.

® (lick an event record to view event snapshots. You can play back the video of the
event. Different events support different operations.

L : Add the person to the platform.

L E; Add the face to an arming group. After you send the group to devices and
configure an event, devices can trigger alarms when the face is recognized.

® When playing back video, click to download the video to designated path.
° CIick to play back the video before and after the snapshot.

° Cllck to refresh events; cI|ck to pause refreshing.
® (lick E to delete event information.

® (lick E to view the most recent events.

6.3.5 Searching for Face Snapshots

Search for face snapshots by setting search criteria or uploading images.
Procedure

Step1 Loginto the DSS Client. On the Home page, click E, and then select DeepXplore.
Click .

Configure the search conditions.

v [N
~ |
F%
w N

You can search for vehicle snapshots in the Record or Person section. For details, see "5.3
DeepXplore".
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6.4 POS

View POS live video and records.
® |iveview

View live POS video and the transaction details overlapped on the video.
® Playback

Search for POS transaction records and play the recorded video. The POS video clip can start 10
seconds before or after the POS receipt printing.

6.4.1 Typical Topology

Figure 6-8 Typical topology

Network
Cable
pss
Switch ‘
Rl
NVR IPC IPC POS Machine

® (Cameras record videos of each POS transaction.

NVRs are connected with cameras and POS machines, and store videos.

® POS machines record transaction details and generate receipts. They connect to the platform
through NVRs.

® The platform centrally manages NVRs and cameras, and provides live videos and POS
transaction video records.

6.4.2 Preparations

Make sure that the following preparations have been made:

® Cameras, NVRs and POS machines are correctly configured. For details, see the corresponding
user’s manuals.

® Basic configurations of the platform have been finished. To configure, see "3 Basic
Configurations".

¢ When adding an NVR, select Encoder for device category.
¢ At least one POS channel is connected to NVR.

On the Bind Resource page, bind video channels to the POS channels. See "3.1.3 Binding
Resources".
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6.4.3 Setting POS End Sign

Procedure

tep1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter.

d

Step2  Click the POS End Sign tab.
Step3  Setthe end line of POS receipt.

Step4  Click OK.

6.4.4 POS Live View

View real-time POS transaction video and details.

Prerequisites
Make sure that the POS channel has been bound to video channel. For details, see "6.4.4 POS Live
View".

Procedure

Step1 Login to the DSS Client. On the Home page, click 8, and then select Monitor Center >
Monitor.

:

Step2 Inthe POS listin the Resources section, select a channel, device or organization, double-
click or drag it to the window.

Figure 6-9 POS video

Resources

*

=
» =

» B3 LMMSY

IPC-1214

¥ B3 NVR182.1

B post

Step3  (Optional) Set POS information style.
1. Right-click and select Set POS Style.
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Figure 6-10 POS style setting

Cancel

2. Set Overlap Pattern, Font Size, Background Transparency and Font Color.

3. Point to POS information overlay area, press mouse left button and move it to adjust
POS information overlay position.

4. Click OK.

6.4.5 Searching for POS Receipts

Search for POS receipt to view related video of receipt. You can search for the video half an hour
before and half an hour after the time when POS receipt is printed, and you can start to play video
30 s before the time when POS receipt is printed.

Procedure
Step1 Loginto the DSS Client. On the Home page, click B, and then select DeepXplore.
Step2  Click &,
Step3  Select channel and time, select POS Record , and then click Search.
Step4 Double-click a POS record to view its details.

® When viewing recorded videos, you can select a target manually or select one
automatically recognized by AcuPick, and then search for it in DeepXplore.

® |f the channel is bound to other video channels, hover the mouse on the video to view
the recorded video from the bound video channels.
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Figure 6-11 View recorded videos from bound video channels
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7 System Configurations

This chapter introduces system parameters configuration, license, service management, and
backup and restore.

7.1 System Deployment

The platform supports managing server information and adjusting the upper-level server of a
server or device.

7.1.1 Distributed Deployment

Background Information

Set the server type, and assign devices to different servers.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the System Config
section, select System Deployment.

Step 2
Step 3
°
°
°
°

G Refresh  ah
Server Name
18 19

19

=
Click k==,

Manage servers.

Click o view server details.

Click E corresponding to a server to define the server type. A server can be set to sub
server or standby server when it is not in use.

Click Il to enable the server. Bl means the server is enabled.

Click E to delete the server.

Figure 7-1 Servers

IP Address Server Status Operation

o

— 80

Step4  Assign devices to different servers.

Manually

Click Allocate Resources, and then select devices or channels on the left side, and
drag them to the server on the right. The number of corresponding devices in the
target server increases, and the devices in the original server reduces.

¢ Click Default, the servers are sorted in the order in which they were added.
¢ Click Sort By Device Quantity, the servers will be sorted by the number of devices.
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Figure 7-2 Resource allocation

9 Allocate Resources

All Device Refres 2, AutoDistribution () Default 1l SortByD

= (11)

® Automatic allocation
Allocate the same type of devices evenly to different servers.

Click Auto Distribution.
Select Device Type. Multiple types are supported.

Select the server to which the devices belong. Multiple servers can be selected.
Click OK.

HwnN =

Figure 7-3 Auto allocation

O Default 1[. Sort By Device Quantity

Auto Distribution

Device Type| | Encoder, ANPR DeviceAccess,Emer... ™

Distribute devices evenly to selected server.
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7.1.2 Cascade Deployment

Cascade deployment allows you to add a lower-level platform to an upper-level platform. After
cascading, you can view the live video and recorded video of the lower-level platform from the
upper-level platform. Also, you can display the videos on the lower-level platform on wall from the
upper-level platform. 3 levels can be added at most.

Prerequisites
Make sure that the deployment of all relevant platforms has been completed.
Background Information

® You need to configure the lower-level platform information on the upper-level platform.
® Supports adding DSS Express to lower-level platform.

Procedure
Step1 Login to client of the upper-level DSS platform. On the Home page, click EY and thenin
the System Config section, select System Deployment.
Step2  Click 2l
Step3  Click Add, and then configure parameters.
Step4  After configuration, click OK.
Figure 7-4 Add cascade
9 Add Cascade
MName: Organization:
Root

IP Address | Domain:

Username: Password:

Remarks:

Table 7-1 Description of cascade parameters

Parameter Description
Name The name that identifies the platform to be added.

The organization that the added (lower-level) platform belongs to. The
Organization devices and channels of the added platform can be viewed on the upper-
level platform from the organization that you have defined.

IP Address/Domain | The |P address or domain name, and the port of the added (lower-level)
Port platform.
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Parameter Description
Username The username and password for logging in to the added (lower-level)
Password platform.

7.2 License Information

Log in to the DSS Client. On the Home page, click , and then in the System Config section,

select License.

Click [ of an activation code to view its details, such as time of activation and resources you can
connect to the platform.

7.3 License

The system controls channel and function availability through the license. User can buy a license
according to the channels and functions as needed.

|

The platform is unlicensed by default after being deployed.

License Types

® Trial

A trial license is limited in capacity and expires in 90 days.

® Paid

To acquire full control of the features and permanent use, you need to buy a formal license.
After activating the first paid license, if you want to increase your license capacity, you can buy
more license codes. For example, if you have 500 channels currently, you can buy another 500
channels. After activating the new 500 channels, you will have 1,000 channels in total.

® Unlicensed

Lack permissions to use the system. This occurs after deactivating.

For expired trial version and unlicensed version, all modules are displayed as unauthorized,
except for the resources, license, tools, and management modules.

Activation Methods

® Normal online activation

When the platform server is connected to the Internet, it can connect to the license server,
which supports online license activation by verifying the activation code.
® Normal offline activation

When the platform server is on a local area network, it cannot connect to the license server. You
need to obtain the license file from a computer with Internet access, and then import the license
file to the platform to activate it.

® Upgrade from DSS Express to DSS Pro
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¢ Online activation

When the platform is upgraded from Express to DSS Pro, and the original Express has a
purchased license, and the platform server has Internet access, you can activate through
verifying the new activation code and Express activation code (or importing Express
deactivation file).

¢ Offline activation

When the platform is upgraded from Express to DSS Pro, and the original Express has a
purchased license, the platform server cannot visit the license server. You can activate
through verifying the new activation code and Express activation code (or importing Express
deactivation file) and then importing the license obtained from a computer with Internet
access.

7.3.1 Activating License

You can get the desired features or number of channels only after you load the corresponding
license.

For details about activating a license, see "2.1.6.2 Activating License".

7.3.2 Deactivating License

After deactivation, the platform will be unauthorized. A deactivated license can be activated again
on other servers, allowing users to change servers. The license can be deactivated with online and
offline deactivation. If the server is connected to the network, use online deactivation. Otherwise
use offline deactivation.

7.3.2.1 Online Deactivation

Background Information
Select this method if your platform sever is connected to a network.
Procedure
Step1 Login tothe DSS Client. On the Home page, click EY and then in the System Config
section, select License.

Step2 Inthe Deactivate License section, click Online Deactivate License.
1]

The license is reusable. We recommend copying the license code by clicking Bl and then
saving it locally.

Step3  Click Deactivate Now, and then follow the onscreen instructions to finish deactivation.

Figure 7-5 Online deactivation

9 Deactivate License
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7.3.2.2 Offline Deactivation

Background Information

Select this method if your platform server has no Internet access.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select License.

Step2 Inthe Deactivate License section, click Offline Deactivate License.

Figure 7-6 Offline deactivation

O Deactivate License

Step3  Click Export to export and save the license deactivation file locally.

A\

After the license deactivation file is exported, the platform will become unauthorized, and
you cannot use any function.

Step4  Move the request file to a computer with Internet access. On that computer, open the
system email that contains your license, and then click the attached URL go to the license
management page.

Step5 Select DSS > Deactivate License.

Step6  Upload the license request file obtained from Step 3, and then follow on-screen
instructions to finish the process.

7.4 System Parameters

Configure security parameters, storage retention duration, email server, time sync, remote log,
login method, and more.

7.4.1 Configuring Security Parameters

Log in to the DSS Client. On the Home page, click EY and thenin the System Config section, select
System Parameter > Security Parameter, and then configure the parameters.
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Table 7-2 Parameter description

Parameter

Description

Certificate Management

A CA certificate is used to validate the legitimacy of the platform.
When accessing the platform through a browser, the browser
will validate the certificate. If the certificate is installed in the
browser, the browser will consider the platform as secure, and
will grant it access. If the certificate is not installed in the
browser, the browser will not consider the platform as secure,
and will not grant it access. You can create, import, and
download certificates on the platform.

® (reate a certificate: After creating a certificate, import it to the
computer that will access the platform.

® |mport a certificate: You can import a certificate that has been
created to the platform.

File Security Policies

Protect your data by verifying login password when download or
export information, and encrypting the export files.

® File Export or Download Password Authentication :

¢ You need to enter the password of the current account to
export or download files.

¢ For all users that log in to the platform, they do not need
to enter the password when exporting or downloading
files.

® File Export and Download Encryption : You need to set an

encryption password for files to be exported or downloaded.

When anyone uses the files, they need to verify the

encryption password.

HTTP Allowlist

After the firewall of the server is enabled, you need to add the IP
address of the computer where the DSS Client is installed to the
HTTP allowlist so that it can access the server.

RTSP Redirecting Allowlist

After the firewall of the server is enabled, only the IP addresses in
the RSTP allowlist can request video stream through the media
gateway service. The IP addresses of decoders will be added
automatically. If there are other IP addresses that need to request
video stream through media gateway service, you need to
manually add them to the RSTP allowlist.

7.4.2 Configuring Retention Period of System Data

Set the retention periods for various types of records. The expired records will be automatically

deleted.
Procedure

Step1 Loginto the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter.

0" [n
~ |~
D [
w IN

Click Message Retention Period.
Double-click a number to change its value.
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Figure 7-7 Change the retention period

Message Retention Period

Message Type Retention Period (Month)
Logs | 4

Alarm Records 6

Step4  Click Save.

7.4.3 Time Synchronization

Synchronize the system time of all connected devices, PC client, and the server. Otherwise the
system might malfunction. For example, video search might fail. The platform supports
synchronizing the time of multiple devices, which have the same time zone as the platform. You
can synchronize the time manually or automatically.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter.

Step2  Click the Time Sync tab. Enable the sync methods, and then set parameters.

Figure 7-8 Enable time synchronization
Time Sync

Device Time Sync:

Scheduled Time Sync:

Start Time: Sync Interval:

Hour(s)

Sync Time Now

NTP Time Sync: . —®

NTP Address:

Sync Interval:

Min(s) (1-1440)

® Scheduled Time Sync: Enable the function, enter the start time in time sync for each
day, and the interval.

® Sync Time When Device Comes Online: Syncs device time when the device goes
online.

® NTP Time Sync: If there is an NTP server in the system, you can enable this function to
let the system enable time with the NTP server.

Step3  Click Save.
Step4  (Optional) Enable time synchronization on DSS Client.
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1. Login to the DSS Client, and then in the Management section, click Local Settings.
2. Click the General tab, select the check box next to Time Sync, and then click Save.

The system immediately synchronizes the time after you restart the client to keep the
time of the server and the PC client the same.

Figure 7-9 Enable time sync

General

Display

It Client Size

in client and event records

. Display liv humbnails whel r channels on th.

Start and Login

3. Restart the client for the configuration to take effect.

7.4.4 AcuPick

Configure the parameters of AcuPick so that it can work normally.

Prerequisites

Purchase a license with the AcuPick function, and then activate the license. For details, see "2.1.6
Licensing".

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter.

Step2  Click the AcuPick tab.
Step3  Select a comparison method. If central intelligence is selected, you need to configure the
parameters shown in the following table.
® Edge Intelligence : After you select a target, you can only search for it on one device
that supports search by image at a time.
® (Central Intelligence : You can search for the target you select on multiple devices.
Table 7-3 Parameter description
Parameter Description
IP/Domain Name Enter the IP address or domain name, and the port number
Port of the server deployed with the AcuPick algorithms.

299



a/hua

TECHNOLOGY User's Manual

Parameter Description

Click i8lto copy the identity certificate and secret key, and
then configure them to the DSS server. For details, see
"2.1.4 Management Tool".

Identity Certificate/Secret Key
w

Click £ to generate a new secret key.

Click the button to check if the function is working
normally. If not, address the issue prompted by the
platform, and then check again. Repeat the steps until it
can work normally.

Test AcuPick Function

Step4 Click Save.

7.4.5 Configuring Email Server

Procedure
Step1 Loginto the DSS Client. On the Home page, click EY and then in the System Config

section, select System Parameter.

Step2  Click the Email Server tab, enable Email Server, and then configure parameters as
required.

Figure 7-10 Set email server

Email Server  —®

Sender Email Address: Password:

Encryption Method:

TLS
Test Recipient:

Email Test

Table 7-4 Description of email server parameters

Parameter Description

Select according to the type of SMTP server to be connected. The

SMTP Server Type types include Yahoo , Gmail, Hotmail, and UserDefined.
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Parameter

Description

Sender Email Address

The sender displayed when an email is sent from DSS.

SMTP Server

Password

Port

IP address, password, and port number of the SMTP server.

Encryption Method

Supports no encryption, TLS encryption, and SSL encryption.

Test Recipient

Email Test

Set the recipient, and then click Email Test to test whether the
mailbox is available.

Step3  Click Save.

7.4.6 Configure Device Access Parameters

To ensure that you can safely use the devices, we recommend using the security mode if devices
support this mode to avoid security risks. The platform also supports enabling and disabling adding

devices through P2P.
Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter > Device Adding Config.

N

Step Select a device login mode, and then click Save.

w

Step Enable or disable the P2P function.

If disabled, you cannot add devices to the platform through P2P.

7.4.7 Customizing POS End Sign

Configure the sign that prompts the end of a POS receipt.

Procedure

wn
—
[}

—_

Log in to the DSS Client. On the Home page, click EY and then in the System Config

section, select System Parameter.

wv |
~+ |+
FP
w N

Click the POS End Sign tab.
Enter the POS end sign, and then click OK.

Figure 7-11 POS end sign

POS End Sign

POSEnd

| Thank You!
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7.4.8 Remote Log

To ensure safe use of the platform, the system sends administrator and operator logs to the log
server for backup at 3 A.M. every day.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter.

Step2  Click the Remote Log tab.
Step3  Enable the function, and then set parameters as required.

The Platform No. must be the same on the remote server and the platform.

Figure 7-12 Enable remote log

Remote Log —®

IP Address:

Platform MNo.:

2

Step4  Click Save.

7.4.9 Configuring Active Directory

When the users in a domain can be used as users on the platform, you can use this function to
import quickly them to the platform.

Procedure
Step1  Configure the domain information.

1. Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameter > Active Directory.

Click - to enable the function, and then configure the parameters of the domain.
Click Get DN to automatically get the basic DN information.

Click Test to check whether the domain information is correct.

(Optional) Enable the automatic synchronization function and set a time. Then, the
platform will automatically synchronize news users in domain groups that you have
imported previously, and update the information of the users imported by manual
selection at the defined time every day.

vk W
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For example, you have imported the entire domain group A. The platform will

synchronize new users in domain group A every day at the defined time. CIickE] to
remove a group on the list, and then it will not be synchronized. For users imported by
manual selection, the platform will check their information, and update if anything
changes.

6. Click Save.
Import domain users.

1.

Log in to the DSS Client. On the Home page, click EY and then in the Basic Config
section, select User > User Management.

Click Import Domain Users.

Select how you want to import users, and then click Next Step.

® |mport by Domain Group : Import all users in the selected group.

©=n

If you import an entire domain group and after the automatic synchronization
function is enabled, the platform will remember that group and automatically
synchronize its new users at the defined time every day. For details, see the
previous steps.

® |mport by Domain User : Import selected users in a group.

Click s to select a role for the users.

All the permissions in the role will be assigned to the users.
Click OK.

7.4.10 Configuring Independent Database

The platform supports connecting to an independent database and storing data in it, including face
images, video metadata, events, and ANPR information. Only official licenses support this function.

Prerequisites

You have prepared a ready-to-run database. Please note that the name of the database must be
ExternalindependentDB. Otherwise, data will not be properly stored to the database.

Procedure

Log in to the DSS Client. On the Home page, click EY and thenin the System Config
section, select System Parameter.

Click the Independent Database Deployment tab.

Click - to enable the function, and then configure the parameters.

303



@Z@ya User's Manual

Figure 7-13 Configure the independent database

Independent Database Deployment ' —®

Database Type:

Mysaql

Username: Password:

Table 7-5 Parameter description

Parameter Description

Database Type Only supports MySQL.

IP Address Enter the IP address of the database.

Port Enter the port of the database.

Username/Password Enter the username and password used to log in to the database.

Step4  Click Save.
1]

An independent database can only connect to one platform.
Results

After an independent database is deployed, face images, video metadata, events, and ANPR
information will only be stored in the independent database, and will not be stored in the local
database anymore. Also, when you search for these 4 types of data, the platform will only search
the independent database. The data that was previously generated in the local database will not be
available for the search.

7.4.11 Configuring Push Notification for App

If you need to send messages to App, you must enable this function. After enabled, messages will
be sent to App through the servers of push notification providers. Data related to these messages
will not be sent back to us.

Procedure

Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select System Parameters > Mobile App Config.

Step2  Enable or disable push notification.

If disabled, the App will not receive any messages, such as alarms and calls.
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7.5 Backup and Restore

The platform supports backing up configuration information and saving it to a computer or server,
so that you can use the backup file for restoring settings.

7.5.1 System Backup

Use the data backup function to ensure the security of user information. Data can be manually or
automatically backed up.

® Manual backup: Manually back up the data, and the DSS platform will save it locally.

® Automatic backup: The DSS platform automatically backs up the data at a defined time, and
saves it to the installation path of the platform server.

Procedure
Step1 Login to the DSS Client. On the Home page, click EY and then in the System Config
section, select Backup and Restore.
Step2  Click the Backup tab.
Step3  Back up data.

® Manual backup: In the Manual Backup section, select the data saving path, click
Backup Now. The Login Password is the same as the system user's. Create an
Encryption Password to protect data.

Figure 7-14 Manual backup

Auto Backup

nber of Backup Files:

Backup Confirmation

Period:

Backup by day

Login Password:
Time:

- a

0 : 00 : 00

Encryption Password:

Confirm Encryption Password:
Manual Backup

Backup Path:

® Auto backup: In the Auto Backup section, configure backup parameters, and then
click OK. The Login Password is the same as the system user's. Create an Encryption
Password to protect the data. The platform automatically backs up data according to
the defined time and period. The backup path is the installation path of the platform
server by default.

- Can‘:E‘
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Max Number of Backup Files means you can only save defined number of backup
files in the backup path.

Figure 7-15 Auto backup

Auto Backup

Backup Confirmation

Confirm Encry,

7.5.2 System Restore

Restore the data of the most recent backup when the database becomes abnormal. It can quickly
restore your DSS system and reduce loss.

® | ocal Restore: Import the backup file locally.
® Server Restore: Select the backup file from the server.

A\

® Users must not use the platform when you are restoring the configurations.
® Restoring the configurations will change the data on the platform. Please be advised.

Procedure

Step1 Login to the DSS Client. On the Home page, click , and then in the System Config
section, select Backup and Restore.
Step2  Click the Restore tab.

Step3  Restore data.

® Restore from local backup file: In the Restore from Local Backup File section, select
the backup file path, click Restore Now, and then enter the passwords (the Password
is the same as the system user's. The Encryption Password is the one created when
the file was backed up).
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Figure 7-16 Local restore

Restore from Local Backup File

~ Local Restore
System very File: |£
g Username:

Encryption P

d fance

® Restore from backup file on the server: In the Restore from Backup File on the

Server section, click , enter the passwords (the Password is the same as the
system user's. The Encryption Password is the one created when the file was backed
up), and then click OK. After restoration, the platform will automatically restart.

Figure 7-17 Restore from backup files on the server
Restore from Backup File on the Server

Backup Time File Size(kb) Qperation

2021-04-10 15:00:29

Restore from Local Backup File

ed to enter the corresponding pa rd to restore the

You can click E to download the backup file.
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8 Management

8.1 Managing Logs

View and export operator logs, device logs and system logs, and enable the service log debug
mode for troubleshooting.

8.1.1 Operation Log

View and export logs that record users' operations, such as viewing the real-time video of a

channel.
Procedure
Step1 Loginto the DSS Client. On the Home page, select Management > Logs > Operation
Logs.
Step2  Select one or more types of logs.
Step3  Specify the time and keywords, and then click Search.

Up to 1 month of logs can be searched for at a time.
Step4 To export the logs, click Export and follow the on-screen instructions.

8.1.2 Device Log

View and export logs generated by devices.
Procedure

Step1 Login to the DSS Client. On the Home page, select Management > Logs > Device Logs.
Step2  Select a device and time, and then click Search.
Step3  To export the logs, click Export and follow the on-screen instructions.

8.1.3 System Log

View and export logs on how the platform has been running, such as a system error.
Procedure

Step1 Login tothe DSS Client. On the Home page, select Management > Logs > System
Logs.

Step2  Select atype of logs.

Step3  Specify the time, and then click Search.
Up to 1 month of logs can be searched for at a time.

Step4  (Optional) Click Export and follow the on-screen instructions.
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8.1.4 Service Log

Services will generate logs when they are running. These logs can be used for troubleshooting. If
you need even more detailed logs, enable the debug mode so that the platform will generate

detailed logs.
Procedure
Step1 Loginto the DSS Client. On the Home page, select Management > Logs > Extract
Service Logs.
Step2  Click =dto download the logs of the service within a specified period to your computer.
Step3  (Optional) Click lll to enable the debug mode of a service, and then click 2 to

download the detailed logs within a specified period to your computer.
[

After the debug mode is enabled, the platform will generate a large amount of logs that
occupy more disk space. We recommend you disable the debug mode after you have
finished troubleshooting.

8.2 Download Center

You can download videos stored on the server or the device. They can be saved in are in .dav
(default), .avi, .mp4, or .asf formats. For H.265 videos, they can only be saved in .dav formats. To
download a video, you can:

® Select a duration on the timeline.

® Download videos by files. The system will generate files every 30 minutes from the time the
video starts. If the video does not start on the hour or the half hour, the first file will start from
the earliest start time to the half hour or the hour. For example, if a video starts from 4:15, the
first file will be from 4:15 to 4:30.

® Download a period before and after a tag.

® Download a video defined by a locking record.

The maximum size of a video file is 1024 MB by default. You can change it to control how many files
will be generated when you download a video by timeline or tag. For details, see "8.3.5 Configure
File Storage Settings".

8.2.1 By Timeline or File

Procedure

Log in to the DSS Client. On the Home page, select Management > Download Center >
Download Video.

Configure the search conditions, and then click Search.
Download videos.

L1

By default, you need to verify your password and configure an encryption password
before download. You can configure whether to verify the password. For details, see
"7.4.1 Configuring Security Parameters".

® Download a video by selecting a duration on the timeline.
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o=t

If you set the Search Type of Device Video Stream to Main Stream and Sub Stream
1, you can download videos recorded in main stream or sub stream for videos stored
on devices. For details, see "8.3.2 Configuring Video Settings".

1. Click the Timeline tab, and then select a period on the timeline.
2. On the pop-up page, adjust the length of the video.
3. (Optional) Click Il to select a format of the video. If this function is not enabled,
the video will be saved in .dav format by default.
4. Click OK.
® Download a video by file.

Click the File tab, and then click to download afile.

You can also select multiple files, and then click Download Selected File on the
upper-left corner to download them at the same time.

Related Operations
® You can pause, resume, and delete a download task.

Figure 8-1 Download progress

Timeline

® After download completes, click '] to go to the path where the video is saved to, or click E] in
the prompt on the upper-right corner to play the video directly in Local Video. For details, see
"8.4 Playing Local Videos".

8.2.2 By Tagging Record

Search for tagging records on the platform and download relevant videos.
Procedure
Step1 Login to the DSS Client. On the Home page, select Management > Download Center >
Tagging Records.
Step2  Configure the search conditions, and then click Search.
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Table 8-1 Parameter description

Parameter Description

Site If you have logged in to multiple sites, you can select which one you
want to search for tags from.
The platform displays channels in the site you selected. Select one or
more channels to search for tags from.

Select Channels ® Unlimited : The platform will search all channels.
° E: Manually select channels.

Time Configure the time to search for tags within it.

Storage Position Select where the videos are stored.

Step3  Click g’(o download one video at a time, or select more tags, and then click Download
Selected Tagged File to download multiple videos at the same time.

Step4  Verify the login password and configure the encryption password, and then click OK.
1]

By default, you need to verify your password and configure an encryption password
before download. You can configure whether to verify the password. For details, see
"7.4.1 Configuring Security Parameters".

Step5 Configure the length of the video, whether you want to convert the video format, and
then click OK.

Related Operations

ClickE to delete a tag, or select more tags, and then click Download Selected Tagged File to
delete them in batches. This operation will only delete the tags. It will not delete the videos.

8.2.3 By Locking Record

Search for locking records on the platform and download relevant videos.
Procedure

Step1 Login to the DSS Client. On the Home page, select Management > Download Center >
Locking Records.

Step2 Configure the search conditions, and then click Search.

Table 8-2 Parameter description

Parameter Description

If you have logged in to multiple sites, you can select which one you

Site want to search for locked videos from.

The platform displays channels in the site you selected. Select one or
more channels to search for locked videos from.

Select Channels ® Unlimited : The platform will search all channels.

° E: Manually select channels.

Time Configure the time to search for locked videos within it.
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Step 3

Step 4

Click g’(o download one video at a time, or select more records, and then click

Download Selected Locked Video to download multiple videos at the same time.

(1

Verify the login password and configure the encryption password, and then click OK.

By default, you need to verify your password and configure an encryption password
before download. You can configure whether to verify the password. For details, see
"7.4.1 Configuring Security Parameters".

Step 5
then click OK.

Related Operations

Configure the length of the video, whether you want to convert the video format, and

CIickE to unlocked a video, or select more records, and then click Unlocked Video to unlock
them in batches. After unlocked, the videos can be overwritten or deleted.

8.3 Configuring Local Settings

8.3.1

After logging in to the client for the first time, you need to configure the following fields under
system parameters: Basic settings, video parameters, record playback, snapshot, recording, alarm,
video wall, security settings and shortcut keys.

Configuring General Settings

Configure client language, client size, time, and more.

Procedure
Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.
Step2 Click General, and then configure the parameters.
Table 8-3 Parameter description
Parameters Description

Default Client Size

The size of the client when it is not maximized. Select a proper
resolution according to your screen.

Display time zone in
client and event records

When selected, the client and the time of alarms will show both the
time and time zone.

Device Node Info
Display

Select that the device tree displays devices and their channels or only
channels.

Display live view
thumbnails when
hovering over channels
on the device tree

When selected, you can hover the mouse over a channel in the device
tree in Monitoring Center and a snapshot of its live video image will
be displayed.

Time Sync

If enabled, the client starts to synchronize network time with the server
to complete time synchronization.
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Parameters

Description

Auto run at startup

® |f Remember Password has been selected on the Login page,
select Auto restart after reboot, and the system will skip the login
page and directly open the homepage after you restart the PC next
time.

® |f Remember Password is not selected on the Login page, select
Auto restart after reboot, the client login page will appear after
you restart the PC.

Auto Login

Enable the system to skip the login page and directly open the
homepage when logging in next time.

® |f Remember Password and Auto Login have been selected on the
Login page, the function is already enabled.

® |f Remember Password has been selected while Auto Login is not
selected on the Login page, select Auto Login on the Basic page to
enable this function.

® |f neither Remember Password nor Auto Login has been selected
on the Login page, select Auto Login on the Basic page and you
then to enter the password when logging in next time to enable the
function.

CPU Alarm Threshold

The user will be asked to confirm whether to open one more video
when the CPU usage exceeds the defined threshold.

Audio and video
transmission encryption

Encrypt all audio and video to ensure information security.

Auto Lock Client

If no operation is performed for the defined period, the client will be
automatically locked, and you cannot perform any operation. Click Click
to Unlock Client and verify the password of the current account to
unlock the client.

The period can be 5 to 60 minutes.

Self-adaptive audio talk
parameters

If enabled, the system automatically adapts to the device sampling
frequency, sampling bit, and audio format for audio talk.

Access Card Input and

Select a mode for the platform to use and display access cards. For
example, when you manually issue a card to a person, you can enter A-F

Display Mode and numbers in the card number if Hex is selected, but you can only
enter 0-9 if Decimal is selected.

Select the sensitivity for when you operate the joystick.

Joystick Sensitivity The higher the sensitivity, the more frequent joystick commands are
sent, and the greater the possibility that operations will be delayed due
to poor performance of PTZ cameras.

Use Thousand Configure a separator for thousands. This will apply to all numbers on

Separator the PC client.

Decimal Separator

Select a separator for decimals. This will apply to all numbers on the PC
client.

Step3  Click Save.
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8.3.2 Configuring Video Settings

Configure window split, display mode, stream type and play mode of live view, and instant

playback length.

Procedure

Step1 Logintothe DSS Client. On the Home page, select Management > Local Settings.
Step2 Click Video, and then configure the parameters.

Table 8-4 Parameter description
Parameters Description

Default Window Split

Set split mode of the video window.

Window Display Scale

Select from Original Scale and Full Screen.

Stream Acquisition Mode

When the device and clients are properly connected to the
network, direct acquisition can reduce the use of the platform's
forwarding bandwidth. If too many clients are acquiring video
streams from a channel, acquisition might fail due to insufficient
performance of the device. At this time, video streams can be set
to be forwarded to clients by the platform.

® Streaming Service Forwarding : Video streams will be
forwarded to clients by the platform.

® Acquire directly from the device : Clients will acquire video
streams directly from the channel. If direct acquisition fails, the
platform will forward the video streams to clients.

Decoding Mode

CPU Threshold

® Software Decoding by CPU : All videos will be decoded by the
CPU. When you are viewing live videos from large amount of
channels, it will take up too much resources of the CPU that
affects other functions.

® Software Decoding by GPU : All videos will be decoded by the
GPU. The GPU is better at concurrent operation than the CPU.
This configuration will free up resources of the CPU
significantly.

® Performance Mode (CPU First) : All videos will be decoded by
the CPU first. When the resources of the CPU is taken up to the
defined threshold, the platform will use the GPU to decode
videos.

Video Toolbar Icon Size

Set the icon size on the toolbar when viewing real-time and
recorded videos.

Stream Switching Rule

When the number of window splits is greater than the defined
value, the live video will switch from the main stream type to sub
stream type.

Double-click on the video to
maximize the window and
switch to main stream

If selected, you can double-click a video window to maximize it
and switch from sub stream to main stream. Double-click again to
restore the window size, and then the system will switch it back to
sub stream.
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Parameters Description

® Real-time Priority

The system might lower the image quality to avoid video lag.
® Fluency Priority

The system might lower the image quality and allow for lag to
ensure video fluency. The higher the image quality, the lower
the video fluency will be.

Play Mode ® Balance Priority

The system balances real-time priority and fluency priority
according to the actual server and network performance.
® Custom

The system adjusts video buffering and lowers the impact on
video quality caused by unstable network. The bigger the
value, the more stable the video quality will be.

Display previous live view If selected, the system displays the last live view automatically
after restart after you restart the client.

Close videos being played
after long period of inactivity | The system closes live view automatically after inactivity for a pre-

defined period of time. Supports up to 30 minutes.

Inactivity Time

After enabled, if the device is recording a video, an icon will be

Display Device Video Status displayed on the upper-left corner of the window.

Click @ on the live view page to play the video of the previous
Instant Playback Time period. The period can be user-defined. For example, if you set 30
seconds, the system will play the video of the previous 30 seconds.

Select a default stream type when you play back recordings from a
device.
Search Type of Device Video |[I]

Stream
If Only Sub Stream 2 is selected, but the device does not support

sub stream 2, then recordings of sub stream 1 will be played.

Select a default location for recorded videos when you play them,
including Prioritize Device Recording for playing recorded
videos stored on devices, and Prioritize Central Recording for
playing recorded videos stored on the platform.

Play Priority

Frame extraction is useful to guarantee fluency and lower the
pressure on decoding, bandwidth and forwarding when playing
back high-definition videos. When frame extraction is enabled,
certain frames will be skipped.

Frame Extraction Mode ® Do Not Extract : Frame extraction will not be enabled in any
situation.

® Self-adaptive : The platform will enable frame extraction
based on the resolution and the play speed.

® Force: Frame extraction is always enabled.
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Parameters

Description

Continuous Snapshot Interval | et the number and interval between each snapshot.

Number of Continuous

For example, if the Continuous Snapshot Interval is 10 seconds
and the Number of Continuous Snapshots is 4, when you right-

Snapshots click on the live/playback video and select Snapshot, 4 images will
be taken every 10 seconds.
Step3  Click Save.

8.3.3 Configuring Video Wall Settings

Configure the default binding mode and stream type of video wall.

Procedure
Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.
Step2 Click Video Wall, and then configure the parameters.
Table 8-5 Parameter description
Parameter Description

Default Stream
Type

Select Main Stream , Sub Stream 1, Sub Stream 2 or Local Signal as the
default stream type for video wall display.

Stream Switching
Rule

When the number of window splits is greater than the defined value, the live
video will switch from the main stream type to sub stream type.

Double-click on
the video to
maximize the
window and
switch to main
stream

Double-click the video to maximize the window, and then its stream type will
switch to main stream.

Video Source Play
Duration

Set the default time interval between the channels for tour display.

For example, if 5 seconds is configured and you are touring 3 video channels,
the live video image of each channel will be played 5 seconds before
switching to the next channel.

Mode of Video
Decoding to Wall

® Tour : Multiple video channels switch to decode in one window by
default.

® Tile: Video channels are displayed in the windows by tile by default.

® Ask Every Time : When dragging a channel to the window, the system
will ask you to select tour or tile mode.

Step 3

Click Save.

8.3.4 Configuring Alarm Settings

Configure the alarm sound and alarm display method on the client.
Procedure

Step 1

Log in to the DSS Client. On the Home page, select Management > Local Settings.
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Step2  Click Alarm, and then configure the parameters.
Table 8-6 Parameter description
Parameters Description
Default All types of alarms will use the same default alarm sound when triggered.
Custom Click Modify Alarm Sound, and then you can change the alarm sound and

its play mode of each type of alarm.

Open alarm linkage
video when alarm
occurs

Open Alarm
Linkage Video

If selected, the platform will automatically open linked video(s) when an
alarm occurs.

® AsPop Up:The alarm video will be played in a pop-up window.

® Openin Live View : The alarm video will be played in a window in
Monitoring Center.

(L1

For this function to work properly, you must enable When an alarm is
triggered, display camera live view on client when configuring an event.
For details, see "4.1 Configuring Events".

Pop-up Display
Duration

When an alarm is
triggered, the alarm
pop up window and
the client will be
displayed on the
top of the screen.

When you configure the alarm videos to be displayed as pop-up windows,
you can select for how long the pop-up windows will be displayed, and
whether to display the pop-up windows and the client on the top of the
screen.

Device on the map
flashes when alarm
occurs

Set one or more alarm types for alarm notification on the map. When an
alarm occurs, the corresponding device will flash on the map.

Step3  Click Save.

8.3.5 Configure File Storage Settings

Configure the storage path, naming rule, file size, and format of recordings and snapshots.

Procedure
Step1 Login tothe DSS Client. On the Home page, select Management > Local Settings.
Step2 Click File Storage, and then configure the parameters.
Table 8-7 Parameter description
Parameters Description

Video Naming Rule

Select a naming rule for manual recordings.

Video Storage Path

Set a storage path of manual recordings during live view or playback. The
default path is C:\Users\Public\DSS Client\Record.
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Parameters Description

Configure the maximum size of a video file. If you download a video that is
larger than the defined size, the platform will divide it into multiple files. The

Video File Size maximum size can be up to 4 GB for 32-bit operating systems, and 1024 GB
for 64-bit operating systems.
Image Format Select a format for snapshots.

Image Naming Rule | Select a naming rule for snapshots.

Set a storage path for snapshots. The default path is C:\Users\Public\DSS

Image Storage Path Client\Picture.

Step3  Click Save.

8.3.6 Viewing Shortcut Keys

View shortcut keys for operating the client quickly.
Procedure

Step1 Login to the DSS Client. On the Home page, select Management > Local Settings.
Step2  Click Shortcut Key to view shortcut keys of the PC keyboard and USB joystick.

8.3.7 Exporting and Importing Configurations

For the parameters in local settings configured by the user currently logged in to the PC client, they
can be exported and imported to another PC client. This is helpful that the user does not need to
configure the parameters again when using a new platform.

Procedure
Step1 Login tothe DSS Client. On the Home page, select Management > Local Settings.

N

Step Click Export/Import Configurations on the lower-right corner.

w

Step Export or import configurations.
® Export configurations.

The parameters of Alarm Sound and Map Flashes will not be included in the exported
configurations.

1. Click Export Configurations.

2. Select Export to File, and then export the configurations to the specified path of your
computer. Or select Send by Email, and send the configurations to the specified email
address.

3. Click OK.
® |mport configurations.

1. Click Import Configurations.

2. Click[3, and then open the exported file of configurations.
3. Click OK.
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8.4 Playing Local Videos

You can play local videos directly on the platform.
Procedure

Step1 Loginto the DSS Client. On the Home page, select Management > Local Video.

Figure 8-2 Local video

Step2  Click @ to select one or more files, or E to open all files in a folder.
Figure 8-3 Play list

Step3  Drag afile to the window on the right or right click it to play.
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Related Operations

Table 8-8 Interface operation

Icon/Function

Description

Right-click menu

® Continuous Snapshot : Take snapshots of the current image (three
snapshots each time by default). The snapshots are saved to ..\DSS\DSS
Client\Picture by default. To change the snapshot saving path, see
"8.3.5 Configure File Storage Settings".

® Video Adjustment : Adjust the brightness, contrast, saturation, and
chroma of the video for video enhancement.

® Digital Zoom: Click and hold to select an area to zoom in on it.

Double-click the image again to exit zooming in.
o=

You can also scroll to zoom in and out.

Close all playing videos.

Split the window into multiple ones and play a video in full screen.

E Take a §napshot of the current image and save it locally. The path is C:\DSS
\DSS Client\Picture\ by default.

E Close the window.

(T Stop/pause the video.

“ x B Fast/slow playback. Max. supports 64X or 1/64X.

Frame by frame playback/frame by frame backward.

5

Capture the target in the playback window. Click = to select the search
method, and then the system goes to the page with search results. More
operations:

L E: Move the selection area.

L] ﬁ: Adjust the size of the selection area.
® Right-click to exit search by snapshot.

8.5 Quick Commands

Customize HTTP commands and execute them quickly. Request methods of GET, POST, PUT and

DELETE are supported.

Procedure

Step1 Loginto the DSS Client. On the Home page, select Management > Quick Commands.
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Figure 8-4 Quick commands

Quick Commands

+ Add

Quick Command Name Request Method HTTP URL Operation

GET 7 v+ 7 @

GET 7 * 4

Step2 Click Add.
Figure 8-5 Add a quick command

Quick Command Config

9 Add Quick Command

ymmand Name:

Request Method:

GET

HTTP URL:

Step3  Configure the parameters, and then click OK.
Step4  Execute commands.

® (lick to execute one command.

® Select multiple commands, and then click Batch Execute to execute them in batches.
1]

Before batch execution, use ﬂ and to adjust the order of the commands. The
platform will execute them in this order.
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Appendix 1 Service Module Introduction

Appendix Table 1-1Service module introduction

Service Name

Function Description

NGINX Proxy Service | NGINX Provides access to the platform.
System Management SMC Manages services and provides access to various
Service functions.
Red|§ Data Cache REDIS Stores data that is frequently accessed.
Service
MySQL Database MySQL Stores data for a long time.
Service
Systern Confi Monitors system resources and synchronizes
ySte 9 CFGS configurations across the distributed
Service ;
environment.
MQ Push .
Notifications Service MQ Pushes messages among clients and platforms.
Med'la Gateway MGW Acquires video streams for video walls.
Service
Protocol Conversion . . .
. PCPS Accesses third-party video devices.
Proxy Service
DeV|F:e Management DMS Accesses video devices.
Service
Alarm Distribution ADS Filters and distributes alarms from devices.
Service
Device Auto Accesses devices added through automatic
. . . ARS . .
Registration Service registration.
Image Transmission PTS Accesses ANPR devices and transfers images
Service between the devices and the platform.
Alarm Controller and
LED Device Access MCD Accesses alarm controllers and LED devices.
Service
Device Search Searches for and obtains configurations from
. SOSO L
Service devices in local networks.
DeV|F:e Update UPDATE Updates devices.
Service
ACU?ICk Algorithm AcuPick Searches for bodies and vehicles by images.
Service
Video Intercom e Manages audio talks among PC clients and app,
Service and video intercom devices.
DA Management DAMS Manages DA_BSID.
Service
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Service Name

Function Description

Link Management

Downloads files from devices, manages the sleep
and wake status of low-power consumption

Service DA_BSID cameras that uses 4G network, and redirects to the
webpage of devices added through automatic
registration.

Group Talk Service | DA_POC Manages the group talk among MPT devices.

Access Control ) -y Manages MCDDOOR,

Management Service

Access C.O ntrol . MCDDOOR Accesses access control devices.

Connection Service

Video Storage Ss Stores and forwards recorded videos on the

Service platform.

Video DeFodlng to VMS Accesses decoders outputs videos to video walls.

Wall Service

ObJEtCt Storage 0SS Stores files of the platform.

Service

Evidence Chz?m File SubOSS Stores evidence files of the platform.

Storage Service

Media Forwarding MTS Forwards real-time video streams.

Service
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Appendix 2 Cybersecurity Recommendations

Security Statement

® |f you connect the product to the Internet, you need to bear the risks, including but not limited

to the possibility of network attacks, hacker attacks, virus infections, etc., please strengthen the
protection of the network, platform data and personal information, and take the necessary
measures to ensure the cyber security of platform, including but not limited to use complex
passwords, regularly change passwords, and timely update platform products to the latest
version, etc. Dahua does not assume any responsibility for the product abnormality, information
leakage and other problems caused by this, but will provide product-related security
maintenance.

Where applicable laws are not expressly prohibited, for any profit, income, sales loss, data loss
caused by the use or inability to use this product or service, or the cost, property damage,
personal injury, service interruption, business information loss of purchasing alternative goods
or services, or any special, direct, indirect, incidental, economic, covering, punitive, special or
ancillary damage, regardless of the theory of liability (contract, tort, negligence, or other),
Dahua and its employees, licensors or affiliates are not liable for compensation, even if they
have been notified of the possibility of such damage. Some jurisdictions do not allow limitation
of liability for personal injury, incidental or consequential damages, etc., so this limitation may
not apply to you.

Dahua's total liability for all your damages (except for the case of personal injury or death due to
the company's negligence, subject to applicable laws and regulations) shall not exceed the price
you paid for the products.

Security Recommendations

The necessary measures to ensure the basic cyber security of the platform:

1.

Use Strong Passwords
Please refer to the following suggestions to set passwords:

® The length should not be less than 8 characters.

® |Include at least two types of characters; character types include upper and lower case letters,
numbers and symbols.

® Do not contain the account name or the account name in reverse order.
® Do not use continuous characters, such as 123, abg, etc.

® Do not use overlapped characters, such as 111, aaa, etc.

Customize the Answer to the Security Question

The security question setting should ensure the difference of answers, choose different
questions and customize different answers (all questions are prohibited from being set to the
same answer) to reduce the risk of security question being guessed or cracked.

Recommendation measures to enhance platform cyber security:

1.

Enable Account Binding IP/MAC

It is recommended to enable the account binding IP/MAC mechanism, and configure the
IP/MAC of the terminal where the commonly used client is located as an allowlist to further
improve access security.

Change Passwords Regularly

We suggest that you change passwords regularly to reduce the risk of being guessed or cracked.

3. Turn On Account Lock Mechanism
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The account lock function is enabled by default at the factory, and it is recommended to keep it
on to protect the security of your account. After the attacker has failed multiple password
attempts, the corresponding account and source IP will be locked.

4, Reasonable Allocation of Accounts and Permissions

According to business and management needs, reasonably add new users, and reasonably
allocate a minimum set of permissions for them.

5. Close Non-essential Services and Restrict the Open Form of Essential Services

If not needed, it is recommended to turn off NetBIOS (port 137, 138, 139), SMB (port 445),
remote desktop (port 3389) and other services under Windows, and Telnet (port 23) and SSH
(port 22) under Linux. At the same time, close the database port to the outside or only opentoa
specific IP address, such as MySQL (port 3306), to reduce the risks faced by the platform.

6. Patch the Operating System/Third Party Components

It is recommended to regularly detect security vulnerabilities in the operating system and third-
party components, and apply official patches in time.

7. Security Audit

® Check online users: It is recommended to check online users irregularly to identify whether
there are illegal users logging in.
® \/iew the platform log: By viewing the log, you can get the IP information of the attempt to
log in to the platform and the key operation information of the logged-in user.
8. The Establishment of a secure Network Environment

In order to better protect the security of the platform and reduce cyber security risks, it is
recommended that:

® Follow the principle of minimization, restrict the ports that the platform maps externally by
firewalls or routers, and only map ports that are necessary for services.

® Based on actual network requirements, separate networks: if there is no communication
requirement between the two subnets, it is recommended to use VLAN, gatekeeper, etc. to
divide the network to achieve the effect of network isolation.

More information

Please visit Dahua official website security emergency response center for security announcements
and the latest security recommendations.
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